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3 1. Descripción general

Configuración del sistema

Paquete de 
micrófono 
inalámbrico 
UWP-D21 
UWP-D22 
UWP-D26

Receptor de 
micrófono 
inalámbrico 
URX-P03D

Adaptador de la 
zapata 
de interfaces 
múltiples  
SMAD-P3D

Adaptador de  
la zapata de 
interfaces múltiples 
SMAD-P5 

Adaptador de 
montura A 
LA-EA3 
LA-EA4

Objetivo de 
montura E

Micrófono 
ECM-VG1 
ECM-MS2

Unidad de control 
remoto 
RM-30BP

Multi Camera Live 
Producer 
MCX-500

Control remoto de la 
empuñadura (suministrado)

ILME-FX6V/ILME-FX6VK 
ILME-FX6T/ILME-FX6TK

Kit de 
Adaptador de 
XLR 
XLR-K2M 
XLR-K3M

Luz de vídeo 
HVL-LBPC

Tarjetas de 
memoria  
CFexpress Tipo A

Tarjetas de memoria  
SDXC

Cargador de 
batería  
BC-CU1 
(suministrado)

Batería  
BP-U35, BP-U60, 
BP-U60T, BP-U70, 
BP-U90, BP-U100

Adaptador de CA 
(suministrado)

Lector de tarjetas CFexpress Tipo A/ 
lector de tarjetas SD

Cargador de batería 
BC-U1A, BC-U2A

1. Descripción general
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Ubicación y función de los componentes

Lado izquierdo y cara frontal
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1. Gancho para cinta métrica
El gancho para cinta métrica está situado en 
el mismo plano que el sensor de imagen. 
Para medir la distancia entre el camcorder y 
el sujeto de forma precisa, utilice este gancho 
como punto de referencia. Puede unir el 
extremo de la cinta métrica al gancho para 
medir la distancia desde el sujeto.

2. Conector del visor (página 19)

3. Salida de aire

[Nota]
No cubra la salida de aire.

4. Interruptor de selección TC IN/OUT 
(página 35, 108)

5. Conector del control remoto de la 
empuñadura (página 20)

6.  (Marca N) (página 56)
ˎˎ Toque un smartphone equipado con la 
función NFC con la unidad para establecer 
una conexión inalámbrica.  
Es posible que algunos smartphones que 
admiten sistemas de pago inalámbricos no 
admitan NFC. Para obtener más información, 
consulte el manual de instrucciones del 
smartphone.
ˎˎ NFC (Near Field Communication) es 
un protocolo de comunicaciones 
internacionales para la comunicación 
inalámbrica entre objetos cercanos.

7. Acoplamiento del control remoto de la 
empuñadura (página 20)

8. Botón de liberación del control remoto de 
la empuñadura (página 20)

9. Antena Wi-Fi

10. Lámpara indicadora/indicador de 
grabación (parte delantera) (página 34)

Parpadea cuando la capacidad restante del 
soporte de grabación o de la batería es baja.

11. Interruptor FOCUS (página 37)

12. Sensor de imagen

13. Botón PUSH AUTO FOCUS (página 40)

14. Contactos de señal del objetivo

[Nota]
No tocar directamente con las manos.

15. Botón WB SET (ajuste del balance de 
blancos) (página 45)

16. Botón de liberación del objetivo 
(página 22)
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Lado derecho (frontal/superior/inferior)
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1. Botón Clip Flag (página 50, 65)

2. Interruptor HOLD (página 93)

3. Botón START/STOP de grabación 
(página 34)

Pulse el botón START/STOP de grabación para 
comenzar a grabar. El LED se iluminará en rojo 
durante la grabación.

4. Dial ND VARIABLE (página 43)

5. Interruptor ND PRESET/VARIABLE 
(página 43)

6. Botones arriba/abajo de ND FILTER 
POSITION (página 43)

7. Indicador ND CLEAR (página 43)

8. Botón ND VARIABLE AUTO (página 43)
Pulse el botón ND VARIABLE AUTO para iniciar 
el ajuste automático de la densidad del filtro 
ND. El LED se iluminará en verde cuando esta 
opción esté activada.

9. Dial multifunción (página 48)
Presione cuando vea la imagen en el visor 
para mostrar y utilizar el menú directo.
Gire el dial cuando aparezca un menú en 
el visor para mover el cursor hacia arriba/
abajo para seleccionar elementos o ajustes 
del menú. Pulse para aplicar el elemento 
seleccionado.
Si no se muestra el menú, el dial también 
puede funcionar como dial asignable.

10. Botón de función IRIS (página 42)

11. Botón CANCEL/BACK (página 64)

12. Botón THUMBNAIL (página 63)

13. Botón MENU (página 10, 68)
Pulse el botón MENU para mostrar la pantalla 
de estado. Mantenga pulsado el botón MENU 
para mostrar la pantalla del menú completo. 
Pulse el botón durante la visualización de la 
pantalla de estado o de la pantalla del menú 
completo para volver a la pantalla anterior.

14. Botón de función ISO/GAIN (página 42)

15. Interruptor ISO/GAIN (ganancia 
seleccionada) (página 42)

16. Botón de función WHT BAL (balance de 
blancos) (página 45)

17. Interruptor WHT BAL (selección de 
memoria de balance de blancos) 
(página 45)

18. Botón de función SHUTTER (página 43)

19. Toma de auriculares (página 34)

20. Interruptor POWER (página 34)

Lateral derecho (trasero) 
(página 6)
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Parte posterior derecha y ranura de tarjetas
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1. Antena Wi-Fi

2. Dial AUDIO LEVEL (CH1) (página 46)

3. Interruptor CH1 (AUTO/MAN) 
(página 46)

4. Botones ASSIGN (asignables) del 1 al 3 
(página 48)

5. Micrófono interno (página 46)
Micrófono de narración para grabar el sonido 
ambiental. 

[Consejo]
Cuando se acopla el asa, se desactiva este micrófono y 
se activa el micrófono interno del asa (página 7).

6. Botón DISPLAY (página 11)

7. Altavoz integrado (página 34)

8. Indicador POWER (página 34)

9. Botón SLOT SELECT (selección de ranura 
de tarjeta de memoria (A)/(B)) 
(página 34)

10. Interruptor CH2 (AUTO/MAN) 
(página 46)

11. Dial AUDIO LEVEL (CH2) (página 46)

12. Indicador de acceso A (página 26)

13. Ranura de la tarjeta CFexpress Tipo A/SD 
(A) (página 26)

14. Ranura de la tarjeta CFexpress Tipo A/SD 
(B) (página 26)

15. Indicador de acceso B (página 26)
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Asa, parte trasera y bloque conector
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1. Interruptor HOLD del asa
Se utiliza para desactivar el funcionamiento de 
los controles del asa.

2. Botón de grabación del asa START/STOP

3. Micrófono interno del asa

4. Zapata de interfaz múltiple

Para obtener más información acerca de 
los accesorios compatibles con la zapata de 
interfaz múltiple, póngase en contacto con su 
representante de ventas.

5. Dial asignable del asa (página 48)

6. Palanca de zoom del asa (página 93)

7. Botones ASSIGN (asignables) del 7 al 8 
(página 48)

8. Selector múltiple (pad D de 8 formas y 
botón de aplicar)

9. Zapata para accesorios (página 7)

10. Orificios para los tornillos de 
acoplamiento de accesorios (1/4 
pulgadas)

Compatible con tornillos 1/4-20 UNC (longitud 
de 6 mm o inferior).

[Nota]
El uso de tornillos con una longitud superior a 6 mm 
podría dañar la superficie exterior.

11. Lámpara indicadora/indicador de 
grabación (parte trasera) (página 34)

12. Botón BATT RELEASE (página 17)

13. Entrada de aire

[Nota]
No cubra la entrada de aire.

14. Acoplamiento de la batería (página 17)

15. Conector USB-C (página 60)

16. Conector INPUT2 (entrada de audio 2) 
(página 46)

17. Conector INPUT1 (entrada de audio 1) 
(página 46)

18. Interruptor INPUT2 (LINE/MIC/MIC+48V) 
(página 46)

19. Interruptor INPUT1 (LINE/MIC/MIC+48V) 
(página 46)

20. Orificios de tornillos para dispositivos 
externos

Compatible con tornillos M3 (longitud de 4 
mm o inferior).

[Nota]
El uso de tornillos con una longitud superior a 4 mm 
podría dañar la superficie exterior.

21. Conector HDMI OUT (página 107)

22. Conector SDI OUT (página 107)

23. Conector TC IN/TC OUT (entrada/salida de 
código de tiempo) (página 108)

24. Conector REMOTE
Conéctelo al accesorio de conector LANC de 
uso general.

25. USB/conector múltiple (página 109)

26. Conector DC-IN (toma de CC estándar) 
(página 18)

Acople de la zapata para accesorios

1 Levante el borde delantero del muelle de 
la zapata y tire del muelle en la dirección 
opuesta a la flecha que se encuentra 
grabada en este.

Muelle de la zapata

Zapata para accesorios

1

2 Sitúe la zapata para accesorios en la 
montura de la zapata para accesorios, 
alineando los salientes de la zapata con 
los puntos correspondientes de la 
montura, y apriete los cuatro tornillos.
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3 Introduzca el muelle de la zapata en la 
dirección de la flecha de modo que la 
parte en forma de U encaje en el extremo 
de la zapata para accesorios.

2 32 3

Muelle de la 
zapata

Zapata para accesorios

Extracción de la zapata para accesorios

Extraiga la muelle de la zapata tal y como se 
describe en el paso 1 de la sección “Acople de 
la zapata para accesorios”, afloje los cuatro 
tornillos y extraiga la zapata para accesorios.

Acople del asa

Coloque el asa de manera que el conector 
de esta y los orificios de los tornillos estén 
alineados, presione hacia adentro y gire los 
tornillos de sujeción del asa en el sentido de 
las agujas del reloj para acoplarla a la unidad.
También puede apretar los dos tornillos de 
acople del asa girándolos en el sentido de 
las agujas del reloj con una llave hexagonal 
(4 mm).

[Nota]
Asegúrese de que los dos tornillos de acople del asa 
estén bien apretados antes de utilizar el asa. El asa 
podría desprenderse de la videocámara si los tornillos 
no están bien apretados.

Extracción del asa

Extráigala usando el procedimiento inverso al 
del acople.

Colocación de la tapa protectora del 
conector del asa (suministrada)

Cuando utilice la videocámara sin el asa, 
proteja el conector con la tapa protectora del 
conector.

[Consejo]
Cuando acople el asa, guarde la tapa protectora 
suministrada en la parte inferior del asa.

Protección de los terminales de los 
conectores

Acople la cubierta en conectores que no se 
utilicen para proteger los terminales de los 
conectores.

Parte superior

1

2 2

2

2

1. Conector del asa

2. Orificios para los tornillos de 
acoplamiento de accesorios  
(1/4 pulgadas)

Compatible con tornillos 1/4-20 UNC (longitud 
de 6 mm o inferior).

[Nota]
El uso de tornillos con una longitud superior a 6 mm 
podría dañar las piezas exteriores.
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Parte inferior

1 2
1. Orificios para los tornillos del trípode (1/4 

pulgadas, 3/8 pulgadas)
Compatibles con tornillos 1/4-20 UNC y 3/8-16 
UNC. Acople la unidad a un trípode (opcional, 
longitud de tornillos de 5,5 mm o inferior).

2. Salida de aire

[Nota]
No cubra la salida de aire.

Visor

Para obtener más información acerca de la 
conexión del visor (suministrado), consulte la 
página 19.

1
2
3

4 5

1. Botón PEAKING

2. Botón ZEBRA

3. Botón ASSIGN (asignable) 9 (página 48)

4. Panel táctil
Las operaciones táctiles se pueden 
deshabilitar mediante un botón asignable o 
con el menú (página 10).

5. Interruptor MIRROR

Control remoto de la empuñadura

Para obtener más información acerca 
de la conexión del control remoto de la 
empuñadura (suministrado), consulte la 
página 20.

4

3
2

1

7
8

6
5

1. Palanca de zoom

2. Botón ASSIGN (asignable) 4 (página 48)

3. Dial asignable de la empuñadura 
(página 48)

4. Botón ASSIGN (asignable) 6 (página 48)

5. Palanca de rotación de la empuñadura 
(página 21)

6. Botón START/STOP de grabación

7. Selector múltiple (pad D de 8 formas y 
botón de aplicar)

8. Botón ASSIGN (asignable) 5 (página 48)
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Uso del panel táctil

Precauciones de uso del panel 
táctil

El visor de la unidad es un panel táctil que se 
controla directamente tocándolo con el dedo.
ˎˎ El panel táctil está diseñado para tocarse 
ligeramente con el dedo. No presione el 
panel con fuerza ni lo toque con objetos 
afilados o puntiagudos (uña, bolígrafo, 
alfiler, etc.)
ˎˎ Es posible que el panel táctil no responda 
si se toca en las siguientes circunstancias. 
También se podría producir un fallo de 
funcionamiento.
ˎˎ  Funcionamiento con la punta de las 
uñas de los dedos
ˎˎ  Funcionamiento mientras la superficie 
está en contacto con otros objetos
ˎˎ  Funcionamiento con una lámina o un 
adhesivo de protección colocados
ˎˎ  Funcionamiento con gotas de agua o 
condensación en la pantalla
ˎˎ  Funcionamiento con los dedos mojados 
o sudados

Gestos del panel táctil

Pulsar
Toque ligeramente un elemento, como un 
icono o un elemento de menú, con el dedo y 
luego retire el dedo inmediatamente.

Arrastrar
Toque la pantalla y deslice el dedo hasta 
la posición deseada de la pantalla. A 
continuación, retire el dedo.

Desplazar/deslizar
Toque la pantalla y desplace/deslice 
rápidamente el dedo hacia arriba, abajo, 
izquierda o derecha.

[Consejo]
Si el contenido de la pantalla continúa sobresaliendo de 
los bordes de la pantalla, puede arrastrar o desplazar el 
contenido de la pantalla.

Configuración del panel táctil

El funcionamiento del panel táctil se puede 
activar/desactivar mediante Touch Operation 
(página 93) en el menú Technical.
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Visualización de la pantalla
Durante la filmación (grabación/en espera) y la reproducción, el estado y la configuración del 
camcorder se superponen sobre la imagen mostrada en el visor.
Puede mostrar/ocultar la información con el botón DISPLAY. Aunque esté oculta, aparecerá 
mientras se realizan operaciones en el menú directo (página 48).
También puede elegir si desea mostrar u ocultar cada elemento independientemente 
(página 87).

Información mostrada en la pantalla durante la filmación

3 42
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9 1075

11
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15
16
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18 19 20 21 22 23 24 25 26 27 28

29

30
31
32
33
34
35
36

1

1. Indicador de estado de red (página 13)
Muestra el estado de conexión de red a través 
de un icono.

2. Indicador de carga/indicador de archivos 
restantes (página 61)

3. Indicador de área de enfoque 
(página 37)

Muestra el área de enfoque para el enfoque 
automático.

4. Modo de grabación, ranura A/B, indicador 
de intervalo de grabación Interval Rec 
(página 49)

Pantalla Significado

Rec Grabación

Stby Grabación en espera

5. Indicador de profundidad de campo

6. Indicador de modo de escaneado de la 
cámara (página 24)

Se muestra una marca  si hay una 
discrepancia entre el tamaño del círculo de 
la imagen del objetivo y el ajuste del modo 
de escaneado de la cámara del tamaño de 
imagen efectivo.
Cuando Imager Scan Mode está ajustado en 
FF, aparece una marca “C” en los modos con 
un ángulo de visión más reducido (recortado).
El recorte se produce en los siguientes modos:
ˎˎ Cuando el formato de grabación es 
3840×2160 y la velocidad de fotogramas de 
S&Q Motion es 100 fps o 120 fps
ˎˎ Cuando Codec está ajustado en RAW o RAW 
& XAVC-I y el formato de salida RAW es 
3840×2160

7. Indicador de estado de funcionamiento 
de la salida RAW (página 55)

Muestra el estado de salida de la señal RAW.

8. Indicador de estado de serie UWP-D 
(página 13)

Muestra la intensidad de la señal de nivel RF 
utilizando un icono cuando se conecta un 
dispositivo de la serie UWP-D a la zapata MI 
configurada para la transferencia de audio 
digital.

9. Indicador de la velocidad de fotogramas 
con Slow & Quick Motion (página 49)

10. Indicador de capacidad de batería 
restante/tensión de DC IN (página 17)

11. Indicador de modo de enfoque 
(página 41)

Significado Pantalla

Modo Focus Hold Focus Hold

Modo MF MF

Modo AF AF

AF de detección de caras/ojos (AF/ /Only/ / )

Icono de detección de 
caras/ojos

Icono de AF de 
detección de caras/
ojos

Only

Icono de cara 
registrada

 

Icono de pausa AF 
durante el AF de 
detección de caras/
ojos1)

1) Aparece cuando no hay una cara registrada y no se 
detecta una cara, o cuando hay una cara registrada y 
no se detecta la cara registrada.

12. Indicador de posición del zoom 
(página 36)

Muestra la posición del zoom en el rango de 
0 (gran angular) a 99 (telefoto) (si se acopla 
un objetivo compatible con la pantalla de 
configuración de zoom).
La pantalla se puede cambiar a un indicador 
de barra o indicador de distancia focal 
(página 94).

Los siguientes elementos se añaden a la 
pantalla cuando Clear Image Zoom está 
activado.

Pantalla Significado

Clear Image Zoom está 
activado

Valor de 
ampliación

Cuando se utiliza Clear Image 
Zoom

13. Indicador de modo de estabilización de la 
imagen

14. Indicador de estado de Rec Control de 
salida SDI/HDMI (página 107)

Muestra el estado de salida de la señal de 
control REC.

15. Indicador de enfoque (página 40)

16. Indicador de capacidad restante de los 
soportes

17. Indicador de modo de balance de blancos

Pantalla Significado

Modo Auto

 Hold Modo Auto pausado

W:P Modo predeterminado

W:A Modo de Memoria A

W:B Modo de Memoria B

18. Indicador de bloqueo de código de 
tiempo externo/pantalla de datos sobre 
el tiempo (página 34)

Muestra “EXT-LK” cuando está bloqueado con 
el código de tiempo de un dispositivo externo.

19. Indicador del filtro ND (página 43)

20. Indicador de archivos de escena 
(página 106)

21. Indicador de diafragma
Muestra la posición del diafragma (valor F) 
(si se acopla un objetivo compatible con la 
pantalla de configuración del diafragma).
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22. Indicador del advertencia del nivel de 
vídeo

23. Indicador de ganancia (página 42)
Muestra el valor EI cuando está en el modo 
Cine EI (página 24).

Pantalla Significado

Modo Auto

H Modo H 
predeterminado

M Modo M 
predeterminado

L Modo L 
predeterminado

Modo de ajuste 
temporal

24. Visualización del nombre del clip 
(página 63)

25. Indicador de obturación (página 43)

26. Indicador de modo AE/nivel AE 
(página 42)

27. Indicador de nivel de burbuja
Muestra el nivel horizontal en intervalos de ±1° 
hasta ±15°.

28. Medidor del nivel de audio
Muestra el nivel de audio de CH1 y CH2.
CH3 y CH4 se pueden controlar en la pantalla 
de estado.

29. Monitor de señal de vídeo (página 50)
Muestra una forma de onda, un vectorscopio y 
un histograma.
La línea naranja indica el valor establecido del 
nivel de cebra.
En el modo Cine EI (página 24), se muestra 
el tipo de LUT de la señal monitorizada.

30. Indicador de Base Sensitivity/indicador 
de Base ISO (página 42)

En el modo Custom (página 24), muestra 
la sensibilidad base establecida usando ISO/

Gain/EI en la pantalla Main Status o ISO/Gain/
EI >Base Sensitivity en el menú Shooting del 
menú completo.
En el modo Cine EI (página 24), muestra la 
sensibilidad ISO base establecida usando ISO/
Gain/EI en la pantalla Main Status o ISO/Gain/
EI >Base ISO en el menú Shooting del menú 
completo.

31. Indicador de la pantalla asistida de 
gamma/LUT de monitor

Muestra el estado de la pantalla asistida de 
gamma. La función de la pantalla asistida 
de gamma se puede activar/desactivar 
asignando Gamma Display Assist a un botón 
asignable (página 48).
En el modo Cine EI (página 24), se muestra 
el ajuste de LUT (página 76).

32. Indicador Base Look (página 52)
Muestra el ajuste de Base Look.
En el modo Cine EI (página 24), se muestra 
el ajuste de LUT para la grabación de vídeos 
en las tarjetas de memoria (página 76).

33. Indicador de estado de proxy

34. Indicador de formato de grabación 
(códec) (página 77)

Muestra el nombre del formato de grabación 
en las tarjetas de memoria.

35. Indicador de formato de grabación 
(velocidad de fotogramas y método de 
exploración)

36. Indicador de formato de grabación 
(tamaño de imagen) (página 77)

Muestra el tamaño de imagen para 
grabaciones en las tarjetas de memoria.

Información mostrada en la pantalla durante la reproducción

La siguiente información se superpone sobre la imagen reproducida.

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1. Indicador de estado de red

2. Indicador de carga/indicador de archivos 
restantes

3. Número del clip/número total de clips

4. Indicador de estado de reproducción

5. Indicador de formato de reproducción 
(velocidad de fotogramas y método de 
exploración)

6. Indicador de formato de reproducción 
(tamaño de imagen)

7. Indicador de capacidad de batería 
restante/tensión de DC IN

8. Indicador de formato de reproducción 
(códec)

9. Indicador de soporte
Si la tarjeta de memoria está protegida contra 
escritura, aparece un icono .

10. Visualización de datos de tiempo

11. Visualización del nombre del clip

12. Indicador de la pantalla asistida de 
gamma

13. Medidor del nivel de audio
Muestra el nivel de reproducción de audio.

14. Indicador Base Look
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Visualización de iconos

Visualización de iconos de conexión de red

Modo de red Estado de conexión Icono

Modo de punto de acceso Funciona como un punto de acceso

Error de funcionamiento de punto de 
acceso

Modo de estación Conexión Wi-Fi
El icono cambia según la intensidad de 
la señal (4 pasos)

   

Wi-Fi desconectado (incluso cuando se 
establece la conexión)

Error al conectarse al Wi-Fi

Anclaje USB Anclaje USB conectado

Anclaje USB desconectado

Error del anclaje USB

Visualización de iconos de la serie UWP-D

Estado del transmisor Estado de recepción Icono

Apagado Sin recepción

Estado de transmisión normal Recibiendo
 –   

(nivel de recepción (4 pasos))

Estado de silenciación Recibiendo (en silencio)

Estado de advertencia de capacidad 
restante de la batería

Recibiendo
 (Icono parpadeando)

Estado de advertencia de capacidad 
restante de la batería y silenciación

Recibiendo
 (Icono parpadeando)

Pantalla de estado

Puede comprobar la capacidad restante de 
la videocámara en la pantalla de estado. Los 
ajustes de los elementos marcados con un 
asterisco (*) se pueden cambiar.
La pantalla de estado admite el 
funcionamiento táctil.

Para mostrar la pantalla de estado
ˎˎ Pulse el botón MENU.

Para cambiar la pantalla de estado
ˎˎ Gire el dial multifunción.
ˎˎ Presione el selector múltiple hacia arriba/
abajo.
ˎˎ Deslice la pantalla de estado hacia arriba/
abajo.

Para ocultar la pantalla de estado
ˎˎ Pulse el botón MENU.

Para cambiar un ajuste
Cuando se muestre la pantalla de estado, 
pulse el dial multifunción o el selector múltiple 
para permitir la selección de un elemento de 
configuración en una página. Seleccione un 
número de página y pulse para cambiar de 
página.
También puede seleccionar elementos 
directamente con el funcionamiento táctil.

[Nota]
Puede deshabilitar los cambios en la pantalla de 
estado ajustando Menu Settings >User Menu Only 
(página 93) en el menú Technical del menú completo 
en On.

Pantalla Main Status

Muestra las funciones principales de la cámara 
y el espacio libre en los soportes.

Elemento de la 
pantalla

Descripción

S&Q Frame Rate Configuración de velocidad 
de fotogramas para disparos 
en Slow & Quick Motion

Frequency/Scan* Frecuencia del sistema y 
ajustes del método de 
escaneado

Imager Scan* Modo de escaneado del 
sensor de imagen

Media Remain 
(A)

Espacio libre restante en los 
soportes de la ranura A

ND Filter Ajustes del filtro ND

ISO/Gain/EI Ajuste de ISO/Gain/
Exposure Index

Base ISO/
Sensitivity*

Ajuste de Base ISO/Base 
Sensitivity

Codec* Ajustes de códec para 
grabación

Media Remain (B) Espacio libre restante en los 
soportes de la ranura B

Scene File* Archivo de escena en uso y 
su ajuste de File ID

Base Look/LUT* Ajuste de Monitor LUT

Shutter Velocidad de obturación o 
ajuste del ángulo de 
obturación

Iris Ajuste del diafragma

Video Format* Tamaño de imagen para 
grabaciones en tarjetas de 
memoria

RAW Output 
Format*

Tamaño de imagen de la 
salida RAW

White Balance Ajuste del balance de 
blancos
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Pantalla Camera Status

Muestra el estado de diferentes preajustes de 
la cámara.

Elemento de la 
pantalla

Descripción

White Switch<B> Ajuste de la memoria B del 
balance de blancos

White Switch<A> Ajuste de la memoria A del 
balance de blancos

White Switch<P> Ajuste de Preset White

ND<Preset> ND Filter Preset1 a 3 ajustes

ISO / Gain<L>* Ajuste ISO/Gain<L>

ISO / Gain<M>* Ajuste ISO/Gain<M>

ISO / Gain<H>* Ajuste ISO/Gain<H>

Base ISO/
Sensitivity*

Ajuste de Base ISO/Base 
Sensitivity

Zebra1 Ajuste Zebra1 On/Off y nivel

Zebra2 Ajuste Zebra2 On/Off y nivel

VF Gamma/
Gamma

Categoría gamma y curva

Scene File* Archivo de escena en uso y 
su ajuste de File ID

Pantalla Audio Status

Muestra el ajuste de entrada, el medidor 
del nivel de audio y el ajuste del monitor de 
volumen para cada canal.

Elemento de la 
pantalla

Descripción

CH1 Level 
Control

Estado de activación/
desactivación del ajuste 
automático

Level Meter Medidor del nivel de audio
Source* Fuente de entrada
Ref./Sens.* Nivel de referencia de 

entrada
Wind 
Filter*

Ajuste del filtro de reducción 
del ruido del viento en el 
micrófono

CH2 Level 
Control

Estado de activación/
desactivación del ajuste 
automático

Level Meter Medidor del nivel de audio
Source* Fuente de entrada
Ref./Sens.* Nivel de referencia de 

entrada
Wind 
Filter*

Ajuste del filtro de reducción 
del ruido del viento en el 
micrófono

CH3 Level 
Control*

Estado de activación/
desactivación del ajuste 
automático

Level 
Meter*

Medidor del nivel de audio

Source* Fuente de entrada
Ref./Sens.* Nivel de referencia de 

entrada
Wind 
Filter*

Ajuste del filtro de reducción 
del ruido del viento en el 
micrófono

CH4 Level 
Control*

Estado de activación/
desactivación del ajuste 
automático

Level 
Meter*

Medidor del nivel de audio

Source* Fuente de entrada
Ref./Sens.* Nivel de referencia de 

entrada
Wind 
Filter*

Ajuste del filtro de reducción 
del ruido del viento en el 
micrófono

Elemento de la 
pantalla

Descripción

Audio Input 
Level*

Ajuste del nivel de entrada 
de audio (volumen maestro)

HDMI Output CH* Ajuste del canal de audio de 
salida HDMI

Volume* Ajuste del volumen del 
auricular/altavoz integrado

Monitor CH* Ajuste del canal del monitor

Pantalla de estado Project

Muestra los ajustes básicos relacionados con 
el proyecto de filmación.

Elemento de la 
pantalla

Descripción

Frequency/Scan* Frecuencia del sistema y 
ajustes del método de 
escaneado

Codec* Ajustes de códec para 
grabación

Rec Function Se habilita un formato de 
grabación y unos ajustes 
especiales

Simul Rec* Estado de activación/
desactivación de la función 
de grabación simultánea en 
2 ranuras

Title Prefix Parte del título del nombre 
del clip

Imager Scan* Modo de escaneado del 
sensor de imagen

Video Format* Tamaño de imagen para 
grabaciones en tarjetas de 
memoria

Number Sufijo numérico del nombre 
del clip

Shooting Mode* Ajuste del modo de disparo

RAW Output 
Format*

Tamaño de imagen de la 
salida RAW

Proxy Rec* Estado de encendido/
apagado y configuración de 
la función de grabación 
proxy

Pantalla Monitoring Status

Muestra los ajustes de salida de SDI y HDMI.

Elemento de la 
pantalla

Descripción

SDI Signal* Tamaño de la imagen de 
salida

Info. 
Disp.*

Ajuste de activación/
desactivación de la 
pantalla de salida

Color 
Gamut*

Ajuste del espacio de 
color/estado de Monitor 
LUT

HDMI Signal* Tamaño de la imagen de 
salida

Info. 
Disp.*

Ajuste de activación/
desactivación de la 
pantalla de salida

Color 
Gamut*

Ajuste del espacio de 
color/estado de Monitor 
LUT

Stream Signal Tamaño de la imagen de 
salida

Info. 
Disp.

Pantalla de salida (Off 
(fijo))

Color 
Gamut*

Ajuste del espacio de 
color/estado de Monitor 
LUT

VF Color 
Gamut*

Ajuste de la asistencia de 
la visualización de 
gamma/ajuste del espacio 
de color/estado de 
Monitor LUT

Base Look/LUT* Ajuste de Base Look/LUT

Gamma Display 
Assist*

Ajuste de activación/
desactivación de Gamma 
Display Assist
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Pantalla Assignable Button Status

Muestra las funciones asignadas a cada uno 
de los botones asignables.

Elemento de la 
pantalla

Descripción

1 Función asignada al botón 
ASSIGN 1

2 Función asignada al botón 
ASSIGN 2

3 Función asignada al botón 
ASSIGN 3

4 Función asignada al botón 
ASSIGN 4

5 Función asignada al botón 
ASSIGN 5

6 Función asignada al botón 
ASSIGN 6

7 Función asignada al botón 
ASSIGN 7

8 Función asignada al botón 
ASSIGN 8

9 Función asignada al botón 
ASSIGN 9

Focus Hold 
Button

Función asignada al botón 
Focus Hold del objetivo

Multi Function 
Dial

Función asignada al dial 
multifunción

Grip Dial Función asignada al dial 
asignable de la empuñadura

Handle Dial Función asignada al dial 
asignable del asa

Pantalla Battery Status

Muestra información sobre la batería y sobre la 
fuente DC IN.

Elemento de la 
pantalla

Descripción

Detected Battery Tipo de batería

Remaining Capacidad restante (%)

Charge Count Número de recargas

Capacity Capacidad restante (Ah)

Voltage Tensión de la batería (V)

Manufacture 
Date

Fecha de fabricación de la 
batería

Video Light 
Remaining

Muestra la capacidad 
restante de la batería de la 
luz de vídeo.

Power Source Fuente de alimentación

Supplied Voltage Tensión de la fuente de 
alimentación

Pantalla Media Status

Muestra la capacidad y el tiempo de grabación 
restantes de los soportes de grabación.

Elemento de la 
pantalla

Descripción

Información del 
soporte A

Muestra el icono del soporte 
cuando el soporte de 
grabación se ha introducido 
en la ranura A.

Medidor de la 
capacidad 
restante del 
soporte A

Muestra la capacidad de 
grabación restante del 
soporte de grabación 
introducido en la ranura A, 
expresado en forma de 
porcentaje en un gráfico de 
barras.

Tiempo de 
grabación 
restante del 
soporte A

Muestra un cálculo del 
tiempo de grabación 
restante del soporte de 
grabación introducido en la 
ranura A, expresado en 
minutos según las 
condiciones de grabación 
actuales.

Información del 
soporte B

Muestra el icono del soporte 
cuando el soporte de 
grabación se ha introducido 
en la ranura B.

Medidor de la 
capacidad 
restante B

Muestra la capacidad de 
grabación restante del 
soporte de grabación 
introducido en la ranura B, 
expresado en forma de 
porcentaje en un gráfico de 
barras.

Tiempo de 
grabación 
restante del 
soporte B

Muestra un cálculo del 
tiempo de grabación 
restante del soporte de 
grabación introducido en la 
ranura B, expresado en 
minutos según las 
condiciones de grabación 
actuales.

Pantalla Network Status

Muestra el estado de conexión de red.

Elemento de la 
pantalla

Descripción

Wireless LAN Configuración de red 
inalámbrica y estado de 
conexión

Wired LAN Configuración de red LAN 
con cable y estado de 
conexión

Modem Configuración de red 
inalámbrica y estado de 
conexión del anclaje USB

Pantalla File Transfer Status

Muestra información sobre la transferencia de 
archivos.

Elemento de la 
pantalla

Descripción

Auto Upload 
(Proxy)

Estado On/Off de la función 
Auto Upload (Proxy)

Job Status 
(Remain/Total)

Número restante de trabajos 
y número total de trabajos

Total Transfer 
Progress

Progreso de transferencia de 
todos los trabajos

Default Upload 
Server

Nombre del servidor de 
destino de carga automática 
(Proxy)

Current File 
Transfer Progress

Progreso de transferencia de 
la transferencia de archivos 
actual

Current 
Transferring File 
Name

Nombre del archivo que se 
está transfiriendo en estos 
momentos

Server Address Dirección del servidor de 
destino de transferencia de 
archivos

Destination 
Directory

Directorio de destino del 
servidor de transferencia de 
archivos
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Uso de las pantallas de configuración táctiles

Diseño de la pantalla

Elemento

Marca indicadora del ajuste 
actual

Botón Set (aplicar)

Cursor de selección de 
ajuste 
(cuadro naranja)

Nombre del elemento

Opciones de selección

Funcionamiento

1 Pulse un elemento de configuración.

Pulsar

Aparecen las opciones de selección del 
valor.

2 Arrastre o desplace un ajuste para 
seleccionar el valor.

Desplazar

3 Pulse el botón Set o el cursor de selección 
de valor.
El valor se aplica y se vuelve a visualizar la 
pantalla anterior.

[Consejos]
ˎˎ Pulse el botón de CANCEL/BACK para volver al valor 

anterior.
ˎˎ También puede usar el dial multifunción o el selector 

múltiple.
ˎˎ Las operaciones táctiles también se pueden 

desactivar (página 93).
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Fuente de alimentación
Puede utilizar una batería o una fuente de 
alimentación de CA mediante un adaptador 
de CA.
Por su seguridad, utilice sólo las baterías y los 
adaptadores de CA Sony que se enumeran a 
continuación.

Baterías de iones de litio
BP-U35 (suministrada)
BP-U60
BP-U60T
BP-U70
BP-U90
BP-U100

Cargadores de baterías
BC-CU1 (suministrada)
BC-U1A
BC-U2A

Adaptador de CA (suministrado)
[PRECAUCIÓN]

No guarde las baterías en lugares expuestos 
a la luz solar directa, cerca de fuegos ni a 
temperatura elevadas.

[Notas]
ˎˎ Cuando se utilice conectado a una fuente de 

alimentación de CA, utilice el adaptador de CA 
suministrado.
ˎˎ Ajuste siempre el interruptor POWER (Alimentación) 

en la posición de apagado antes de desconectar 
o conectar una batería o un adaptador de CA. En 
determinados casos, si el dispositivo se desconecta o 
se conecta con el interruptor POWER (Alimentación) 
en la posición de encendido, es posible que 
la videocámara no sea capaz de iniciarse. Si la 
videocámara no se puede iniciar, ajuste el interruptor 
POWER en la posición de Off y extraiga la batería 
o desconecte el adaptador de CA temporalmente; 
a continuación, espere unos 30 segundos antes 
de volver a intentar conectarlos. (Si el adaptador 
de CA está desconectado o conectado mientras la 
videocámara funciona gracias a la batería, o viceversa, 
el dispositivo se puede desconectar o conectar con el 
interruptor POWER (Alimentación) en la posición de 
encendido sin problemas).

Utilización de una batería

Para colocar la batería, conéctela en el 
acoplamiento (página 7) empujándolo 
hasta el tope y a continuación deslícela 
hacia abajo para que quede bloqueada en la 
posición final.

Para extraer la batería, mantenga pulsado el 
botón BATT RELEASE (página 7), deslícela 
hacia arriba y a continuación, tire de ella para 
sacarla del acoplamiento.

Botón BATT 
RELEASE

[Notas]
ˎˎ Antes de colocar una batería, cárguela con los 

cargadores de baterías BC-CU1, BC-U1A o BC-U2A 
específicos.
ˎˎ Si carga la batería mientras está caliente (por ejemplo, 

inmediatamente después de utilizarla), es posible que 
no se recargue completamente.

Comprobación de la capacidad restante

Durante la filmación y la reproducción con 
batería, la capacidad de batería restante se 
muestra en el visor (página 11).

Icono Significado

Entre 91% y 100%

Entre 71% y 90%

Entre 51% y 70%

Entre 31% y 50%

Entre 11% y 30%

Entre 0% y 10%

La videocámara indica la capacidad restante 
al calcular el tiempo de uso disponible con la 
batería si el uso es continuado y con el ritmo 
de consumo de energía actual.

Si el nivel de carga de la batería es bajo

Si la carga restante de la batería desciende 
por debajo de un nivel determinado durante 
el funcionamiento (estado Low Battery), 
aparecerá un mensaje de batería baja y la 
lámpara indicadora/indicador de grabación 
comenzará a parpadear como advertencia.
Si la carga restante de batería desciende por 
debajo del nivel al que el funcionamiento ya 
no puede continuar (estado Battery Empty), 
aparecerá un mensaje de batería agotada.
Sustituya la batería por una batería cargada.

Cambio de los niveles de advertencia

El nivel Low Battery está ajustado en el 10% 
de la carga total de la batería y el nivel de 
Battery Empty está ajustado en el 3% de 
manera predeterminada. Puede cambiar la 
configuración del nivel de advertencia en 
Camera Battery Alarm (página 94) en el 
menú Technical del menú completo.

Cómo cargar la batería mediante el 
cargador de batería suministrado 
(BC-CU1)

1 Conecte el adaptador de CA 
(suministrado) al cargador de batería y, a 
continuación, conecte el cable de 
alimentación (suministrado) a una fuente 
de alimentación de CA.

2 Empuje la batería hacia adentro y 
deslícela en la dirección de la flecha.
El indicador CHARGE se iluminará en 
naranja y comenzará la carga.

Indicador CHARGE

Adaptador de CA

Cable de alimentación

Indicador CHARGE (naranja)
Encendido:  cargando
Intermitente:  error de carga, o la temperatura 

está fuera del rango de 
funcionamiento y se ha detenido 
la carga.
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ˎˎ Cuando está totalmente cargada, el 
indicador CHARGE del cargador de batería 
se apaga.
ˎˎ Utilice siempre baterías originales de Sony.

Tiempo de carga
Tiempo aproximado (minutos) necesarios para 
cargar un batería totalmente descargada.

Batería Tiempo de carga total

BP-U35 120 minutos

[Nota]
Si el adaptador de CA se desconecta del cargador de 
la batería y la batería se deja conectada al cargador, la 
batería empezará a descargarse.

Utilización de la alimentación por CA

Si la videocámara se conecta a una fuente de 
alimentación de CA este se podrá utilizar sin 
preocuparse de la necesidad de recargar la 
batería.

Conector DC IN

Adaptador de CA

Cable de 
alimentación

Conecte el adaptador de CA al conector DC IN 
de la videocámara y, a continuación, conecte 
el cable de alimentación (suministrado) a una 
fuente de alimentación de CA.

Si disminuye la tensión de salida del 
adaptador de CA

Si la tensión de salida del adaptador de CA 
desciende por debajo de un determinado 
nivel durante el funcionamiento (DC Low 
Voltage1 state), aparecerá un mensaje 
informándole de que la tensión ha disminuido 
y la lámpara indicadora/indicador de 
grabación comenzará a parpadear.
Si la tensión de salida del adaptador de 
CA desciende por debajo del nivel mínimo 
requerido para el funcionamiento (DC Low 
Voltage2 state), aparecerá un mensaje 
informándole de que la tensión de salida del 
adaptador de CA es demasiado baja.

En ese caso, es posible que el adaptador de 
CA esté defectuoso. Si es necesario, verifique 
el adaptador de CA.

Cambio de las tensiones de advertencia

El nivel DC Low Voltage1 está ajustado en 
16,5 V y el nivel DC Low Voltage2 está ajustado 
en 15,5 V de manera predeterminada de 
fábrica. Puede cambiar la configuración del 
nivel de advertencia en Camera DC IN Alarm 
(página 95) en el menú Technical.

Adaptador de CA

ˎˎ No conecte ni utilice un adaptador de CA 
en espacios reducidos, como por ejemplo, 
entre una pared y un mueble.
ˎˎ Conecte el adaptador de CA a la fuente 
de alimentación de CA más cercana. Si se 
produce algún problema durante el uso, 
desconecte inmediatamente el cable de 
alimentación de la fuente de alimentación 
de CA.
ˎˎ No provoque un cortocircuito en las piezas 
metálicas del enchufe del adaptador 
de CA. Si lo hace, provocará un fallo de 
funcionamiento.
ˎˎ La batería no se puede cargar mientras 
está conectada al camcorder aunque el 
adaptador de CA esté conectado.
ˎˎ Cuando vaya a desconectar el adaptador de 
CA de la unidad, sujete el enchufe y sáquelo 
recto. Si tira del cable, podría producir un 
fallo de funcionamiento.
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Acople de dispositivos

Acople de un micrófono (se vende 
por separado)

1 Coloque el micrófono en el soporte del 
micrófono.

2 Conecte el cable del micrófono al 
conector INPUT1 o INPUT2.

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

Micrófono

Soporte del 
micrófono

INPUT1 INPUT2

3 Coloque el cable del micrófono en el 
soporte del cable tal como se muestra en 
el diagrama.

Soporte del cable

[Consejos]
ˎˎ Si no puede acoplar el micrófono de forma segura, 

utilice el espaciador suministrado con el micrófono.
ˎˎ Dependiendo del tipo de objetivo acoplado, es 

posible que se vea la punta del micrófono en la 
imagen de la videocámara. Ajuste de la posición del 
micrófono.

Acople del visor

[Nota]
Acople o retire el visor mientras la videocámara esté 
apagado.

Acople del visor a la parte frontal del asa

1 Introduzca el adaptador de la abrazadera 
de montaje del visor en el acoplamiento 
para el visor del asa () y gire el tornillo 
(suministrado) en el sentido de las agujas 
del reloj para fijarlo en su posición ().
El adaptador de la abrazadera de montaje 
se puede acoplar libremente en 
incrementos de 45°, pero se recomienda 
la posición en la que el punto de 
acoplamiento está directamente sobre el 
tornillo.

Tornillo
Adaptador de la 
abrazadera de 
montaje del visor

2 Monte la abrazadera del visor en el 
adaptador de la abrazadera de montaje 
del visor () y gire la perilla de bloqueo 
en el sentido de las agujas del reloj para 
fijarlo en su posición ().

[Nota]
Asegúrese de apretar bien la perilla de bloqueo cuando 
utilice un visor. El visor podría desprenderse si la perilla 
de bloqueo no está bien apretada.

3 Alinee la marca  de la videocámara con 
la marca  del conector del visor e inserte 
el cable.
Asegúrese de que la marca  esté en el 
lado exterior antes de introducir el 
conector.

4 Coloque el cable en el soporte del cable 
tal como se muestra en el diagrama.

Soporte del cable
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Acople del visor a la parte posterior del 
asa

Existen dos puntos de acoplamiento, uno en la 
parte posterior del asa () y otro en la parte 
posterior de la videocámara (), para acoplar 
un visor. Acople el visor de la misma forma 
descrita en la sección “Acople del visor a la 
parte frontal del asa”.

Ajuste de la posición del visor

Incline el visor hacia arriba/abajo/delante/
atrás para ajustar el ángulo del visor.
Puede utilizar el interruptor MIRROR para 
voltear la imagen cuando la vea desde la parte 
frontal de la videocámara, por ejemplo.

[Consejo]
Cuando no se utilice la unidad o cuando se transporte, 
se recomienda mover el visor hasta la posición que se 
muestra en el siguiente diagrama para protegerlo.

Extracción del visor

Afloje la perilla de bloqueo del visor y siga los 
pasos del procedimiento de acoplamiento del 
visor en orden inverso.

Acople de la cubierta del visor

1 Abra las abrazaderas metálicas de la 
cubierta del visor.

2 Acople la abrazadera de metal de la parte 
superior de la cubierta del visor al gancho 
de la parte superior del visor y acople la 
abrazadera de metal de la parte inferior 
de la cubierta del visor al gancho de la 
parte inferior del visor.

Ganchos de conexión

3 Pulse la placa de fijación en la parte 
inferior de la cubierta del visor en la 
dirección de la flecha para fijar la cubierta 
del visor en su posición.

Placa de 
fijación

Apertura de la cubierta del visor

Tire de la parte inferior central de la cubierta 
del visor hacia usted y, a continuación, tire 
hacia arriba para abrir la cubierta.

[Nota]
Cuando mueva el visor, sujete el cuerpo de visor y, a 
continuación, muévalo. No sujete la cubierta del visor.

Extracción de la cubierta del visor

Desconecte el bloqueo de la cubierta del visor 
y extraiga la cubierta del visor.

Acople del control remoto de la 
empuñadura

[Nota]
Acople o retire el control remoto de la empuñadura 
mientras la videocámara esté apagado.

1 Conecte el cable al conector del control 
remoto de la empuñadura.
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2 Alinee el acoplamiento del control remoto 
de la empuñadura de la videocámara con 
la marca de referencia de montaje de la 
empuñadura (), acople la empuñadura 
a la videocámara y gírela lentamente en el 
sentido contrario a las agujas del reloj 
().
Se escuchará un clic cuando encaje en su 
posición.

Marca de referencia

[Nota]
Si no se puede acoplar correctamente, vuelva a acoplarla 
sin aplicar demasiada fuerza al control remoto de la 
empuñadura o a la videocámara.

3 Inserte el cable conectado en el paso 2 
bajo la hendidura del control remoto de la 
empuñadura tal como se muestra en el 
diagrama.

[Nota]
Si no se coloca el cable bajo la hendidura, al cambiar el 
ángulo de acoplamiento de la empuñadura, se podría 
aplicar demasiada fuerza en el cable, o bien este podría 
quedar atrapado en el mecanismo de rotación.

Ajuste del ángulo del control remoto de 
la empuñadura

Puede ajustar el ángulo del control remoto de 
la empuñadura en el rango que se muestra 
en el siguiente diagrama para adaptarlo a su 
estilo.

Posición estándar

Girado hacia el objetivo (90° máx.)

Girado hacia la parte posterior (83° máx.)

1 Mueva la palanca de rotación de la 
empuñadura a la posición que se muestra 
en el diagrama y gire la empuñadura 
mientras presiona la palanca.

2 Retire el dedo de la palanca de rotación 
de la empuñadura al aproximarse a la 
posición deseada.

3 Mueva la empuñadura ligeramente hasta 
que escuche un clic, lo que indica que la 
empuñadura está fija en su posición.
Cuando la empuñadura está fija, la 
palanca de rotación de la empuñadura 
vuelve a la posición original.

[Notas]
ˎˎ Después de cambiar la posición, compruebe siempre 

que la empuñadura esté bien colocada.
ˎˎ No puede ajustar el ángulo fuera del rango de 

ajuste. No aplique demasiada fuerza cuando gire la 
empuñadura.

Cómo sujetar la empuñadura (método 
recomendado)

No existen normas para sujetar la 
empuñadura, pero en el siguiente ejemplo 
se muestra una forma fácil de utilizar la 
empuñadura.



2. Preparación: Acople de dispositivos22

Cuando se utiliza el botón ASSIGN 5 o el 
selector múltiple

A: utilice el dial asignable de la empuñadura 
con el dedo índice.
B: utilice el selector múltiple y el botón ASSIGN 
5 con el pulgar.
C: sujete firmemente la empuñadura con los 
dedos corazón, anular y meñique.

Cuando se utiliza el zoom

A: utilice la palanca de zoom con los dedos 
índice y corazón.
C: sujete firmemente la empuñadura con el 
pulgar.
C: sujete firmemente la empuñadura con los 
dedos anular y meñique.

Extracción de la empuñadura

[Nota]
Cuando extraiga la empuñadura, asegúrese de colocar 
la videocámara sobre una superficie plana como, por 
ejemplo, una mesa.

1 Desconecte el cable del conector del 
control remoto de la empuñadura.

2 Mantenga presionado el botón de 
liberación del control remoto de la 
empuñadura y gire la empuñadura en el 
sentido de las aguas del reloj hasta que 
se suelte.

Botón de liberación del control 
remoto de la empuñadura

[Consejo]
Se puede acoplar una roseta tanto en el punto de 
sujeción de la empuñadura en la unidad como en el 
punto de sujeción correspondiente de la empuñadura.
Para obtener más información sobre la compra de 
rosetas, póngase en contacto con su distribuidor Sony.
 – Lado de la videocámara: 4-546-932- (opcional)
 – Lado de la empuñadura: 4-547-089- (opcional)
 – Tornillos de fijación* 

Lado de la videocámara: 7-627-556- (opcional) 
Lado de la empuñadura: 7-627-556- (opcional)

* Se necesitan cuatro tornillos para cada roseta (los 
orificios de los tornillos se indican mediante círculos 
en el siguiente diagrama). El uso de tornillos distintos 
a los especificados podría dañar la superficie exterior.

Lado de la 
videocámara

Lado de la 
empuñadura

Acople de un objetivo

[PRECAUCIÓN]

No deje el objetivo orientado directamente 
al sol. La luz directa del sol puede penetrar 
a través del objetivo, enfocarse en la 
videocámara y provocar un incendio.

[Notas]
ˎˎ Acople o retire los objetivos mientras la videocámara 

esté apagado.
ˎˎ Los objetivos son componentes de precisión. No 

coloque los objetivos sobre una superficie dejando 
la montura de estos orientada hacia abajo. Acople la 
tapa de la montura del objetivo suministrada.

[Consejo]
Para obtener más información acerca de los objetivos 
compatibles con la videocámara, póngase en contacto 
con el servicio de asistencia técnica de Sony.

Acople de un objetivo de montura E

1 Retire la tapa del objetivo y la cubierta de 
la videocámara y el objetivo.

2 Alinee la marca de la montura del objetivo 
(blanca) con la videocámara, introduzca 
con cuidado el objetivo y, a continuación, 
gire el objetivo en el sentido de las agujas 
del reloj.
Se escuchará un clic cuando encaje en su 
posición.

Marcas de la montura (blancas)

[Nota]
No presione el botón de liberación del objetivo mientras 
acopla un objetivo.

Acople de un objetivo de montura A

Para utilizar un objetivo de montura A, acople 
un adaptador de montura de objetivos 
(opcional) y, a continuación, acople el objetivo 
de montura A.

[Nota]
Cuando se usa un objetivo con montura A, el diafragma se 
establece manualmente y el enfoque se establece en MF.

Extracción de un objetivo

Extraiga un objetivo a través del siguiente 
procedimiento.

1 Mantenga presionado el botón de 
liberación del objetivo y gire el objetivo en 
el sentido contrario a las agujas del reloj 
mientras lo sujeta.

2 Tire del objetivo hacia afuera en dirección 
de avance.
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[Notas]
ˎˎ Cuando extraiga un objetivo, alinee la marca de la 

montura del anillo de bloqueo del objetivo con la 
marca de la montura de la videocámara.
ˎˎ Sujete el objetivo con firmeza para impedir que caiga.
ˎˎ Si no se acopla otro objetivo inmediatamente, 

coloque siempre la tapa del cuerpo.

Ajustes de diafragma para objetivos con 
interruptor Auto Iris

ˎˎ Cuando la función Auto Iris del objetivo 
se ajusta en AUTO, el diafragma se ajusta 
automáticamente y también se puede 
ajustar manualmente desde la videocámara.
ˎˎ Cuando la función Auto Iris del objetivo se 
ajusta en MANUAL, el diafragma solo se 
puede ajustar usando el anillo del objetivo. 
El funcionamiento del diafragma desde la 
videocámara no tiene ningún efecto.

Ajustes de enfoque para objetivos con 
interruptor FOCUS

ˎˎ Cuando el interruptor de enfoque del 
objetivo se ajusta en AF/MF o AF, el enfoque 
se ajusta automáticamente y también se 
puede ajustar manualmente desde una 
unidad de control remoto.
ˎˎ Cuando el interruptor de enfoque del 
objetivo está configurado en MF, el enfoque 
se ajusta con el anillo del objetivo y también 
se puede ajustar manualmente desde una 
unidad de control remoto.

 [Nota]
Cuando se usa un objetivo con montura A, el ajuste 
manual de una unidad de control remoto puede no 
estar disponible.
ˎˎ Cuando el interruptor de enfoque del 
objetivo se ajusta en Full MF, el enfoque 
solo se puede ajustar usando el anillo del 
objetivo. El funcionamiento del enfoque 
desde la videocámara no tiene ningún 
efecto.

Acoplamiento en un trípode

Utilice los orificios para los tornillos del trípode 
de la videocámara cuando la acople a un 

trípode. Utilizar el soporte para trípode en el 
objetivo podría ocasionar daños.
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Configuración del funcionamiento básico de la videocámara
La pantalla de ajustes iniciales aparece en 
el visor la primera vez que se enciende la 
videocámara o después de que la batería de 
reserva se haya descargado completamente.
Ajuste la fecha y la hora del reloj interno en 
esta pantalla.

Time Zone
Time Zone ajusta la diferencia horaria desde 
UTC (Tiempo Universal Coordinado). Cambie el 
ajuste según sea necesario.

Ajuste de la fecha y la hora

Utilice el selector múltiple (página 7) 
o el dial multifunción (página 5) para 
seleccionar elementos y configuraciones y, a 
continuación, presione el botón de aplicación 
del selector múltiple o el dial multifunción 
para aplicar la configuración e iniciar el 
funcionamiento del reloj.
Después de cerrar la pantalla de ajustes, 
puede cambiar los ajustes de fecha, hora y 
zona horaria en Clock Set (página 100) en el 
menú Maintenance.

[Notas]
ˎˎ Si el ajuste del reloj se pierde debido a que la batería 

de reserva se descarga totalmente por el hecho 
de permanecer desconectado durante un período 
prolongado (sin batería ni fuente de alimentación 
DC IN), se mostrará la pantalla de ajustes iniciales la 
próxima vez que encienda la videocámara.
ˎˎ Mientras se muestra la pantalla de ajustes iniciales, 

no podrá realizar ninguna otra operación, excepto 
apagar el dispositivo, hasta que se completen los 
ajustes en esta pantalla.
ˎˎ La videocámara dispone de una batería recargable 

incorporada que almacena la fecha, la hora y otros 
ajustes incluso cuando está apagado.

Antes de filmar, configure el funcionamiento 
básico de la videocámara en la pantalla de 
estado Project que mejor se adapte a su uso.

4/12
Frequency/Scan

59.94P
Imager Scan

FF
Shooting Mode

Custom (709)
Codec

XAVC-I
Video Format

2160P3840
RAW Output Format

- - -
Rec Function

O�
Simul Rec

O�
Proxy Rec

O�
Title Prefix

000_
Number

0001

Project

Modo de filmación

Puede cambiar el modo de filmación entre 
el “modo Custom” para crear imágenes de 
manera flexible in situ y el “modo Cine EI” 
(donde la videocámara funciona de manera 
similar a una cámara de cine y el metraje se 
revela en postproducción).
Configure el modo de filmación en Shooting 
Mode (página 14) en la pantalla de estado 
Project.

[Consejo]
También puede configurar el modo de filmación en 
Base Setting >Shooting Mode (página 77) en el menú 
Project del menú completo.

Modo Custom

En el modo de filmación Custom, puede 
seleccionar el estándar de vídeo.
Puede configurar el estándar de vídeo en Base 
Setting >Target Display (página 77) en el 
menú Project del menú completo.
ˎˎ SDR(BT.709): filmación según el estándar de 
emisión HD
ˎˎ HDR(HLG): filmación según el estándar de 
emisión 4K de última generación

Para obtener más detalles, consulte 
página 52.

Modo Cine EI

Si el modo de filmación está ajustado en el 
modo Cine EI, seleccione el espacio de color 
base para la señal de grabación y la señal de 
salida. El espacio de color seleccionado aquí 
es el espacio de color de la salida de vídeo 
cuando MLUT se ajusta en Off.
Puede seleccionar el espacio de color en Cine 
EI Setting >Color Gamut (página 78) en el 
menú Project del menú completo.
ˎˎ S-Gamut3.Cine/SLog3: gama de colores fácil 
de ajustar para el cine digital (DCI-P3).
ˎˎ S-Gamut3/SLog3: amplia gama de colores 
de Sony que cubre el espacio de color ITU-R 
BT.2020.

Para obtener más detalles, consulte 
página 54.

[Notas]
ˎˎ El modo Cine EI tiene las siguientes limitaciones.

ˎˎ Funciones que no se pueden ajustar de forma 
automática (corrección)
 – Balance de blancos
 – Ganancia
 – Obturador

ˎˎ Funciones que no se pueden configurar
 – Ganancia/sensibilidad ISO (establecida en la 

sensibilidad ISO base (fija))
 – Configuración del menú Paint/Look (excepto 

Base Look)
 – Scene File (deshabilitado)

ˎˎ Las siguientes funciones solo están disponibles en 
modo Cine EI (página 54):

ˎˎ Exposure Index
ˎˎ Monitor LUT

Frecuencia del sistema

Configure la frecuencia del sistema en 
Frequency/Scan (página 14) en la pantalla 
de estado Project. La videocámara puede 
reiniciarse automáticamente después de 
cambiar, dependiendo del valor seleccionado.

[Consejo]
También puede configurar la frecuencia del sistema 
en Rec Format >Frequency (página 77) en el menú 
Project del menú completo.

[Nota]
No puede cambiar la frecuencia del sistema durante una 
grabación o una reproducción.

Modo de escaneado de la cámara

Puede establecer el tamaño efectivo de la 
imagen y la resolución del sensor de imagen.
Configure el modo de escaneado en Imager 
Scan (página 14) en la pantalla de estado 
Project.
ˎˎ FF: tamaño de fotograma completo
ˎˎ S35: tamaño Super 35 mm

[Consejo]
También puede seleccionar el modo de escaneado en 
Rec Format >Imager Scan Mode (página 77) en el 
menú Project del menú completo.

[Notas]
ˎˎ No puede cambiar el modo de escaneado de la 

cámara durante una grabación o una reproducción.
ˎˎ Cuando se ajusta a S35, el formato de vídeo está 

restringido a 1920×1080.

Códec

Ajuste el códec en Codec (página 14) en la 
pantalla de estado Project.

[Consejo]
También puede ajustar el códec en Rec Format >Codec 
(página 77) en el menú Project del menú completo.

[Nota]
No puede cambiar el códec durante una grabación o 
una reproducción.
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Formato de vídeo

Puede configurar el formato de vídeo para la 
grabación. Configure el formato de vídeo en 
Video Format (página 14) en la pantalla de 
estado Project.

[Consejo]
También puede configurar el formato de vídeo en Rec 
Format >Video Format (página 77) en el menú Project 
del menú completo.

[Notas]
ˎˎ No puede cambiar el formato de vídeo durante una 

grabación o una reproducción.
ˎˎ Se pueden aplicar restricciones a la señal de 

los conectores SDI OUT y HDMI OUT, según la 
configuración del formato de vídeo.
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La videocámara graba audio y vídeo en tarjetas de memoria CFexpress Tipo A o en tarjetas de 
memoria SDXC (ambas disponibles por separado) insertadas en las ranuras para tarjetas. Las 
tarjetas de memoria también se utilizan para grabar proxy y almacenar/cargar configuraciones, 
así como para realizar actualizaciones de software.

Acerca de las tarjetas de memoria CFexpress Tipo A

Utilice las tarjetas de memoria CFexpress Tipo A de Sony* indicadas en “Soportes recomendados” 
(página 27) en la videocámara.
Para obtener más información sobre las operaciones con soportes de otros fabricantes, consulte 
las instrucciones de funcionamiento de dichos soportes o la información del fabricante.
*  En este documento se denominan “tarjetas CFexpress”.

Acerca de las tarjetas de memoria SDXC

Utilice las tarjetas de memoria SDXC* indicadas en “Soportes recomendados” (página 27) en la 
videocámara.
*  En este documento se denominan “tarjetas SD”.

Uso de tarjetas de memoria
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Soportes recomendados

Las condiciones de funcionamiento garantizadas variarán según los ajustes de Rec Format y Recording.
Sí: operación admitida
No: no se garantiza un funcionamiento normal

Formato de grabación CFexpress 
Tipo A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out &  
XAVC-I

4096×2160
Class300

Modo Normal 59.94P Sí No No No No No No Sí

50P Sí No No No No No No Sí

29.97P Sí No No No No No Sí Sí

25P Sí No No No No No Sí Sí

24P Sí No No No No No Sí Sí

23.98P Sí No No No No No Sí Sí

3840×2160
Class300

Modo Normal 59.94P Sí No No No No No No Sí

50P Sí No No No No No No Sí

29.97P Sí No No No No No Sí Sí

25P Sí No No No No No Sí Sí

23.98P Sí No No No No No Sí Sí

S&Q (60fps o inferior) 59.94P Sí No No No No No No Sí

50P Sí No No No No No No Sí

29.97P Sí No No No No No No Sí

25P Sí No No No No No No Sí

23.98P Sí No No No No No No Sí
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Formato de grabación CFexpress 
Tipo A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Modo Normal 59.94P Sí No No No No No No Sí

50P Sí No No No No No No Sí

29.97P Sí No No No No No Sí Sí

25P Sí No No No No No Sí Sí

24P Sí No No No No No Sí Sí

23.98P Sí No No No No No Sí Sí

S&Q (60fps o inferior) 59.94P Sí No No No No No No Sí

50P Sí No No No No No No Sí

29.97P Sí No No No No No No Sí

25P Sí No No No No No No Sí

24P Sí No No No No No No Sí

23.98P Sí No No No No No No Sí

3840×2160
Class300 

Modo Normal 59.94P Sí No No No No No No Sí

50P Sí No No No No No No Sí

29.97P Sí No No No No No Sí Sí

25P Sí No No No No No Sí Sí

23.98P Sí No No No No No Sí Sí

S&Q (60fps o inferior) 59.94P Sí No No No No No No Sí

50P Sí No No No No No No Sí

29.97P Sí No No No No No No Sí

25P Sí No No No No No No Sí

23.98P Sí No No No No No No Sí

S&Q (100fps, 120fps) 59.94P Sí No No No No No No No

50P Sí No No No No No No No

29.97P Sí No No No No No No No

25P Sí No No No No No No No

23.98P Sí No No No No No No No
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Formato de grabación CFexpress 
Tipo A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Modo Normal 59.94P Sí No No No No No Sí Sí

50P Sí No No No No No Sí Sí

29.97P Sí No No Sí No Sí Sí Sí

25P Sí No No Sí No Sí Sí Sí

23.98P Sí No No Sí No Sí Sí Sí

S&Q (60fps o inferior) 59.94P Sí No No No No No Sí Sí

50P Sí No No No No No Sí Sí

29.97P Sí No No No No No Sí Sí

25P Sí No No No No No Sí Sí

23.98P Sí No No No No No Sí Sí

S&Q (100fps, 120fps) 59.94P Sí No No No No No No Sí

50P Sí No No No No No No Sí

29.97P Sí No No No No No No Sí

25P Sí No No No No No No Sí

23.98P Sí No No No No No No Sí

S&Q (150fps, 180fps) 59.94P Sí No No No No No No No

50P Sí No No No No No No No

29.97P Sí No No No No No No No

25P Sí No No No No No No No

23.98P Sí No No No No No No No

S&Q (200fps, 240fps) 59.94P Sí No No No No No No No

50P Sí No No No No No No No

29.97P Sí No No No No No No No

25P Sí No No No No No No No

23.98P Sí No No No No No No No
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Formato de grabación CFexpress 
Tipo A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840×2160
420 

Modo Normal 59.94P Sí No No Sí No Sí Sí Sí

50P Sí No No Sí No Sí Sí Sí

29.97P Sí No No Sí No Sí Sí Sí

25P Sí No No Sí No Sí Sí Sí

23.98P Sí No No Sí No Sí Sí Sí

S&Q (60fps o inferior) 59.94P Sí No No Sí No Sí Sí Sí

50P Sí No No Sí No Sí Sí Sí

29.97P Sí No No No No No Sí Sí

25P Sí No No No No No Sí Sí

23.98P Sí No No No No No No Sí

S&Q (100fps, 120fps) 59.94P Sí No No No No No Sí Sí

50P Sí No No No No No Sí Sí

29.97P Sí No No No No No No Sí

25P Sí No No No No No No Sí

23.98P Sí No No No No No No No

1920×1080
HD50

Modo Normal 59.94P Sí No No Sí No Sí Sí Sí

50P Sí No No Sí No Sí Sí Sí

29.97P Sí No No Sí No Sí Sí Sí

25P Sí No No Sí No Sí Sí Sí

23.98P Sí No No Sí No Sí Sí Sí

S&Q (60fps o inferior) 59.94P Sí Sí Sí Sí Sí Sí Sí Sí

50P Sí Sí Sí Sí Sí Sí Sí Sí

29.97P Sí No No Sí No Sí Sí Sí

25P Sí No No Sí No Sí Sí Sí

23.98P Sí No No Sí No Sí Sí Sí

S&Q (100fps, 120fps) 59.94P Sí No No Sí No Sí Sí Sí

50P Sí No No Sí No Sí Sí Sí

29.97P Sí No No No No No Sí Sí

25P Sí No No No No No Sí Sí

23.98P Sí No No No No No Sí Sí
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Formato de grabación CFexpress 
Tipo A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q (150fps, 180fps) 59.94P Sí No No No No No Sí Sí

50P Sí No No No No No Sí Sí

29.97P Sí No No No No No No Sí

25P Sí No No No No No No Sí

23.98P Sí No No No No No No Sí

S&Q (200fps, 240fps) 59.94P Sí No No No No No Sí Sí

50P Sí No No No No No Sí Sí

29.97P Sí No No No No No No Sí

25P Sí No No No No No No Sí

23.98P Sí No No No No No No Sí

1920×1080
HD35

Modo Normal 59.94P Sí Sí Sí Sí Sí Sí Sí Sí

50P Sí Sí Sí Sí Sí Sí Sí Sí

29.97P Sí Sí Sí Sí Sí Sí Sí Sí

25P Sí Sí Sí Sí Sí Sí Sí Sí

23.98P Sí Sí Sí Sí Sí Sí Sí Sí

S&Q (60fps o inferior) 59.94P Sí Sí Sí Sí Sí Sí Sí Sí

50P Sí Sí Sí Sí Sí Sí Sí Sí

29.97P Sí No No Sí No Sí Sí Sí

25P Sí No No Sí No Sí Sí Sí

23.98P Sí No No Sí No Sí Sí Sí

S&Q (100fps, 120fps) 59.94P Sí No No Sí No Sí Sí Sí

50P Sí No No Sí No Sí Sí Sí

29.97P Sí No No Sí No Sí Sí Sí

25P Sí No No Sí No Sí Sí Sí

23.98P Sí No No No No No Sí Sí

S&Q (150fps, 180fps) 59.94P Sí No No Sí No Sí Sí Sí

50P Sí No No Sí No Sí Sí Sí

29.97P Sí No No No No No Sí Sí

25P Sí No No No No No Sí Sí

23.98P Sí No No No No No Sí Sí

S&Q (200fps, 240fps) 59.94P Sí No No Sí No Sí Sí Sí

50P Sí No No Sí No Sí Sí Sí

29.97P Sí No No No No No Sí Sí

25P Sí No No No No No Sí Sí

23.98P Sí No No No No No No Sí
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Introducción de una tarjeta de 
memoria

1 Abra la tapa de soportes de la sección de 
la ranura para tarjetas.

2 Introduzca una tarjeta de memoria.
ˎˎ En las tarjetas CFexpress, la etiqueta 
mira hacia la izquierda.

Etiqueta

ˎˎ En las tarjetas SD, la etiqueta mira hacia 
la derecha con la esquina biselada en la 
parte inferior.

Esquina biselada

El indicador de acceso (página 6) se 
iluminará en rojo y, a continuación, 
cambiará a verde si la tarjeta se puede 
utilizar.

[Nota]
Si el indicador de acceso parpadea continuamente 
en color rojo y no cambia a verde, apague 
temporalmente la videocámara, retire la tarjeta de 
memoria e insértela de nuevo.

3 Cierre la tapa de soportes.

[Notas]
ˎˎ La tarjeta de memoria, la ranura de la tarjeta de 

memoria y los datos de imagen de la tarjeta de 
memoria pueden resultar dañados si la tarjeta se 
introduce a la fuerza en la ranura en la orientación 
incorrecta.
ˎˎ Cuando grabe en los soportes utilizando ambas 

ranuras de tarjeta CFexpress Tipo A/SD, la A y la 
B, inserte los soportes en las dos ranuras que se 
recomiendan para su funcionamiento con el formato 
que desea grabar.

Extracción de una tarjeta de 
memoria

Abra la tapa de soportes de la sección de la 
ranura para tarjetas y presione ligeramente la 
tarjeta de memoria para extraerla.

[Notas]
ˎˎ Si el camcorder está apagado o si se extrae la tarjeta 

de memoria mientras se está accediendo a esta, no 
se podrá garantizar la integridad de los datos de la 
tarjeta. Es posible que se pierdan todos los datos 
grabados en la tarjeta. Asegúrese de que el indicador 
de acceso esté siempre iluminado en color verde o 
apagado antes de apagar el camcorder o extraer la 
tarjeta de memoria.
ˎˎ Cuando extraiga una tarjeta de memoria 

inmediatamente después de finalizar una grabación, 
es posible que la tarjeta de memoria esté caliente, 
pero esto no significa que haya un problema.

Formateo (inicialización) de 
tarjetas de memoria

Si se introduce una tarjeta de memoria sin 
formatear o formateada con especificaciones 
diferentes, aparecerá en el visor el mensaje 
“Media Needs to be Formatted”.
Formatee la tarjeta mediante el siguiente 
procedimiento.

1 Seleccione Format Media (página 86) 
en el menú TC/Media del menú completo.

2 Seleccione Media(A) (ranura A) o Media(B) 
(ranura B) y, a continuación, seleccione el 
método de formateo (Full Format o Quick 
Format).
Aparecerá un mensaje de confirmación.
ˎˎ Full Format: inicia el soporte por 
completo, incluida la información acerca 
de la gestión de datos y la región de 
datos.
ˎˎ Quick Format: inicia solo la información 
acerca de la gestión de datos del 
soporte.

3 Seleccione Execute.
Se mostrará un mensaje durante el 
formateo y el indicador de acceso se 
iluminará en rojo.
Cuando se haya completado el formateo, 
se mostrará un mensaje de finalización. 
Pulse el dial multifunción para ignorar el 
mensaje.

[Notas]
ˎˎ Al formatear una tarjeta de memoria se borran todos 

los datos, incluidos los archivos de configuración y los 
datos de vídeos grabados.
ˎˎ Es posible que aparezcan mensajes durante la 

ejecución dependiendo de la duración del proceso de 
formateo.

Si el formateo no se completa 
correctamente

Las tarjetas de memoria no compatibles con la 
videocámara no se podrán formatear.
Se mostrará un mensaje de advertencia. Siga 
las instrucciones para sustituir la tarjeta por 
una tarjeta de memoria compatible.

Para utilizar una tarjeta SD formateada 
con el camcorder en la ranura de otro 
dispositivo

En primer lugar, realice una copia de 
seguridad de la tarjeta y, a continuación, 
vuelva a formatear la tarjeta en el dispositivo 
que se va a utilizar.
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Comprobación del tiempo de 
grabación restante

Durante la filmación (grabación/en espera), 
puede comprobar la capacidad restante de la 
tarjeta de memoria en cada ranura mediante 
los indicadores de los soportes A/B restantes 
en el visor (página 11).
El tiempo de grabación restante se calcula a 
partir de la capacidad restante de los soportes 
en cada ranura y del formato de vídeo actual 
(velocidad de bits de grabación), y se mostrará 
en minutos.

Tiempo de cambio de tarjetas de 
memoria

ˎˎ Cuando el tiempo de grabación restante 
total en las dos tarjetas de memoria es 
inferior a 5 minutos, aparece el mensaje 
“Media Near Full”, la lámpara indicadora/
indicador de grabación comienza a 
parpadear y se escucha un pitido (salida de 
auriculares) de advertencia.  
Introduzca algún soporte que disponga de 
espacio.
ˎˎ Si continúa grabando hasta que el tiempo 
restante de grabación total llegue a cero, 
el mensaje cambiará a “Media Full” y la 
grabación se detendrá.

[Nota]
En una tarjeta de memoria se pueden grabar hasta 600 
clips aproximadamente.

Restablecimiento de tarjetas de 
memoria

Si, por alguna razón, se produjera un error 
en una tarjeta de memoria, esta debe 
restablecerse antes de usarla.
Si carga una tarjeta de memoria que necesite 
restablecerse, aparecerá un mensaje en la 
pantalla del visor en el que se le preguntará si 
desea restablecerla.

Restablecer una tarjeta

Gire el dial multifunción para (página 5) 
seleccionar Execute y, a continuación, pulse el 
dial multifunción.
Se mostrará un mensaje y el estado de avance 
(%) durante el formateo y el indicador de 
acceso se iluminará en rojo.
Cuando termine el restablecimiento, aparecerá 
un mensaje de finalización.

Si falla el restablecimiento

ˎˎ No se pueden restablecer las tarjetas de 
memoria donde se haya producido un error. 
Se mostrará un mensaje de advertencia. 
Siga las instrucciones para sustituir la tarjeta 
de memoria.
ˎˎ Las tarjetas de memoria en las que se haya 
producido un error pueden volver a usarse 
si se vuelven a formatear.
ˎˎ Algunos clips pueden restablecerse, pero 
otros no. Los clips restablecidos pueden 
reproducirse con normalidad.

[Notas]
ˎˎ Asegúrese de utilizar esta videocámara para 

restablecer los soportes grabados con ella.
ˎˎ Es posible que los soportes grabados con un 

dispositivo que no sea esta videocámara o con 
una videocámara de versión diferente (incluso del 
mismo modelo) no se restablezcan mediante esta 
videocámara.

ˎˎ Los clips de menos de 2 segundos no se pueden 
restablecer.
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Procedimiento básico de funcionamiento
La filmación básica se realiza mediante el 
siguiente procedimiento.

1 Acople los dispositivos necesarios y 
compruebe que se suministra la 
alimentación necesaria.

2 Introduzca las tarjetas de memoria.

3 Coloque el interruptor POWER en la 
posición ON.
Se encenderá el indicador POWER y 
aparecerá en el visor la imagen de la 
cámara.

4 Pulse el botón START/STOP de grabación 
(página 5).
El indicador de grabación/lámpara 
indicadora se enciende y se inicia la 
grabación.

5 Para detener la grabación, pulse el botón 
START/STOP de grabación de nuevo.
La grabación se detendrá y la 
videocámara cambiará al modo STBY (en 
espera).

[Nota]
Si se pulsa el botón START/STOP de grabación pocos 
segundos después de encender la videocámara, el 
indicador de grabación/lámpara indicadora se iluminará 
para indicar que la unidad se encuentra en estado de 
grabación; pero es posible que la grabación en los 
soportes no se produzca durante los primeros segundos, 
según el formato de grabación seleccionado.

Intercambio de tarjetas de 
memoria

Si introduce dos tarjetas de memoria, pulse 
el botón SLOT SELECT (página 6) para 
intercambiar las tarjetas.
La grabación cambia automáticamente a 
la segunda tarjeta de memoria justo antes 
de que la capacidad restante en la primera 
tarjeta se reduzca a cero (grabación de 
retransmisión). Puede continuar grabando 
de forma continua al cambiar de tarjeta de 
memoria si sustituye la tarjeta de memoria 
llena por una nueva.

[Nota]
No se pueden intercambiar las tarjetas de memoria 
durante el modo de reproducción. Además, la 
reproducción continua de un soporte de duración de un 
clip en la ranura A y B no es compatible.

Clips (datos grabados)
Al dejar de grabar, el vídeo, el audio, y los 
datos que los acompañan desde el principio 
hasta el final de la grabación se guardan como 
un solo “clip” en una tarjeta de memoria.

Nombres de clips
A todos los clips grabados con este camcorder 
se les asignará un nombre automáticamente 
usando el formato establecido en la opción 
Clip Name Format (página 86) del menú TC/
Media del menú completo.

Duración máxima de clip
Hasta 6 horas por clip.
La duración máxima de una grabación 
continua es la misma que la duración máxima 
de un clip. Si el tiempo de grabación supera 
la duración máxima de un clip, se crea un 
clip nuevo automáticamente y continúa la 
grabación. El nuevo clip aparece como un 

clip separado en la pantalla de imágenes en 
miniatura.

Se graban varios clips sucesivamente durante 
la grabación continua, pero la grabación se 
detendrá de manera automática transcurridas 
unas 24 horas.

[Notas]
ˎˎ No extraiga una tarjeta de memoria mientras se 

esté grabando en ella. Cambie solo las tarjetas de 
memoria en las ranuras cuyo indicador de acceso esté 
apagado.
ˎˎ Cuando la capacidad restante de la tarjeta de 

memoria en la que se está grabando es inferior a un 
minuto y en la otra ranura se ha insertado otra tarjeta 
de memoria en la que se puede grabar, aparecerá 
el mensaje “Will Switch Slots Soon”. El mensaje 
desaparecerá después de cambiar las ranuras de 
tarjeta de memoria.
ˎˎ Es posible que la grabación continua no funcione si 

la grabación comienza cuando la capacidad restante 
de la tarjeta de memoria es inferior a un minuto. Para 
una grabación continua correcta, compruebe que 
la capacidad restante de la tarjeta de memoria es 
superior a un minuto antes de comenzar a grabar.
ˎˎ Los vídeos creados con la función de grabación 

continua del camcorder no se pueden reproducir sin 
interrupciones en el camcorder.
ˎˎ Para combinar los vídeos creado con la función de 

grabación continua del camcorder, utilice el software 
“Catalyst Browse”.

Control del audio

Puede controlar el audio que se está grabando 
con los auriculares.
Al conectar unos auriculares a la toma de 
auriculares (página 5) podrá controlar 
el audio que se está grabando. También 
puede controlar el audio de reproducción 
(página 64) con el altavoz integrado 
(página 6) o con los auriculares.
Puede ajustar el volumen del audio que desea 
controlar con Volume (página 14) en la 
pantalla Audio Status o con Audio Output 

>Volume (página 91) en el menú Audio del 
menú completo.
Puede seleccionar el canal de que desea 
supervisar con Monitor CH (página 14) en 
la pantalla Audio Status o con Audio Output 
>Monitor CH (página 91) en el menú Audio 
del menú completo.

Especificación de los datos de 
tiempo

Ajuste del código de tiempo

Ajuste el código de tiempo para grabar 
mediante Timecode (página 85) en el menú 
TC/Media del menú completo.

Ajuste de los bits del usuario

Puede añadir un número hexadecimal de 8 
dígitos a la imagen grabada como bits de 
usuario. También puede establecer los bits del 
usuario a la hora actual. Establezca el uso de 
Users Bit (página 85) en el menú TC/Media.

Visualización de los datos de tiempo

Ajuste el código de tiempo que se va a 
mostrar mediante TC Display (página 85) 
>Display Select en el menú TC/Media.
Si pulsa un botón asignable (página 48) 
al que se le haya asignado DURATION/TC/U-
BIT, cambiará la visualización entre código de 
tiempo, bits de usuario y duración de forma 
consecutiva.



3. Filmación: Procedimiento básico de funcionamiento35

Cambio de la entrada/salida de código 
de tiempo

Puede cambiar la entrada/salida de código de 
tiempo con el interruptor de selección TC IN/
OUT (página 4).
Para obtener más detalles, consulte 
página 108.

Revisión de la grabación (Rec 
Review)

Puede revisar el último clip grabado en la 
pantalla (revisión de grabación).

[Nota]
Rec Review no es compatible si el formato de vídeo se 
cambia después de grabar un clip.

Método de revisión de la grabación

Asigne Rec Review a uno de los botones 
asignables primero.
Cuando detenga la grabación, pulse el botón 
asignable (página 48) al que se ha asignado 
la función Rec Review. La reproducción del 
último clip grabado se inicia.
El clip se reproduce hasta el final, Rec Review 
finaliza y la videocámara vuelve al modo STBY 
(en espera).

Para detener Rec Review

Presione el botón asignable con Rec Review 
asignado o presione el botón CANCEL/BACK.

Ajustes de revisión de grabación

Puede establecer el punto de inicio de 
la reproducción en uno de los siguientes 
mediante el ajuste Rec Review (página 93) 
en el menú Technical.

ˎˎ Últimos 3 segundos del clip
ˎˎ Últimos 10 segundos del clip
ˎˎ Inicio del clip

[Consejo]
Si desea revisar un clip específico después de grabar 
varios clips, presione el botón THUMBNAIL para mostrar 
la pantalla de miniaturas y seleccione el clip para 
comenzar la reproducción.
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Puede ajustar el zoom según las condiciones 
de filmación.

Si acopla un objetivo con zoom motorizado, 
puede ajustar el zoom con la palanca de zoom 
del control remoto de la empuñadura o del 
asa. La velocidad del zoom varía según la 
presión aplicada a la palanca.
La videocámara cuenta con una función de 
zoom que utiliza un procesamiento de la señal 
de la imagen llamado Clear Image Zoom. 
Cuando Clear Image Zoom está activado, se 
admite el zoom incluso para los objetivos de 
distancia focal fija. También se puede utilizar 
para ampliar el rango más allá del rango 
óptico de un objetivo con zoom motorizado.
La relación de zoom máxima con Clear Image 
Zoom varía en función de la resolución de 
grabación.
ˎˎ Para la resolución de grabación QFHD/4K: 
1,5×
ˎˎ Para la resolución de grabación HD: 2×

Selección del tipo de zoom

Configure el tipo de zoom con Zoom >Zoom 
Type (página 93) en el menú Technical del 
menú completo.
El tipo de zoom variará en función del tipo de 
objetivo acoplado.

Objetivo 
acoplado

Ajuste de Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Objetivo 
de focal 
fija/
objetivo 
con zoom 
manual

No se admite el 
funcionamiento 
del zoom con la 
palanca.

Se admite Clear 
Image Zoom.

Objetivo 
acoplado

Ajuste de Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Objetivo 
con zoom 
motorizado

Solo el zoom 
óptico

Se admiten el 
zoom óptico y 
Clear Image 
Zoom.

[Notas]
ˎˎ Clear Imagen Zoom no está disponible en los 

siguientes casos:
 – Cuando S&Q Motion >Frame Rate (página 76) en 

el menú Shooting del menú completo es superior 
a 60fps

 – Cuando Rec Format >Codec (página 77) en el 
menú Project del menú completo está ajustado en 
RAW o en una opción que incluya RAW

ˎˎ Cuando se utiliza el interruptor de selección SERVO/
MANUAL de un objetivo, la ampliación de Clear Image 
Zoom se restablece en 1×. 
ˎˎ Cuando se usa Clear Image Zoom, el área de enfoque 

se ajusta en Wide y el AF de detección de caras/ojos 
de desactiva.

Ajuste del zoom del asa

Ajuste el zoom del asa con Handle Zoom 
(página 93) en el menú Technical del menú 
completo.

Ajuste del sentido del anillo del 
zoom

En algunos objetivos de montura E, el sentido 
de rotación del anillo del zoom se puede 
invertir.
Establezca el sentido de rotación con Lens 
>Zoom Ring Direction (página 94) en el 
menú Technical del menú completo.

Ajuste del zoom
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Ajuste del enfoque
Puede ajustar el enfoque de forma automática 
o manual según las condiciones de disparo.

Ajuste manual del enfoque 
(Manual Focus)

Para ajustar el enfoque manualmente, ajuste 
el interruptor FOCUS (página 4) en la 
posición “MAN”.
Esto le permitirá ajustar el enfoque 
manualmente según las condiciones de 
filmación.
El enfoque manual resulta útil para los 
siguientes tipos de sujetos.
ˎˎ Sujetos en la parte más alejada de una 
ventana cubierta por gotas de agua
ˎˎ Sujetos con poco contraste con el fondo
ˎˎ Sujetos más alejados que otros más 
cercanos

[Consejo]
También puede utilizar en enfoque automático en los 
siguientes casos cuando el ajuste manual es el principal 
método de funcionamiento.
ˎˎ Cuando la sensibilidad de desplazamiento del sujeto 

AF está ajustada en 1(Locked)
ˎˎ Cuando el interruptor FOCUS está ajustado en la 

posición “AF”
ˎˎ Cuando se utiliza el anillo de enfoque (AF Assist, 

página 39)

Ajuste automático del enfoque 
(Auto Focus)

La videocámara utiliza AF de detección de 
fase para enfoque de alta velocidad y AF de 
contraste para enfoque de alta precisión.
La combinación de estos dos métodos AF 
proporciona un enfoque automático con alta 
velocidad y alta precisión.
Para ajustar el enfoque automáticamente, 
sitúe el interruptor FOCUS (página 4) de 
la videocámara en la posición “AUTO”. Si el 
objetivo dispone de interruptor de selección 
de enfoque, sitúe el interruptor en la posición 
“AF/MF” o “AF”. Si se ajusta el interruptor 
en la posición “Full MF” o “MF”, el enfoque 
del objetivo no se puede realizar con la 
videocámara (página 23).

[Consejo]
Cuando Focus >AF Assist (página 76) en el menú 
Shooting del menú completo está ajustado en On, aún 
puede usar el anillo de enfoque en el objetivo durante el 
enfoque automático para ajustar el enfoque.

[Notas]
ˎˎ Se necesita un objetivo compatible con enfoque 

automático.
ˎˎ Es posible que no se obtenga precisión según las 

condiciones de disparo.
ˎˎ El enfoque no se puede ajustar de manera automática 

en un objetivo de montura A.

Especificación de la posición/área de 
enfoque automático (Focus Area)

Puede establecer el área de destino para el 
enfoque automático con Focus >Focus Area 
(página 75) en el menú Shooting del menú 
completo.

Flexible Spot:
Enfoca una posición especificada en la 
imagen.
Cuando se selecciona, especifique la posición 
con el selector múltiple (página 7).
Puede volver a la posición central 
manteniendo presionado el selector múltiple.

Zone:
Busca automáticamente una posición de 
enfoque dentro de la zona especificada.
Cuando se selecciona, especifique la posición 
con el selector múltiple (página 7).
Puede volver a la posición central 
manteniendo presionado el selector múltiple.

Wide:
Busca un sujeto en un ángulo amplio de la 
imagen al enfocar. No se muestra un marco.

[Consejo]
Se admite la misma operación utilizando un botón 
asignable (página 48) asignado con Focus Area.
Puede mostrar/ocultar el marco del área de enfoque 
usando Display On/Off >Focus Area Indicator 
(página 87) en el menú Monitoring del menú 
completo.

[Notas]
ˎˎ El marco del área de enfoque no está oculto cuando 

se usa el botón DISPLAY.
ˎˎ El área de enfoque se ajusta en Wide cuando se 

utiliza Clear Image Zoom.

Cambio del área de enfoque 
rápidamente (Focus Setting)

También puede cambiar la posición y el 
tamaño del área de enfoque automático 
rápidamente durante la filmación asignando 
Focus Setting a un botón asignable 
(página 48).
La operación varía según el ajuste del área del 
enfoque.

Cuando Focus >Focus Area (página 75) en 
el menú Shooting del menú completo está 
ajustado en Flexible Spot o Zone
Puede cambiar la posición del área de 
enfoque pulsando un botón asignable 
asignado con Focus Setting y realizando el 
ajuste con el selector múltiple (página 7).
Puede volver a la posición central del área 
del enfoque a la vez que ajusta la posición 
presionando el selector múltiple.
Puede cambiar el tamaño del área de enfoque 
manteniendo pulsado un botón asignable 
asignado con Focus Setting.
Después de cambiar el tamaño, ajuste la 
posición del área del enfoque pulsando el 
selector múltiple.
Al finalizar, pulse el botón asignable asignado 
con Focus Setting para volver a la pantalla 
original.
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Cuando Focus >Focus Area (página 75) en 
el menú Shooting del menú completo está 
ajustado en Wide
Solo puede cambiar el tamaño del área de 
enfoque manteniendo pulsado un botón 
asignable asignado con Focus Setting. 
La posición también puede cambiarse 
modificando primero el tipo a Flexible Spot o 
Zone.

[Consejos]
ˎˎ Cuando Focus >Push AF Mode (página 75) en el 

menú Shooting del menú completo está ajustado 
en Single-shot AF(AF-S) y el interruptor FOCUS 
(página 4) está en la posición MF, puede cambiar 
la posición del área de enfoque con Focus Area(AF-S) 
(página 75).
ˎˎ Cuando se utiliza Clear Image Zoom, el ajuste del 

tamaño del área de enfoque se desactiva y se activa 
el funcionamiento del enfoque automático con 
prioridad a la zona central.
ˎˎ El marco del área de enfoque se muestra de color 

naranja cuando la modificación de la posición del 
área de enfoque es posible.

Mover el marco del área de enfoque 
mediante el funcionamiento táctil (área 
de enfoque táctil)

Puede cambiar la posición del área de 
enfoque pulsando un botón asignable 
(página 48) asignado con Focus Setting 
para cambiar la visualización del área de 
enfoque a naranja y, a continuación, moverla 
con el funcionamiento táctil.
Pulse la pantalla para mover el área de 
enfoque, con el área de enfoque centrada 
en la posición pulsada. Arrastre la pantalla 
para mover el área de enfoque a la posición 
indicada con el dedo (página 10).

[Consejo]
Puede activar/desactivar el funcionamiento táctil del 
enfoque en la pantalla de filmación mediante un botón 
asignable asignado con Focus Setting.

Pulse cualquier posición

El área de enfoque se mueve y se centra en 
la posición pulsada.

Arrastre para mover el área de enfoque, 
indicando la posición con el dedo

[Notas]
ˎˎ Si pulsa una posición o arrastra el área de enfoque 

hasta una posición que supere el rango de ajuste, 
el área de enfoque se ajustará al límite superior/
inferior/izquierdo/derecho del rango de ajuste.
ˎˎ Esta función no está disponible en las siguientes 

circunstancias.
 – Cuando Touch Operation (página 93) en el menú 

Technical del menú completo está ajustado en Off
 – Cuando el área de enfoque aparece de color gris o 

no aparece

Ajuste del funcionamiento del enfoque 
automático (velocidad de transición AF, 
sensibilidad de desplazamiento del 
sujeto AF)

Velocidad de transición AF
Puede establecer la velocidad de la unidad de 
enfoque para cuando el sujeto cambia usando 
Focus >AF Transition Speed (página 75) en 
el menú Shooting del menú completo.
Cuando se configura a baja velocidad, el 
enfoque se mueve lentamente cuando el 
sujeto que se enfoca se mueve, lo que permite 
tomar imágenes impresionantes.
Cuando se configura a alta velocidad, el 
enfoque alterna entre sujetos rápidamente. El 
sujeto que entra en el encuadre se enfoca al 
instante, lo que convierte este ajuste en ideal 
para la filmación documental que requiere un 
enfoque rápido.

Durante el cambio:
1(Slow): el enfoque funciona 
lentamente.
.
.
.
7(Fast): el enfoque funciona 
rápidamente.

Centrado en un sujeto lejano

Centrado en un sujeto cercano
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Sensibilidad de desplazamiento del sujeto AF
Puede establecer la sensibilidad para cambiar 
entre sujetos usando Focus >AF Subj. Shift 
Sens. (página 75) en el menú Shooting del 
menú completo.
Cuando se establece en una sensibilidad 
baja, el enfoque no cambia fácilmente incluso 
cuando otro sujeto se mueve delante del 
sujeto enfocado. Cuando se establece en una 
sensibilidad alta, el enfoque cambia para dar 
prioridad al sujeto que se mueve al frente.

[Consejo]
Si asigna AF Speed/Sens. a un botón asignable, las 
barras de nivel para el ajuste de los valores se muestran 
en el siguiente orden cada vez que se presiona el botón, 
lo que le permite cambiar los ajustes de velocidad de 
transición AF y de sensibilidad de desplazamiento del 
sujeto AF.
Velocidad de transición AF  Sensibilidad de 
desplazamiento del sujeto AF  Sin visualización…

AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

Cambio del enfoque a otro sujeto 
lentamente

Cambio del enfoque a otro sujeto 
rápidamente

Cambio del objetivo de enfoque 
manualmente (AF Assist)

Cuando Focus >AF Assist (página 76) en 
el menú Shooting del menú completo está 
ajustado en On, aún puede usar el anillo de 
enfoque en el objetivo durante el enfoque 
automático para ajustar el enfoque en un 
sujeto.
Cuando deje de utilizar la operación de anillo 
de enfoque, el enfoque automático seguirá 
enfocando al sujeto mediante el anillo de 
enfoque (estado AF Assist).
Después de operar el anillo de enfoque, mover 
el enfoque a otro sujeto es ligeramente más 
difícil, independientemente del ajuste Focus 
>AF Subj. Shift Sens. (página 75) en el menú 
Shooting del menú completo.
El estado AF Assist se cancela en los 
siguientes casos:
ˎˎ Cuando el sujeto enfocado mediante el 
anillo de enfoque ya no es visible
ˎˎ Al cambiar al enfoque manual
ˎˎ Cuando se registra una cara.

[Consejos]
ˎˎ El estado AF Assist se puede cancelar rápidamente 

con un botón asignable (página 48) asignado con 
Push AF/Push MF.
ˎˎ Al utilizar el anillo de enfoque, se borra la selección 

de cara registrada.
ˎˎ En el modo Face/Eye Only AF, el enfoque automático 

enfoca la cara más cercana a la posición de enfoque 
del anillo de enfoque.
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Uso del enfoque manual de forma 
temporal (Push Manual Focus)

Pulse el botón PUSH AUTO FOCUS 
(página 4) cuando está en modo 
de enfoque automático para enfocar 
manualmente mientras se presiona el botón.
El enfoque volverá al enfoque automático 
cuando suelte el botón.
Esto le permite detener temporalmente el 
enfoque automático y enfocar manualmente 
cuando algo que no es el sujeto de la 
filmación se cruza delante de este.

[Consejo]
La misma operación es compatible con un botón 
asignable (página 48) asignado con Push AF/Push 
MF.

Uso del enfoque automático de 
forma temporal (Push Auto Focus)

Cuando Focus >Push AF Mode (página 75) 
en el menú Shooting del menú completo 
se configure en AF, presione el botón PUSH 
AUTO FOCUS (página 4) cuando esté 
en modo de enfoque manual para enfocar 
automáticamente mientras se presiona el 
botón.
El enfoque ocurre dentro del área de enfoque 
establecida usando Focus >Focus Area 
(página 75) en el menú Shooting del menú 
completo.
El enfoque volverá al enfoque manual cuando 
suelte el botón.
Esto es útil cuando desea mover el enfoque 
lentamente de un sujeto a otro durante el 
enfoque manual.

[Consejo]
La misma operación es compatible con un botón 
asignable (página 48) asignado con Push AF/Push 
MF.

[Nota]
La función Push Auto Focus no se puede utilizar si el 
objetivo está ajustado en enfoque manual.

Uso de Enfoque automático de 
una sola toma (Push Auto Focus 
(AF-S))

Establezca Focus >Push AF Mode 
(página 75) en el menú Shooting del 
menú completo en Single-shot AF(AF-S) 
y, a continuación, configure el área de 
enfoque utilizando Focus >Focus Area(AF-S) 
(página 75) en el menú Shooting del menú 
completo.
Pulse el botón PUSH AUTO FOCUS cuando está 
en modo de enfoque manual para enfocar 
automáticamente a alta velocidad. El enfoque 
se detiene en cuanto suelta el botón.
El estado de enfoque se indica mediante el 
indicador de enfoque.
ˎˎ On: el enfoque está fijo en la posición de 
enfoque.
ˎˎ Parpadeando: fuera de enfoque. Debido a 
que el enfoque no es automático, cambie 
los ajustes de composición y enfoque para 
conseguir el enfoque.

El enfoque volverá al enfoque manual cuando 
suelte el botón.
Esto resulta útil cuando desea enfocar 
rápidamente a un sujeto antes de empezar a 
filmar.

[Consejos]
ˎˎ La misma operación es compatible con un botón 

asignable (página 48) asignado con Push AF/Push 
MF.
ˎˎ También puede asignar Push AF Mode a un botón 

asignable (página 48).
ˎˎ También puede asignar Focus Area(AF-S) a un botón 

asignable (página 48).
ˎˎ Puede mostrar/ocultar el marco del área de enfoque 

usando Display On/Off >Focus Area Ind.(AF-S) 
(página 87) en el menú Monitoring del menú 
completo.
ˎˎ Durante la ampliación del enfoque, el enfoque se 

ajusta para adaptarse a la posición de visualización 
ampliada.

[Notas]
ˎˎ La función Push Auto Focus no se puede utilizar si el 

objetivo está ajustado en enfoque manual.
ˎˎ El marco del área de enfoque no está oculto cuando 

se usa el botón DISPLAY.

Enfocar con una visualización 
aumentada (Focus Magnifier)

Según el ajuste predeterminado de fábrica, 
la función Focus Magnifier ×3/×6 se asigna 
al botón ASSIGN 4 en el control remoto de la 
empuñadura y el botón ASSIGN 7 en el asa 
(página 48).
Pulse el botón ASSIGN 4 o ASSIGN 7 para 
cambiar el visor a la pantalla de ampliación 
del enfoque, con el centro ampliado unas 
tres veces aproximadamente. Pulse el botón 
de nuevo para incrementar el aumento hasta 
aproximadamente seis veces. Esta función 
resulta útil para comprobar el enfoque.
Pulse el botón de nuevo para volver a la 
pantalla normal.
Puede mover la posición para que se amplíe 
durante la ampliación del enfoque mediante 
el selector múltiple (página 7). Si presiona 
el selector múltiple, se vuelve al centro de la 
imagen.
Cuando se usa el enfoque automático (AF) 
durante la ampliación del enfoque, el enfoque 
ocurre dentro del área de enfoque establecida 
usando Focus >Focus Area (página 75) en el 
menú Shooting del menú completo.
Si se utiliza la función Push Auto Focus (AF-S) 
durante la ampliación del enfoque, el enfoque 
se ajusta para adaptarse a la posición de 
visualización ampliada.

[Notas]
ˎˎ La imagen grabada o la imagen de salida SDI/HDMI 

no aumenta cuando se aumenta el enfoque.
ˎˎ Durante la ampliación del enfoque, el botón MENU y 

otras operaciones están desactivados.
ˎˎ La posición de ampliación regresa al centro de la 

pantalla cuando se apaga el camcorder.
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Enfoque usando Detección de 
caras y ojos (Face/Eye Detection 
AF)

La videocámara puede detectar las caras y los 
ojos de la gente y ajustar el enfoque en las 
caras y los ojos dentro del área de enfoque.
Esta función solo está disponible cuando 
el ajuste del enfoque está en el modo AF o 
durante el enfoque automático mediante una 
pulsación.
Cuando se detecta una cara, aparece un marco 
gris de detección de caras/ojos. Cuando es 
posible establecer el enfoque automático, 
el marco se vuelve de color blanco. Cuando 
se detectan ojos y se ajusta el enfoque, el 
marco de detección de caras/ojos aparece 
en los ojos. Cuando se detectan varios 
individuos, se determina el individuo principal 
automáticamente.

[Consejos]
ˎˎ Cuando el área de enfoque está configurada en Zone 

o en Flexible Spot y las caras o los ojos se superponen 
dentro del área de enfoque especificada, los marcos 
de detección de caras/ojos cambian a blanco y la 
videocámara enfoca esas caras/ojos.
ˎˎ Cuando se utiliza el enfoque automático mediante 

una pulsación (AF-S), los marcos de detección de 
caras/ojos de las caras/ojos enfocados cambian a 
verde.

Configure el funcionamiento del AF de 
detección de caras/ojos mediante Focus 
>Face Detection AF (página 75), en el menú 
Shooting.

Face/Eye Only AF:
La cámara detecta las caras/ojos de los 
sujetos (personas) y solo enfoca en las caras/
ojos. Si no se detecta ninguna cara ni ojo, el AF 
se detiene temporalmente (MF) y se muestra 
el icono de enfoque automático pausado del 
modo Face/Eye Only AF  (página 11). Este 
modo resulta eficaz cuando desea enfocar 
automáticamente únicamente las caras/ojos.

Face/Eye Priority AF:
La cámara detecta las caras/ojos de los 
sujetos (personas) y prioriza el enfoque en 
las caras/ojos. Cuando no se detecta ninguna 
cara ni ojo, el enfoque está en modo AF 
(ajuste predeterminado).

Off:
La función de AF de detección de caras/ojos 
está desactivada.

[Notas]
ˎˎ Durante el funcionamiento del enfoque automático 

mediante una pulsación, se activa Face/Eye Priority 
AF, aunque se haya seleccionado Face/Eye Only AF.
ˎˎ Cuando el interruptor FOCUS se ha establecido en 

MAN, se desactiva el AF de detección de caras/
ojos (salvo durante el funcionamiento del enfoque 
automático mediante una pulsación).
ˎˎ Si apaga la videocámara mientras Face/Eye Only AF 

está seleccionado, el modo cambia automáticamente 
a Face/Eye Priority AF cuando vuelva a encender la 
videocámara.
ˎˎ El AF de detección de caras/ojos no se admite cuando 

se utiliza Clear Image Zoom. El AF normal está 
activado.

Ocultar marcos de detección de caras/
ojos

Puede mostrar/ocultar los marcos de 
detección de caras/ojos mediante Display On/
Off >Face/Eye Detection Frame (página 87) 
en el menú Monitoring del menú completo.

[Nota]
Se muestran marcos verdes de detección de caras/ojos 
para las caras y los ojos que están enfocados usando el 
enfoque automático mediante una pulsación (AF-S), y 
no se ocultan con el botón DISPLAY o cuando Face/Eye 
Detection Frame se establece en Off.

Enfoque en una cara registrada

Durante el funcionamiento del AF de 
detección caras/ojos, puede registrar la cara 
de un sujeto (persona) para realizar el enfoque 
en dicha cara.

Solo se puede registrar una cara. El registro de 
una cara sobrescribe el registro actual.
Cuando se registra una cara, el marco de 
detección de caras/ojos cambia a un marco 
doble (marco de cara registrada) y se muestra 
el icono de cara registrada  (página 11).
En el AF de detección de caras/ojos, las 
siguientes acciones tienen lugar dependiendo 
de si se ha registrado una cara y del modo de 
funcionamiento del AF de detección de caras/
ojos.

En el modo Face/Eye Priority AF:
Si la cámara detecta una cara registrada, la 
cámara la enfoca. Si no se detecta la cara 
registrada, el AF de detección de caras/ojos se 
desactiva.

En el modo Face/Eye Only AF:
Si la cámara detecta solo la cara registrada, 
la cámara enfoca dicha cara/ojo. Si no se 
detecta la cara registrada, el AF se detiene 
temporalmente (MF) y se muestra el icono 
de enfoque automático pausado del modo 
Face/Eye Only AF  (página 11). Este 
modo resulta eficaz cuando desea enfocar 
automáticamente solo la persona registrada.

Ajuste de la cara registrada
Mueva el cursor de selección de caras 
(destacado en naranja) a la cara que 
desea registrar usando el selector múltiple 
(página 7) y presione el selector múltiple.

Otros marcos de detección de 
caras/ojos (gris)

Marco de cara 
registrado 
(marco blanco 
doble)

Cursor de selección de cara (naranja)

Borrar la cara registrada
Mueva el cursor de selección de caras al marco 
de cara registrada usando el selector múltiple 
(página 7) y presione el selector múltiple.
La cara registrada se borra, el marco de 
detección de caras/ojos pasa a ser un marco 
único y el icono de cara registrada desaparece.
Cuando se detectan caras/ojos sin mostrar 
el marco de cara registrada y se muestra el 
cursor de selección de caras (naranja), puede 
borrar la cara registrada pulsando dos veces el 
selector múltiple.

[Notas]
ˎˎ En el estado AF Assist (página 39), se borra la 

selección de cara registrada.
ˎˎ Cuando se utiliza Clear Image Zoom, no se puede 

utilizar el AF de detección de caras/ojos.
ˎˎ Es posible que no se detecten las caras y los ojos 

a causa del entorno de grabación, la condición del 
sujeto o los ajustes.
ˎˎ Es posible que no pueda obtener el efecto adecuado 

o que se pueda detectar como una cara objetos que 
no sean caras de personas, en algunos entornos 
de grabación. En este caso, ajuste la función AF de 
detección de caras/ojos en Off.
ˎˎ Se recomienda el registro de la cara del individuo 

previsto para realizar el enfoque antes de filmar.
ˎˎ El registro de caras puede resultar incorrecto en 

función del estilo del pelo o la decoración facial o si 
no se mira directamente a la cámara. En este caso, el 
marco de detección de caras/ojos puede convertirse 
en un marco doble, pero el icono de cara registrada 
no se muestra y la cara no está registrada.
ˎˎ Si ya se ha registrado una cara, se recomienda borrar 

la cara existente y, a continuación, registrar la cara 
nueva.

Cambio del funcionamiento del AF de 
detección de caras/ojos con un botón 
asignable

Asigne Face/Eye Detection AF a un botón 
asignable (página 48). Puede cambiar 
el funcionamiento del AF de detección de 
caras/ojos cada vez que pulse el botón, en el 
siguiente orden: Face/Eye Priority AF, Face/Eye 
Only AF y Off.

Ajuste mediante el menú directo

También se puede ajustar el funcionamiento 
del AF de detección de caras/ojos mediante el 
menú directo (página 48).
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Ajuste del brillo

B

C
D
E

F
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Puede ajustar el brillo mediante la regulación 
del diafragma, la ganancia, la velocidad 
del obturador y el nivel de luz con los 
filtros ND. También puede realizar ajustes 
automáticamente.
El nivel deseado para el ajuste de brillo 
automático se establece con Auto Exposure 
(página 73) >Level en el menú Shooting del 
menú completo. También puede asignar Auto 
Exposure Level a un botón asignable o al dial 
asignable (página 48).

[Nota]
La ganancia no puede ajustarse en el modo Cine EI. 
La sensibilidad base está fija. Asimismo, el brillo no 
puede ajustarse automáticamente con la velocidad del 
obturador. Se puede ajustar automáticamente el brillo 
con el disfragma o el filtro ND.

Selección de la sensibilidad base

Puede seleccionar entre dos tipos de 
sensibilidad base en la videocámara.
En el modo Custom, puede ajustar la 
sensibilidad base en High o Low mediante 
Base ISO/Sensitivity en la pantalla Main Status 
(página 13) o en la pantalla Camera Status 
(página 14), o bien mediante ISO/Gain/EI 
>Base Sensitivity (página 72) en el menú 
Shooting del menú completo.  
En el modo Cine EI, puede ajustar la 
sensibilidad ISO base en ISO 12800 o ISO 800 
mediante Base ISO/Sensitivity en la pantalla 
Main Status (página 13) o en la pantalla 
Camera Status (página 14), o bien mediante 
ISO/Gain/EI >Base ISO (página 72) en el 
menú Shooting del menú completo.
Se recomienda seleccionar Low o ISO 800 en 
condiciones de iluminación normales y High o 
ISO 12800 en condiciones de poca luz.

* También se puede configurar en la pantalla de 
estado.

[Consejo]
También puede asignar Base ISO/Sensitivity a un botón 
asignable (página 48).

Ajuste del diafragma

Puede ajustar el diafragma para ajustar el 
brillo.

Ajuste automático del diafragma

Esta función ajusta el brillo según el sujeto. 
Se necesita un objetivo compatible con 
diafragma automático.

1 Si se acopla un objetivo con interruptor 
Auto Iris, coloque el interruptor en AUTO.

2 Mantenga presionado el botón de función 
IRIS (E) para mostrar el menú directo 
(página 48) y seleccione Auto.

 [Consejo]
También puede asignar Auto Iris a un botón 
asignable (página 48).

 [Nota]
El diafragma no se puede ajustar de manera 
automática en un objetivo de montura A.

Ajuste manual del diafragma

1 Mantenga presionado el botón de función 
IRIS (E) para mostrar el menú directo 
(página 48) y seleccione Manual.

2 Presione el botón de función IRIS (E) para 
que el valor del diafragma se muestre en 
un fondo blanco.

3 Gire el dial multifunción para ajustar el 
valor.

 [Consejos]
ˎˎ También puede operar el dial multifunción como 

un dial IRIS (página 48) asignando la función 
IRIS al dial multifunción.
ˎˎ También puede asignar la función IRIS a un dial 

asignable (página 48).

Ajuste temporal de forma automática

Pulse el botón asignable (página 48) 
asignado con la función Push Auto Iris para 
ajustar automáticamente el diafragma 
mientas está pulsado el botón.
El diafragma volverá al ajuste anterior cuando 
suelte el botón.

[Nota]
Cuando el interruptor Auto Iris del objetivo se ajusta 
en “MANUAL”, las funciones Auto Iris y Push Auto Iris 
del camcorder no tendrán ningún efecto. Los ajustes 
manuales de diafragma en el camcorder tampoco 
tendrán ningún efecto.

Ajuste de la ganancia

En el modo Custom, puede ajustar la ganancia 
para ajustar el brillo.

Ajuste automático de la ganancia

Mantenga presionado el botón de función 
ISO/GAIN (H) para mostrar el menú directo 
(página 48) y seleccione Auto.

[Consejos]
ˎˎ También puede realizar la misma acción configurando 

Auto Exposure (página 73) >AGC en el menú 
Shooting en On.
ˎˎ También puede asignar AGC a un botón asignable 

(página 48).

Ajuste manual de la ganancia

Puede controlar la ganancia cuando desee 
ajustar la exposición con un ajuste de 
diafragma fijo, o bien cuando desee evitar que 
la ganancia aumente debido al AGC.

1 Mantenga presionado el botón de función 
ISO/GAIN (H) para mostrar el menú 
directo (página 48) y seleccione 
Manual.

2 Ajuste el interruptor ISO/GAIN (I) en H, M 
o L.

[Consejos]
ˎˎ También puede asignar la función Push AGC a un 

botón asignable y activar AGC de forma temporal 
manteniendo pulsado el botón.
ˎˎ Puede cambiar el valor preestablecido de cada 

posición del interruptor con ISO / Gain<L>/<M>/<H> 
(página 14) en la pantalla Camera Status, o 
bien con ISO/Gain/EI >ISO/Gain<H>/<M>/<L> 
(página 72) en el menú Shooting del menú 
completo.
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Control de la ganancia (ajuste fino)

1 Presione el botón de función ISO/GAIN (H) 
para que el valor de ganancia se muestre 
en un fondo blanco.

2 Gire el dial multifunción para ajustar el 
valor.

[Consejo]
Cambie al valor preestablecido de ganancia de acuerdo 
con la configuración del interruptor ISO/GAIN (I).

Control de la ganancia temporalmente 
(ajuste fino)

Gire el dial asignable (página 48) asignado 
a la función ISO/Gain/EI, para ajustar el valor 
de ganancia establecido con el interruptor 
ISO/GAIN (I).
Esto es útil cuando desea ajustar la exposición 
en un nivel sin cambiar la profundidad de 
campo.
El valor de ganancia ajustado se puede 
cancelar con el interruptor ISO/GAIN (I), 
cambiando la sensibilidad básica, activando 
AGC o apagando el dispositivo.

[Consejos]
ˎˎ También puede asignar esta función al dial 

multifunción (página 48).
ˎˎ También puede asignar la función Push AGC a un 

botón asignable y activar AGC de forma temporal 
manteniendo pulsado el botón.

Ajuste del índice de exposición

En el modo Cine EI, se presupone que la 
salida de vídeo con MLUT establecido en Off 
se graba como la señal principal. Al cambiar 
el brillo de la imagen con MLUT On para que 
coincida con el valor EI, puede comprobar 
el resultado del ajuste de la sensibilidad de 
exposición postproducción a la vez que filma.
Puede cambiar el valor EI ajustando el 
interruptor ISO/GAIN (I) en H, M o L.

[Consejo]
Puede cambiar el valor EI de cada posición del 
interruptor con ISO/Gain/EI (página 14) en la pantalla 
Camera Status, o bien con ISO/Gain/EI >Exposure 
Index<H>/<M>/<L> (página 72) en el menú Shooting 
del menú completo.

Ajuste fino del índice de exposición

1 Presione el botón de función ISO/GAIN (H) 
para que el valor EI se muestre en un 
fondo blanco.

2 Gire el dial multifunción para ajustar el 
valor.

[Consejo]
Cambie al valor preestablecido EI de acuerdo con la 
configuración del interruptor ISO/GAIN (I).

Ajuste del obturador

Puede ajustar el obturador para ajustar el 
brillo.

Ajuste automático del obturador

Mantenga presionado el botón de función 
SHUTTER (F) para mostrar el menú directo 
(página 48) y seleccione Auto para ajustar 
la velocidad del obturador o el ángulo del 
obturador automáticamente en respuesta al 
brillo de la imagen.

[Consejo]
También puede realizar la misma acción configurando 
Auto Exposure >Auto Shutter (página 74) en el menú 
Shooting del menú completo en On.

Ajuste manual del obturador

1 Mantenga presionado el botón de función 
SHUTTER (F) para mostrar el menú directo 
(página 48) y seleccione Speed o Angle.

2 Presione el botón de función SHUTTER (F) 
para que el valor del obturador se 
muestre en un fondo blanco.

3 Gire el dial multifunción para ajustar la 
velocidad del obturador.

[Consejos]
ˎˎ Para ajustar el tiempo de exposición para que 

coincida con el intervalo de fotogramas, seleccione 
Off en el paso 1.
ˎˎ También puede ajustar el ángulo y la frecuencia 

(página 72).

Ajuste del nivel de luz (filtro ND)

En condiciones donde la luz es demasiado 
fuerte, puede ajustar el brillo adecuado si 
cambia el filtro ND.
El camcorder posee dos modos de filtro ND. 
Puede alternar entre los dos modos con el 
interruptor ND PRESET/VARIABLE.

Ajuste en el modo predeterminado

Ajuste el interruptor ND PRESET/VARIABLE 
(A) a la posición PRESET, y ajuste los botones 
arriba/abajo de ND FILTER POSITION (B) a uno 
de los siguientes ajustes.
Clear: sin filtro ND
1: Transmitancia ajustada mediante ND Filter 
>Preset1 (página 72) en el menú Shooting 
del menú completo.
2: Transmitancia ajustada mediante ND Filter 
>Preset2 (página 72) en el menú Shooting 
del menú completo.
3: Transmitancia ajustada mediante ND Filter 
>Preset3 (página 72) en el menú Shooting 
del menú completo.

Ajuste en el modo variable

Ajuste el interruptor ND PRESET/VARIABLE (A) 
en la posición VARIABLE. Ajuste los botones 
arriba/abajo ND FILTER POSITION (B) entre 
CLEAR y On.

Ajuste automático del nivel de luz
Puede activar Auto ND Filter para habilitar el 
ajuste de exposición automática con el filtro 
ND.

1 Presione el botón [+] de los botones 
subir/bajar ND FILTER POSITION (B) para 
activar la operación del filtro ND.
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2 Mantenga presionado el botón ND 
VARIABLE AUTO (C) hasta que se 
seleccione Auto.

Ajuste manual del nivel de luz

1 Presione el botón [+] de los botones 
subir/bajar ND FILTER POSITION (B) para 
activar la operación del filtro ND.

2 Mantenga presionado el botón ND 
VARIABLE AUTO (C) hasta que se 
seleccione Manual.

3 Gire el dial ND VARIABLE (D) para ajustar 
la transmitancia del filtro.

[Consejo]
También puede asignar la función ND Filter a un dial 
asignable (página 48).

Ajuste temporal de forma automática
Puede asignar la función Push Auto ND a un 
botón asignable (página 48) y activar Auto 
ND Filter de forma temporal manteniendo 
pulsado el botón. Al soltar el botón, se vuelve 
a desactivar la función Auto ND Filter.
Presione el botón [+] de los botones subir/
bajar ND FILTER POSITION (B) para activar la 
operación del filtro ND.

[Nota]
Cuando ND Filter se cambia a o desde CLEAR durante el 
disparo, el marco del filtro ND se muestra en la imagen y 
el sonido de funcionamiento se incluye en el audio.

[Consejos]
ˎˎ Puede establecer en CLEAR girando el dial ND 

VARIABLE (D) hacia abajo desde ND1/4. Girando el 
dial hacia arriba desde CLEAR establece ND1/4. Puede 
deshabilitar esta acción usando ND Dial >CLEAR with 
Dial (página 93) en el menú Technical del menú 
completo.
ˎˎ También puede asignar ND Filter Position a un botón 

asignable (página 48) y pulsar el botón en lugar 
de utilizar los botones arriba/abajo de ND FILTER 
POSITION para cambiar el ajuste.  
Modo predeterminado: Clear  Preset1  Preset2 

 Preset3  Clear… 
Modo variable: Clear  On  Clear…
ˎˎ También puede asignar la función Auto ND Filter a un 

botón asignable (página 48) y pulsar el botón para 
activar y desactivar Auto ND Filter.
ˎˎ Cuando se filma un sujeto con mucha luz, un cierre 

excesivo del diafragma puede causar borrosidad 
por difracción, lo que hace que la imagen empiece a 
desenfocarse (un fenómeno habitual en las cámaras 
de vídeo). Puede suprimir este efecto para obtener 
mejores resultados en la filmación con el filtro ND.
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J

Puede seleccionar el modo de ajuste que 
mejor se adapte a las condiciones de 
filmación.

ATW (localización automática del 
balance de blancos)

Esta función ajusta el balance de blancos 
automáticamente en el nivel adecuado.
El balance de blancos se ajusta 
automáticamente cuando la temperatura de 
color de la fuente de luz cambia.
Mantenga presionado el botón de función 
WHT BAL (G) para mostrar el menú directo 
(página 48) y seleccione ATW.
Puede seleccionar la velocidad de ajuste 
(cinco pasos) mediante White Setting >ATW 
Speed (página 74) en el menú Shooting del 
menú completo.

[Consejo]
Puede congelar el ajuste del balance de blancos actual 
si asigna la función ATW Hold a un botón asignable 
(página 48) y pulsa el botón asignable para pausar 
temporalmente el modo ATW.

[Notas]
ˎˎ ATW no se puede utilizar en el modo Cine EI.
ˎˎ Tal vez no sea posible ajustar el color adecuado con 

ATW, según las condiciones de iluminación y del 
sujeto.  
Ejemplos:
 – Cuando un único color domina el sujeto, como por 

ejemplo el cielo, el mar, la tierra o las flores.
 – Cuando la temperatura del color es 

extremadamente alta o extremadamente baja.
 Si no se puede obtener el efecto adecuado porque 

la velocidad de corrección automática de ATW es 
demasiado lenta o por cualquier otro motivo, utilice el 
balance automático de blancos.

Ajuste manual del balance de 
blancos

1 Cuando el balance de blancos se 
establece en modo ATW, mantenga 
presionado el botón de función WHT BAL 
(G) para mostrar el menú directo 
(página 48) y seleccione W:P, W:A o 
W:B.

2 Seleccione B, A o PRESET con el 
interruptor WHT BAL (J).
B: modo memoria B
A: modo memoria A
PRESET: modo predeterminado

[Consejo]
ATW se puede habilitar para la memoria B configurando 
White Setting >White Switch<B> (página 75) en el 
menú Shooting del menú completo en ATW.

Modo memoria A/memoria B
Este modo ajusta el balance de blancos en la 
configuración guardada en la memoria A o B 
respectivamente.

Modo predeterminado
Este modo ajusta la temperatura del 
color a un valor predeterminado (el valor 
predeterminado de fábrica es 3200K).

Cambio del valor preestablecido 
predeterminado

En el modo predefinido, puede cambiar 
directamente un valor predefinido existente.
Mantenga presionado el botón de función 
WHT BAL (G) y seleccione una de las opciones 
siguientes en el menú directo.
Modo Custom: ˎ3200K, ˎ4300K, 

ˎ5600K, ˎ6300K
Modo Cine EI: ˎ3200K, ˎ4300K, ˎ5500K

[Consejo]
También puede asignar Preset White Select a un botón 
asignable (página 48) y pulsar el botón para cambiar 
el ajuste.
Modo Custom: 3200K  4300K  5600K  6300K  
 3200K…

Modo Cine EI: 3200K  4300K  5500K  3200K…

Cambio de la temperatura del color

1 Presione el botón de función WHT BAL (G) 
para que el valor de la temperatura de 
color se muestre en un fondo blanco.

2 Gire el dial multifunción para ajustar el 
valor.

[Consejos]
ˎˎ En el modo preestablecido, puede establecer el valor 

en unidades de 100K.
ˎˎ En el modo de memoria, puede establecer el valor 

en incrementos de 20K dentro del rango de 2000K 
a 5600K. Es posible establecer valores superiores 
a 5600K en intervalos equivalentes a la cantidad 
de cambio de color (mired) de 5580K a 5600K. 
También puede ajustar el valor de tinte con White 
(página 74) >Tint en el menú Shooting del menú 
completo.

Utilización del balance automático de 
blancos

El balance de blancos que está guardado 
en la memoria A/memoria B se configura 
automáticamente.

1 Seleccione el modo memoria A o el modo 
memoria B.

2 Coloque un papel blanco (u otro objeto) 
en un lugar con la misma fuente de 
iluminación y condiciones que el sujeto y, 
a continuación, utilice el zoom para 
acercarse al papel y así mostrar blanco en 
la pantalla.

3 Ajuste el brillo.
Ajuste el diafragma con el procedimiento 
descrito en “Ajuste manual del diafragma” 
(página 42).

4 Pulse el botón WB SET (página 4).
ˎˎ Si el balance automático de blancos se 
ejecuta en el modo de memoria, el valor 
de ajuste se guarda en la memoria (A o 
B) seleccionada en el paso 1.
ˎˎ Si el balance automático de blancos se 
ejecuta en el modo ATW, el ajuste del 
balance de blancos vuelve al balance de 
blancos del modo ATW cuando finaliza 
el ajuste.

[Nota]
Si el ajuste no se realiza correctamente, aparecerá 
un mensaje de error en la pantalla durante unos tres 
segundos. Si el mensaje de error continúa después 
de varios intentos repetidos de ajuste del balance 
de blancos, póngase en contacto con su servicio de 
asistencia técnica de Sony.

Ajuste de colores naturales (balance de blancos)
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Puede especificar el audio que se va a grabar 
con los conectores de entrada, interruptores y 
diales del camcorder.

Interruptores de selección y conectores 
de entrada de audio externa

Conector INPUT1 (página 7)
Conector INPUT2 (página 7)
Zapata de interfaz múltiple (página 7)
Interruptor INPUT1 (LINE/MIC/MIC+48V) 
(página 7)
Interruptor INPUT2 (LINE/MIC/MIC+48V) 
(página 7)

Interruptores para ajustar el nivel de 
audio

Interruptor CH1 (AUTO/MAN) (página 6)
Interruptor CH2 (AUTO/MAN) (página 6)
Dial AUDIO LEVEL (CH1) (página 6)
Dial AUDIO LEVEL (CH2) (página 6)

Pantalla Audio Status

Selección del dispositivo de 
entrada de audio

1 Configure la entrada de audio con CH1/
CH2/CH3/CH4 > Source (página 14) en 
la pantalla Audio Status o con Audio Input 
>CH1 Input Select en CH4 Input Select 
(página 90) en el menú Audio del 
menú completo.
Si utiliza un micrófono de zapata, un 
adaptador XLR o un dispositivo UWP 
(micrófono inalámbrico UHF), especifique 
Shoe CH1 o Shoe CH2. Para obtener más 
información acerca del adaptador de XLR, 
consulte “Adición de conectores de 
entrada de audio” (página 47).

 [Notas]
ˎˎ En los modos Interval Rec y Slow & Quick Motion 

no se graba audio.
ˎˎ La videocámara tiene un micrófono de narración 

integrado para grabar sonido ambiental. Se 
puede usar para realizar la sincronización con 
otros equipos. En tales casos, especifique Internal 
MIC.
ˎˎ Cuando se acopla el asa, solo se activa el 

micrófono interno del asa (página 7) para 
grabar audio. Cuando el asa no está acoplada, 
se puede utilizar el micrófono de narración 
(página 6) para grabar el sonido ambiental.
ˎˎ Cuando CH1 Input Select y CH2 Input Select están 

ajustados en Internal MIC, el nivel de grabación 
de audio de CH1 y CH2 se ajusta con el dial 
AUDIO LEVEL(CH1) (página 6). Cuando CH3 
Input Select y CH4 Input Select están ajustados 
en Internal MIC, el nivel de grabación de audio 
de CH3 y CH4 se ajusta con CH3 Input Level 
(página 90).

2 Seleccione la fuente de entrada de audio.
Ajuste los interruptores INPUT1/INPUT2 
(LINE/MIC/MIC+48V) en los dispositivos 
conectados a los conectores INPUT1/
INPUT2 respectivamente.

Dispositivo conectado Posición del 
interruptor

Fuente externa de audio 
(por ejemplo, mezclador)

LINE

Micrófono dinámico, 
micrófono con batería

MIC

Micrófono con 
alimentación fantasma de 
+48 V

MIC+48V

ˎˎ Si selecciona MIC+48V y conecta un 
micrófono que no sea compatible con 
fuentes de +48V, es posible que dañe 
el dispositivo conectado. Compruebe el 
ajuste antes de conectar el dispositivo.
ˎˎ Si le preocupa el ruido en conectores 
que no tengan un dispositivo conectado, 
ajuste los interruptores INPUT1/INPUT2 
(LINE/MIC/MIC+48V) correspondientes 
en LINE.

Ajuste automático del nivel de 
grabación de audio

Ajuste los interruptores CH1/CH2 (AUTO/
MAN) para que los canales se ajusten 
automáticamente en AUTO.
Para CH3/CH4, ajuste el control del nivel 
de audio en la pantalla Audio Status 
(página 14), o bien ajuste Audio Input 
>CH3 Level Control y CH4 Level Control en 
el menú Audio del menú completo en Auto 
(página 90).

Ajuste manual del nivel de 
grabación de audio

Utilice el siguiente procedimiento para ajustar 
el nivel de grabación de audio de CH1/CH2.

1 Ajuste los interruptores CH1/CH2 (AUTO/
MAN) para que los canales se ajusten 
automáticamente en MAN.

2 Durante la filmación o en espera, gire los 
diales AUDIO LEVEL (CH1)/(CH2) hasta los 
canales correspondientes para ajustar el 
nivel de audio.
ˎˎ Para CH3/CH4, ajuste el control del nivel 
de audio con CH3/CH4 (página 14) 
en la pantalla Audio Status, o bien 
con Audio Input >CH3 Level Control o 
CH4 Level Control en el menú Audio 
del menú completo, en Manual y, 
a continuación, ajuste el nivel de 
grabación de audio con CH3 Input Level 
o CH4 Input Level.
ˎˎ Puede ajustar los niveles de CH1 a CH4 
como grupo. Puede ajustar el nivel de 
grabación usando un dial asignable 
(página 48) asignado con la función 
Audio Input Level, la pantalla Audio 
Status o Audio Input >Audio Input Level 
en el menú Audio del menú completo.

[Consejo]
La pantalla Audio Status resulta cómoda para comprobar 
el nivel de entrada de audio (página 14).

[Notas]
ˎˎ Es posible que los ajustes de Audio Input Level 

estén desactivados, en función de la combinación 
de ajustes del menú Audio. Para obtener más 
información, consulte el diagrama en la página 125.
ˎˎ El camcorder admite combinaciones de diferentes 

ajustes. Para obtener más información, consulte el 
diagrama en la página 125.

Especificación del audio que se va a grabar
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Adición de conectores de entrada 
de audio

Puede conectar a la videocámara hasta cuatro 
canales de los dispositivos de audio XLR al 
mismo tiempo si utiliza un adaptador de XLR 
XLR-K2M (no suministrado) o un adaptador 
XLR K3M-XLR (no suministrado).
Conecte el adaptador XLR a la zapata de 
interfaz múltiple y ajuste CH3 >Source en Shoe 
CH1 y CH4 >Source en Shoe CH2 en la pantalla 
Audio Status (página 14). También puede 
ajustar Audio Input >CH3 Input Select en CH1 
y CH4 Input Select en Shoe CH2 en el menú 
Audio del menú completo.
Las funciones la videocámara que se solapen 
se inhabilitarán para los canales en los que el 
adaptador de XLR se haya seleccionado como 
la entrada. Utilice los interruptores y los diales 
del adaptador de XLR para realizar los ajustes.

[Notas]
ˎˎ La videocámara admite la interfaz de audio digital 2ch 

del XLR-K3M.
ˎˎ Si Audio Input >CH3 Level y CH4 Level se han 

establecido en Audio Input Level en el menú Audio, el 
Audio Input Level la videocámara se multiplicará por 
el nivel que se haya ajustado en el adaptador de XLR.  
Audio Input Level también se habilita cuando el dial 
del adaptador de XLR está ajustado en AUTO.  
Cuando se especifique “Through”, el audio se grabará 
en el nivel que se haya ajustado con el adaptador de 
XLR (página 126).
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Funciones útiles

Funcionamiento del menú directo

Puede verificar el estado y la configuración de 
la videocámara que se muestra en la pantalla 
del visor, y seleccionar y cambiar directamente 
la configuración.
Estos son los elementos que pueden 
configurarse.
ˎˎ Face/Eye Detection AF
ˎˎ SteadyShot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ EI Gain Value
ˎˎ Auto Shutter
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1 Presione el dial multifunción o un botón 
asignable asignado con la función Direct 
Menu.
Solo los elementos en la pantalla que se 
pueden configurar con el menú directo se 
pueden seleccionar con el cursor naranja.

2 Gire el dial multifunción para mover el 
cursor hasta el elemento del menú que se 
desea ajustar y, a continuación, pulse el 
dial multifunción.
Se muestra un menú o el elemento sobre 
un fondo blanco.

3 Gire el dial multifunción para seleccionar 
un ajuste y, a continuación, pulse el dial 
multifunción.
El menú o el fondo blanco desaparece y 
se muestra el nuevo ajuste con un cursor 
naranja.
Pulse de nuevo el botón asignable al que 
se ha asignado Direct Menu de nuevo o 
espere 3 segundos sin realizar ninguna 
acción para cerrar el menú directo.

 [Consejos]
ˎˎ Los ajustes directos también se pueden 

configurar manteniendo presionado cada uno 
de los botones de función (página 5).
ˎˎ Cuando los elementos se muestran sobre un 

fondo blanco, el dial multifunción se puede usar 
como un dial asignable.
ˎˎ El selector múltiple (página 9) también se 

puede utilizar para operaciones de selección.

Botones/diales asignables

Existen nueve botones asignables (página 6, 
7, 9) en la videocámara a los que puede 
asignar diversas funciones.
También puede asignar funciones al dial 
multifunción de la videocámara (página 5), 
al dial asignable del asa (página 7) y 
al dial asignable del control remoto de la 
empuñadura (página 9).

Cambio de función de los botones

Utilice Assignable Button (página 79) en el 
menú Project del menú completo.
Puede visualizar las funciones asignadas 
en la pantalla Assignable Button Status 
(página 15).

Las funciones se asignan a cada botón 
asignable de manera predeterminada de 
fábrica
Botón 1 S&Q Motion
Botón 2 AF Speed/Sens.
Botón 3 Focus Setting
Botón 4 Focus Magnifier x3/x6
Botón 5 Direct Menu
Botón 6 Off
Botón 7 Focus Magnifier x3/x6
Botón 8 Direct Menu
Botón 9 Video Signal Monitor
Botón Focus Hold Focus Hold

Funciones asignables
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot

ˎˎ Rec
ˎˎ Rec Review
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Volume
ˎˎ Thumbnail
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

Cambio de función de los diales

Puede cambiar la función del dial multifunción 
de la videocámara, del dial asignable de la 
empuñadura y del dial asignable del asa.

Para el dial multifunción, ajuste usando Multi 
Function Dial (página 81) >Default Function 
en el menú Project.
Off se asigna de manera predeterminada de 
fábrica.
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Funciones asignables al dial multifunción
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

[Nota]
El ajuste se desactiva mientras se muestra el menú.

Para el dial asignable, ajuste usando 
Assignable Dial (página 81) en el menú 
Project del menú completo.
En la configuración predeterminada de fábrica, 
IRIS está asignado a todas las funciones.

[Consejo]
El dial asignable de la unidad RM-30BP (opcional) sigue 
la configuración Grip/Remote Dial.

Funciones asignables al dial asignable del asa
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level
ˎˎ Multi Function Dial

Funciones asignables al dial asignable de la 
empuñadura
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

Puede visualizar las funciones asignadas 
en la pantalla Assignable Button Status 
(página 15).

Slow & Quick Motion

Cuando el formato de grabación (página 77) se ajusta en los siguientes valores, puede 
especificar valores diferentes para la velocidad de fotogramas de filmación y la velocidad de 
fotogramas de reproducción.

Formato de grabación Velocidad de 
fotogramaFrecuencia del 

sistema
Modo de 
escaneado de la 
cámara

Codec Formato de vídeo

59.94/50/29.97/ 
25/23.98

FF RAW 3840×2160P 1–60

RAW & XAVC-I 3840×2160P 1–60

XAVC-I 4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

XAVC-L 3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

S35 XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF XAVC-I 4096×2160P 1–60

Puede activar/desactivar el modo Slow & 
Quick Motion presionando un botón asignable 
(página 48) asignado con la función S&Q 
Motion.
Puede establecer la velocidad de fotogramas 
para la filmación manteniendo presionado el 
botón.

[Notas]
ˎˎ La función Slow & Quick Motion no se puede ajustar 

durante la grabación, la reproducción ni durante la 
visualización de la pantalla de miniaturas.
ˎˎ La grabación de audio no es compatible con el modo 

Slow & Quick Motion.
ˎˎ La función de enfoque automático, diafragma 

automático y obturador automático se inhabilitan 
en el modo Slow & Quick Motion. Sin embargo, la 
función de enfoque automático se puede utilizar 
cuando la velocidad de fotogramas se establece en 
los siguientes valores:

Frecuencia del sistema Velocidad de fotograma

59.94/29.97/23.98 30, 60, 120, 240

50/25 25, 50, 100, 200

ˎˎ Para obtener más información sobre el uso de la 
salida RAW, consulte la página 34.

Grabación de vídeo de manera 
intermitente (Interval Rec)

La función Interval Rec del camcorder le 
permite capturar vídeos time-lapse en la 
memoria interna del camcorder. Esta función 
es una manera efectiva de filmar sujetos que 
se mueven lentamente.
Al iniciar la grabación, el camcorder graba 
automáticamente un número especificado 
de fotogramas (Number of Frames) en 
un intervalo de tiempo (Interval Time) 
especificado.

Intervalo de filmación (Interval Time)

Número de fotogramas en una toma
(Number of Frames)

Cuando Interval Rec está activado, la luz de 
vídeo del HVL-LBPC (opcional) se enciende 
automáticamente antes de que comience la 
grabación, lo que le permite grabar imágenes 
con una iluminación y unas condiciones de 
temperatura de color estables (función de 
preiluminación).

[Notas]
ˎˎ Solo se puede utilizar una función de grabación 

especial al mismo tiempo, como la grabación Interval 
Rec.
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ˎˎ Si se activa otro modo de grabación especial mientras 
se está utilizando Interval Rec, se desactivará 
automáticamente Interval Rec.
ˎˎ El modo Interval Rec se desactiva automáticamente 

después de cambiar los ajustes del sistema, como el 
formato de vídeo.
ˎˎ No se pueden cambiar los ajustes de Interval Rec 

durante la grabación o la reproducción, ni cuando se 
muestre la pantalla de imágenes en miniatura.

Para ajustar Interval Rec

Ajuste Interval Rec (página 78) >Setting en 
el menú Project del menú completo en On y 
ajuste Number of Frames e Interval Time.
Si utiliza la luz de vídeo del HVL-LBPC 
(opcional), ajuste el intervalo de tiempo 
para encender la luz de vídeo antes de que 
comience la grabación en Interval Rec >Pre-
Lighting en el menú Project, si es necesario.

[Notas]
ˎˎ Si desea encender la luz de vídeo antes de que 

comience la grabación, ajuste el interruptor de la luz 
de vídeo en AUTO. La luz de vídeo se enciende y se 
apaga automáticamente en función del ajuste de 
Video Light Set (página 94) en el menú Technical.
ˎˎ Si enciende la luz de vídeo, esta siempre estará 

iluminada (la luz de vídeo no se encenderá/apagará 
automáticamente).
ˎˎ Si la luz de vídeo está configurada para que se 

apague durante un período de 5 segundos o menos, 
la luz de vídeo no se apagará.

El camcorder sale del modo Interval Rec 
cuando se apaga, pero se mantienen los 
ajustes de Number of Frames, Interval Time 
y Pre-lighting. No es necesario volver a 
ajustarlos la próxima vez que filme en el modo 
Interval Rec.

Para filmar utilizando Interval Rec

Pulse el botón START/STOP de grabación para 
comenzar a grabar. “Int Rec” y “Int Stby” 
aparecen de manera alterna en el visor.
Si está utilizando la función de preiluminación, 
la luz de vídeo se enciende antes de que 
comience la grabación.

Para detener la filmación

Detenga la grabación.
Cuando la filmación finalice, los datos de 
vídeo almacenados en la memoria hasta ese 
punto se graban en el soporte.

Para salir del modo Interval Rec

Realice una de las siguientes acciones.
ˎˎ Ajuste el interruptor POWER en Off.
ˎˎ En el modo de espera de grabación, ajuste 
Interval Rec >Setting en el menú Project en 
Off.

Asimismo, el modo Interval Rec se desactivará 
automáticamente cuando se reinicie el 
camcorder.

Limitaciones durante la grabación

ˎˎ No se graba el audio.
ˎˎ No es posible revisar la grabación (Rec 
Review).

Si el camcorder se apaga durante la 
grabación

ˎˎ Si el interruptor POWER del camcorder 
está ajustado en la posición Off, se accede 
al soporte durante varios segundos 
para grabar las imágenes almacenadas 
en la memoria hasta ese momento y, a 
continuación, la alimentación se apaga 
automáticamente.
ˎˎ Si la unidad deja de recibir alimentación 
porque se ha extraído la batería, se ha 
desconectado el cable de alimentación 
de CC o se ha apagado la alimentación 
desde el adaptador de CA, es posible que 
se pierdan los datos de audio y de vídeo 
filmados hasta ese punto (10 segundos 
como máximo). Se debe tener cuidado al 
cambiar la batería.

Grabación en la tarjetas de 
memoria A y B simultáneamente 
(2-slot Simul Rec)

Puede grabar simultáneamente en las tarjetas 
de memoria A y B ajustando Simul Rec 
(página 14) en la pantalla de estado Project 
o Simul Rec >Setting (página 78) en el 
menú Project del menú completo en On.

Monitor de señal de vídeo

Puede establecer el tipo de señal de vídeo 
que desea visualizar en la pantalla del visor 
en forma de onda, vectorscopio o histograma 
mediante Display On/Off >Video Signal 
Monitor (página 88) en el menú Monitoring.
La línea naranja indica el valor establecido del 
nivel de cebra.

Monitorización de visualización del 
objetivo

En el modo Cine EI, la configuración 
del espacio de color (página 24) o la 
información de configuración del LUT de 
monitor (página 76) se muestra en la 
parte superior derecha del monitor de 
señal de vídeo para indicar el objetivo de la 
monitorización.

Marcas de clip

Puede añadir una marca de clip OK a un clip 
presionando el botón Clip Flag (página 5) 
y seleccionando Add OK.
Puede eliminar una marca de clip presionando 
el botón dos veces y seleccionando Delete Clip 
Flag.

[Consejos]
ˎˎ También puede utilizar un botón asignable asignado 

con la función de marcas de clip para añadir marcas 
de clip (página 48).
ˎˎ También pueda añadir una marca de clip usando Set 

Clip Flag (página 92) en el menú Thumbnail del 
menú completo (página 65).
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Grabación de proxy
Esta función le permite grabar 
simultáneamente datos proxy de baja 
resolución al mismo tiempo que graba vídeo 
con datos originales de alta resolución.

Para obtener información detallada sobre las tarjetas de 
memoria compatibles, formatear las tarjetas de memoria 
y verificar la capacidad restante, consulte “Uso de tarjetas 
de memoria” (página 26).

Configuración antes de la 
filmación

1 Ajuste Proxy Rec (página 14) en la 
pantalla de estado Project o Proxy Rec 
>Setting (página 78) en el menú Project 
del menú completo en On.

2 Introduzca una tarjeta de memoria en una 
ranura para tarjetas CFexpress Tipo A/SD 
(página 6).
ˎˎ En las tarjetas CFexpress, la etiqueta 
mira hacia la izquierda.
ˎˎ En las tarjetas SD, la etiqueta mira hacia 
la derecha con la esquina biselada en la 
parte inferior.

[Nota]
Proxy Rec no se puede establecer en On al mismo 
tiempo que S&Q Motion o Interval Rec. Cuando Proxy 
Rec se establece en On, estos otros modos de grabación 
se establecen de forma forzada en Off.

Grabación de un proxy

Presione el botón START/STOP de grabación 
para iniciar la grabación después de completar 
la configuración necesaria para el disparo.

[Notas]
ˎˎ Si la videocámara está apagado o si se extrae la 

tarjeta de memoria mientras se está accediendo 
a esta, no se podrá garantizar la integridad de 
los datos de la tarjeta. Es posible que se pierdan 
todos los datos grabados en la tarjeta de memoria. 
Asegúrese de que el indicador de acceso a la tarjeta 
de memoria esté siempre apagado antes de apagar 
la videocámara o extraer la tarjeta de memoria.
ˎˎ Asegúrese de que la tarjeta de memoria no se salga 

al introducirla o extraerla.

Para salir, detenga la grabación.

Ajuste del canal de audio para la 
grabación proxy

Seleccione Proxy Rec >Audio Channel 
(página 78) en el menú Project del menú 
completo y configure el canal de audio para la 
grabación de datos proxy.

Acerca del archivo grabado

La extensión del nombre del archivo es “.mp4”.
El código de tiempo también se graba 
simultáneamente.

Destino del almacenamiento del 
archivo grabado

El archivo grabado se almacenará en el 
siguiente directorio:

Soporte de 
grabación

Ruta de acceso a la 
carpeta

SDXC /PRIVATE/XDROOT/Sub

CFexpress Tipo A /XDROOT/Sub

Acerca del nombre del archivo

El nombre de archivo consiste en el nombre 
del clip grabado en la tarjeta de memoria y un 
sufijo “S03”.
Para obtener más información sobre los 
nombres de clips, consulte Clip Name Format 
(página 86) en el menú TC/Media del menú 
completo.
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Filmación con el aspecto deseado
Cuando la videocámara está en el modo 
Custom, puede añadir ajustes al negro, la 
matriz y otros parámetros para crear un 
“aspecto” basado en el aspecto básico.

：

Aspecto

Matriz

Negro

Aspecto básico

También puede seleccionar rápidamente otro 
aspecto guardando combinaciones diferentes 
de ajustes en archivos de escena.
La videocámara viene con un total de seis 
aspectos predeterminados.

Selección del aspecto

1 Mientras se muestra la pantalla de 
filmación, pulse el dial multifunción.

2 Seleccione el icono SCN.

3 Pulse el dial multifunción.

4 Seleccione el aspecto deseado en el 
menú y pulse el dial multifunción.

[Consejos]
ˎˎ Los siguientes preajustes vienen configurados de 

fábrica:

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Archivo de 
escena 1

S-Cinetone HLG Live

Archivo de 
escena 2

Standard HLG Natural

Archivo de 
escena 3

Still (Sin 
registrar)

Archivo de 
escena 4

ITU709 (Sin 
registrar)

Archivos de 
escena  
5 a 16

(Sin registrar) (Sin 
registrar)

ˎˎ También puede seleccionar un aspecto con Scene File 
(página 13) en la pantalla Main Status o con Scene 
File >Recall (página 83) en el menú Paint/Look del 
menú completo. También puede cargar un preajuste 
con Scene File >Preset Recall.

Importación del aspecto básico 
deseado

Puede importar un archivo 3D LUT, creado 
en un ordenador o en otro dispositivo, como 
aspecto básico. Se pueden importar hasta 16 
archivos.
ˎˎ Formato de archivo: archivo CUBE (*.cube) 
para una 3D LUT de 17 o 33 puntos creada 
con Catalyst Browse, RAW Viewer o DaVinci 
Resolve* (de Blackmagic Design Pty. Ltd.).
* Verificado con Resolve V9.0, V10.0, y V11.0.

ˎˎ Espacio de color/Gamma de entrada: 
S-Gamut3.Cine/S-Log3 o S-Gamut3/S-Log3

1 En el ordenador u otro dispositivo, guarde 
el archivo 3D LUT en la carpeta o el 
soporte de grabación especificado.

Soporte de 
grabación

Ruta de acceso a la 
carpeta

SDXC /PRIVATE/SONY/PRO/LUT/

CFexpress 
Tipo A

/SONY/PRO/LUT/

2 Introduzca el soporte de grabación en el 
que están grabados los archivos 3D LUT 
en una ranura para tarjetas CFexpress Tipo 
A/SD (B).

3 Seleccione Base Look >Import 
(página 83) en el menú Paint/Look del 
menú completo.

4 Seleccione el destino de la importación.

5 Seleccione un archivo 3D LUT para 
importar.
Siga las instrucciones que aparecen en 
pantalla. La videocámara procesa un 
archivo 3D LUT como un aspecto básico.

6 Seleccione el archivo 3D LUT importado 
con Base Look >Select (página 83) en el 
menú Paint/Look del menú completo.

7 Configure Base Look >Input y Output 
(página 83) en el menú Paint/Look del 
menú completo para que coincida con los 
atributos del archivo 3D LUT importado.

Ajuste de subexposición

Si existe tendencia a la subexposición 
cuando se selecciona la exposición 
automática durante el uso del aspecto básico 
importado, ajuste Base Look >AE Level Offset 
(página 83) en el menú Paint/Look.

[Notas]
ˎˎ La imagen no se ve afectada simplemente por 

importar un archivo 3D LUT. Cargue el archivo 3D LUT 
importado con Base Look >Select (página 83) en el 
menú Paint/Look del menú completo.
ˎˎ Si la opción Input no se configura correctamente, no 

se obtendrá el aspecto adecuado.
ˎˎ Los ajustes de los elementos de menú Input, Output 

y AE Level Offset se aplican al aspecto básico 
seleccionado mediante Select. Si se importan varios 
archivos 3D LUT, seleccione Select para cada archivo 
3D LUT y configure Input, Output y AE Level Offset de 
forma individual para cada archivo.
ˎˎ La configuración de Input, Output y AE Level Offset se 

guarda para cada archivo 3D LUT.
ˎˎ Las opciones de selección de Base Look/LUT para 

los archivos 3D LUT importados son las mismas en 
los modos SDR(BT.709)/HDR(HLG)/Cine EI, pero 
el espacio de color y la conversión gamma no se 
realizan de acuerdo con estos modos.
ˎˎ Los archivos 3D LUT no se eliminan cuando se 

selecciona All Reset >Reset en el menú Maintenance.
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Personalización del aspecto

Puede personalizar el aspecto en función del 
aspecto básico mediante la opción Matrix y 
otros elementos de configuración en el menú 
Paint/Look del menú completo. Para obtener 
más información sobre cada elemento de 
configuración, consulte página 83.
Conecte la videocámara a una televisión o a 
un monitor y ajuste la calidad de la imagen 
mientras observa la pantalla de la televisión o 
del monitor.

[Nota]
Al importar un archivo 3D LUT y aplicarlo a la imagen, 
no se obtendrá el aspecto deseado definido en el 
archivo 3D LUT si se cambia la opción Matrix y otros 
ajustes que no sean los ajustes de aspecto básico del 
menú Paint/Look. Puede restablecer todos los ajustes 
personalizados con Reset Paint Settings >Reset without 
Base Look (página 83) en el menú Paint/Look del 
menú completo.

Guardar un aspecto

Puede guardar el aspecto actual como archivo 
de escena en la memoria interna con Scene 
File >Store (página 83) en el menú Paint/
Look del menú completo.
Para guardarlo rápidamente, utilice las 
operaciones del menú directo en la pantalla 
de filmación.

[Nota]
Si selecciona otro aspecto sin guardar el aspecto actual, 
se descartará el aspecto actual.

[Consejo]
Puede sobrescribir los archivos de escena 
predeterminados.
Para restaurar un archivo de escena predeterminado, 
cargue el aspecto que desee restaurar mediante Scene 
File >Preset Recall (página 83) en el menú Paint/Look 
del menú completo y, a continuación, guarde el archivo 
de escena mediante Scene File >Store.

Eliminación de un aspecto guardado

Puede eliminar un archivo de escena 
guardado en la memoria interna con Scene 
File >Delete (página 83) en el menú Paint/
Look del menú completo.

[Consejo]
Una vez eliminado, dejará de mostrarse en el menú 
directo.

Eliminación de un aspecto básico

Puede eliminar un archivo 3D LUT importado 
con Base Look >Delete (página 83) en el 
menú Paint/Look del menú completo.
Puede eliminar todos los archivos 3D LUT 
importados con Base Look >Delete All 
(página 83) en el menú Paint/Look del 
menú completo.

[Notas]
ˎˎ Antes de eliminarlo, compruebe que el aspecto 

básico no esté siendo utilizado en ningún archivo 
de escena. Si elimina un aspecto básico que está 
siendo utilizado, el aspecto de los archivos de escena 
correspondientes será incorrecto.
ˎˎ Los archivos 3D LUT importados no se eliminan 

cuando se selecciona All Reset >Reset (página 100) 
en el menú Maintenance del menú completo.
ˎˎ Los aspectos básicos eliminados ya no podrán 

utilizarse como LUT en el modo Cine EI (página 54).
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Filmación con ajuste del aspecto en posproducción
Si utiliza la videocámara en el modo Cine EI 
y graba gradaciones uniformes de las áreas 
oscuras a las luminosas, puede realizar 
ajustes finos, como restaurar localmente 
las gradaciones de las áreas oscuras y las 
luminosas, en la posproducción.
Sin embargo, cuando vea las imágenes 
grabadas en un monitor convencional, el 
contraste total será bajo y resultará difícil 
ajustar el enfoque y la exposición.
Puede aplicar una LUT al destino del monitor 
en la videocámara para facilitar diversos 
ajustes durante la filmación. También puede 
aplicar una LUT al vídeo de reproducción para 
verificar el resultado final.
Las LUT se aplican en los siguientes sistemas. 
Sin embargo, solo se puede aplicar una LUT.
ˎˎ Salida SDI y salida HDMI
ˎˎ Imágenes del visor y de proxy, transmisión
ˎˎ Vídeo grabado en soportes de grabación

Aplicar una LUT a la imagen del 
visor

1 Pulse el botón MENU para mostrar la 
pantalla Monitoring Status.

2 Seleccione la columna Gamut/Gamma en 
la fila VF.

3 Seleccione On u Off.

[Notas]
ˎˎ El ajuste LUT On/Off de VF también se aplica los 

archivos de proxy y al vídeo de transmisión.
ˎˎ La pantalla asistida de gamma está disponible 

cuando se utiliza la ampliación de enfoque.

[Consejos]
ˎˎ También puede realizar el ajuste con LUT On/Off >VF/

Proxy/Stream (página 76) en el menú Shooting del 
menú completo.
ˎˎ SDI/HDMI se puede ajustar de manera similar a VF.
ˎˎ Para el vídeo grabado en un soporte de grabación, 

puede realizar el ajuste con LUT On/Off >Internal 
Rec (página 76) en el menú Shooting del menú 
completo.

Cambio de una LUT

1 Pulse el botón MENU para mostrar la 
pantalla Monitoring Status.

2 Seleccione el campo Base Look/LUT.

3 Seleccione la LUT que desea aplicar en la 
lista de aspectos básicos.

[Consejos]
ˎˎ También puede importar y aplicar un archivo 3D LUT. 

Es posible seleccionar s709, 709(800%) o S-Log3 para 
el aspecto básico. Para obtener más información, 
consulte “Importación del aspecto básico deseado” 
(página 52) y “Eliminación de un aspecto básico” 
(página 53).
ˎˎ El aspecto básico también se puede ajustar con Base 

Look >Select (página 83) en el menú Paint/Look 
del menú completo.

Cambio de la distribución de las 
áreas oscuras e iluminadas en el 
vídeo grabado

Puede cambiar la distribución de las áreas 
oscuras e iluminadas, por ejemplo, si desea 
priorizar el tono de las áreas oscuras sobre las 
áreas iluminadas, cambiando Exposure Index 
a un valor distinto de la sensibilidad base.

1 Aplique una LUT a la imagen del visor 
(página 54).

2 Pulse el botón MENU para mostrar la 
pantalla Camera Status.

3 Configure los campos L/M/H de Exposure 
Index.
Los ajustes individuales se asignan a las 
posiciones L/M/H del interruptor ISO/
GAIN (página 5).

4 Seleccione el valor de Exposure Index que 
desea aplicar con el interruptor ISO/GAIN.

5 Ajuste la exposición de la imagen del 
visor según corresponda.

[Nota]
La pantalla asistida de gamma está disponible cuando 
se utiliza la ampliación de enfoque. El ajuste Exposure 
Index no se aplica a la pantalla asistida de gamma.

[Consejos]
ˎˎ La exposición también se puede ajustar con ISO/

Gain/EI >Exposure Index (página 72) en el menú 
Shooting del menú completo.
ˎˎ El segundo valor numérico del ajuste indica cuántos 

pasos de información sobre el brillo se asignan a las 
áreas luminosas (brillo superior a gris 18%). Las áreas 
con un brillo superior quedarán sobreexpuestas.  
Ejemplo: en “400EI/5.0E”, se asignan 5,0 pasos en la 
parte luminosa.
ˎˎ Esto también le puede servir de guía para comprobar 

el tono de las zonas oscuras y luminosas durante 

la filmación. Por ejemplo, si la posición M es la 
sensibilidad base, la posición L es 2 pasos menos y 
la posición H es 2 pasos más, puede comprobar la 
exposición con el interruptor ISO/GAIN. No olvide 
volver a la posición M después de comprobar la 
exposición.
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Puede grabar la señal de vídeo RAW emitida 
desde el conector SDI OUT de la videocámara 
en una grabadora externa compatible.

1 Conecte una grabadora RAW externa al 
conector SDI OUT de la videocámara.

2 Configure el modo de filmación con la 
pantalla de estado Project (página 14) 
o con Base Setting >Shooting Mode 
(página 77), en el menú Project del 
menú completo, en Cine EI.

3 Configure el modo de escaneado (solo FF) 
con Imager Scan en la pantalla de estado 
Project o con Rec Format >Imager Scan 
Mode (página 77) en el menú Project 
del menú completo.

4 En la pantalla de estado Project o en Rec 
Format >Codec (página 77), en el menú 
Project del menú completo, configure un 
códec que incluya RAW.
Si selecciona RAW & XAVC-I, se grabará 
simultáneamente vídeo RAW en la 
grabadora RAW externa y vídeo en las 
tarjetas de memoria de la videocámara.

5 Ajuste la resolución con la pantalla de 
estado Project o con Rec Format >RAW 
Output Format (página 77) en el menú 
Project del menú completo.

6 Compruebe que la grabadora externa esté 
encendida y, a continuación, pulse el 
botón START/STOP de grabación en la 
videocámara.

 [Nota]
Cuando se inicia la grabación en una grabadora 
externa, sin usar el botón START/STOP de 
grabación de la videocámara, es posible que los 
clips no se graben correctamente.

A continuación, se muestran los formatos de 
salida RAW compatibles.

Frecuencia 
del sistema

Codec Formato de 
salida RAW

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & XAVC-I 4096×2160

3840×2160

24 RAW 4096×2160

RAW & XAVC-I 4096×2160

Indicador de estado de grabación

Si Display On/Off (página 87) >RAW Output 
Control Status en el menú Monitoring del 
menú completo se ajusta en On, se mostrará 
el estado de la grabación RAW en la pantalla 
del visor mediante un icono.

[Nota]
La señal de control de grabación se emite desde el 
conector SDI OUT de la videocámara, pero no es posible 
obtener el estado de la grabadora externa. Por lo tanto, 
es posible que la videocámara indique que se está 
grabando vídeo RAW cuando en realidad la grabadora 
externa no está grabando. Compruebe el indicador 
en la grabadora externa para obtener el estado de 
funcionamiento correcto.

[Consejo]
También se muestra el valor de configuración de RAW 
Output Format.

Grabación Slow & Quick Motion

Si S&Q Motion >Setting en el menú Shooting 
se ajusta en On, se graba vídeo RAW en el 
modo Slow & Quick Motion.
Para obtener más información sobre las 
velocidades de fotogramas admitidas en la 
filmación, consulte la página 49.

Grabación de vídeo RAW
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Conexión a otros dispositivos a través de una LAN
La videocámara se puede conectar a 
smartphones, tablets y otros dispositivos a 
través de una conexión LAN.
El establecimiento de una conexión LAN 
entre un dispositivo y la videocámara le 
permite llevar a cabo lo siguiente mediante la 
aplicación “Content Browser Mobile”.
ˎˎ Funcionamiento remoto a través de una LAN 
Puede controlar la videocámara desde un 
smartphone, una tableta o un ordenador 
conectados a esta a través de una LAN.
ˎˎ Transferencia de archivos a través de una 
LAN 
Puede transferir un archivo de proxy (baja 
resolución) o un archivo original (alta 
resolución) que se haya grabado en una 
tarjeta de memoria en la videocámara al 
servidor a través de una LAN.
ˎˎ Seguimiento de vídeo mediante una LAN 
Podrá crear una transmisión (H.264) a partir 
de la cámara o el vídeo de reproducción 
de la videocámara y seguir la transmisión 
mediante la aplicación “Content Browser 
Mobile” desde un dispositivo a través de 
una LAN.

Aplicación “Content Browser Mobile”

Puede controlar la videocámara de manera 
remota en la pantalla del dispositivo mientras 
monitoriza el vídeo de la videocámara y 
configurar los ajustes de la videocámara 
mediante la aplicación “Content Browser 
Mobile”.

Para obtener más información acerca de la aplicación 
“Content Browser Mobile”, póngase en contacto con el 
servicio de asistencia técnica o de ventas de Sony.

Establecimiento del nombre de 
usuario y la contraseña

Establezca el nombre de usuario y la 
contraseña de la videocámara para usar la 
función de red.

1 Configure Access Authentication >User 
Name (página 96) en el menú Network 
del menú completo.

2 Configure Access Authentication 
>Password (página 96) en el menú 
Network del menú completo.

Conexión con Wireless LAN Access 
Point Mode

La videocámara funciona como un punto de 
acceso y se conecta a un dispositivo a través 
de una red LAN inalámbrica.

Smartphone/tablet

Conexión a un dispositivo compatible 
con NFC mediante un toque

Los dispositivos compatibles con NFC se 
pueden conectar (conexión con un toque) 
mediante NFC.

1 Abra [Settings] en el dispositivo, 
seleccione [More] y marque la casilla de 
NFC.

2 Encienda la videocámara.

3 Active la función NFC.
Mantenga pulsado (durante 3 segundos) 
un botón asignable al que le haya 
asignado NFC o seleccione Wireless LAN 
>NFC, en el menú Network, para activar el 
modo de conexión NFC.
La función NFC se encuentra disponible 
cuando aparece  en la pantalla.

4 Toque la videocámara con el dispositivo.
El dispositivo se conectará a la 
videocámara y se iniciará “Content 
Browser Mobile”.

 [Notas]
ˎˎ Desactive previamente el modo de suspensión y 

el bloqueo de pantalla.
ˎˎ Toque sin soltar el dispositivo hasta que se inicie 

la aplicación “Content Browser Mobile” (1 o 2 
segundos).
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Conexión con un dispositivo compatible 
con WPS

Los dispositivos compatibles con WPS pueden 
conectarse mediante WPS.

1 Seleccione Wireless LAN >Setting >Access 
Point Mode en el menú Network del menú 
completo.

2 Seleccione Wireless LAN >WPS >Execute 
en el menú Network del menú completo.

3 Abra los ajustes de Network o los ajustes 
de Wi-Fi en el dispositivo y active el Wi-Fi.

4 Seleccione el SSID de la videocámara en la 
lista de SSID de Wi-Fi Network en el 
dispositivo y, a continuación, seleccione el 
pulsador WPS en Option, en el dispositivo, 
para conectarlo.

 [Notas]
ˎˎ El método de funcionamiento varía en función 

del dispositivo.
ˎˎ Para obtener información acerca del SSID y 

la contraseña de la videocámara, consulte 
AP Mode Settings >Camera SSID & Password 
(página 96) en el menú Network del menú 
completo.

5 Conexión con la aplicación Content 
Browser Mobile.

Conexión mediante la introducción de 
un SSID y una contraseña en un 
dispositivo

Puede conectar la videocámara a un 
dispositivo mediante la introducción de un 
SSID y una contraseña en un dispositivo.

1 Seleccione Wireless LAN >Setting >Access 
Point Mode en el menú Network del menú 
completo.

2 Abra los ajustes de Network o los ajustes 
de Wi-Fi en el dispositivo y active el Wi-Fi.

3 Conecte el dispositivo a la videocámara 
seleccionando el SSID de la videocámara 
en la lista de SSID de Wi-Fi Network e 
introduciendo la contraseña.
Para obtener información acerca del SSID 
y la contraseña de la videocámara, 
consulte AP Mode Settings >Camera SSID 
& Password (página 96) en el menú 
Network.

 [Nota]
El método de funcionamiento varía en función del 
dispositivo.

4 Conexión con la aplicación Content 
Browser Mobile.

Conexión del modo de estación de 
LAN inalámbrica

La videocámara se conecta a un punto de 
acceso existente de la red LAN inalámbrica 
como cliente. La videocámara y el dispositivo 
se conectan a través del punto de acceso.
Los 10 puntos de acceso conectados más 
recientemente se mostrarán en el historial.
El historial de conexión se guarda en un 
archivo ALL, pero no se guardarán las 
contraseñas de acceso. Es obligatorio 
introducir la contraseña la próxima vez que se 
conecte después de cargar el archivo ALL.

Smartphone/
tablet

Punto de acceso

Ordenador

Conexión a un punto de acceso a través 
de WPS

Si el punto de acceso es compatible con la 
función WPS, puede conectarse al punto de 
acceso mediante ajustes sencillos.

1 Active el punto de acceso.

2 Encienda la videocámara.

3 Seleccione Wireless LAN >Setting >Station 
Mode en el menú Network del menú 
completo.

4 Seleccione ST Mode Settings >Camera 
Remote Control (página 96) >Enable en 
el menú Network del menú completo.

5 Seleccione Wireless LAN >WPS >Execute 
en el menú Network del menú completo.

6 Pulse el botón WPS del punto de acceso.
Para obtener más información acerca de 
cómo utilizar el botón WPS, consulte las 
instrucciones de funcionamiento del 
punto de acceso.
Cuando la conexión se realiza 
correctamente, el icono indicador del 
estado de red mostrará una fuera de 1 o 
superior en la pantalla del visor.

 [Nota]
En caso de que falle la conexión, vuelva a llevar a 
cabo los pasos a partir del 1.

7 Conecte el dispositivo al punto de acceso.
Para obtener más información acerca de 
la conexión, consulte las instrucciones de 
funcionamiento del dispositivo.

8 Conexión con la aplicación Content 
Browser Mobile.
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Conexión a un punto de acceso 
mediante la detección automática de 
red o manualmente

Puede configurar la conexión a un punto de 
acceso deseado desde el menú completo.
Puede configurar la conexión a un punto de 
acceso deseado a través de la función de 
detección automática de red.

Conexión mediante la función de detección 
automática de red

1 Siga los pasos de 1 a 3 en “Conexión a un 
punto de acceso a través de WPS” 
(página 57).

2 Seleccione ST Mode Settings >Scan 
Networks (página 97) >Execute en el 
menú Network del menú completo.
La videocámara comienza a detectar los 
destinos de conexión.
Los posibles destinos encontrados se 
muestran en una lista.

3 Seleccione un destino de entre las 
opciones de la lista.
Aparecerá la pantalla de detalles de la red 
(punto de acceso). La conexión 
seleccionada se muestra en SSID.

4 Seleccione Password y defina la 
contraseña en la pantalla de introducción 
de contraseña.
La selección de un SSID en el historial de 
conexiones configura automáticamente 
los ajustes, incluida la contraseña.
Establezca la contraseña para volver a la 
pantalla de detalles de red (punto de 
acceso).

5 Configure los siguientes ajustes de 
conexión.
ˎˎ DHCP 
Establezca el ajuste DHCP.  
Cuando establezca el ajuste en On, la 
dirección IP se asignará a la videocámara 
automáticamente.  
Para asignar la dirección IP a la 
videocámara manualmente, establezca 
el ajuste Off.
ˎˎ IP Address 
Introduzca la dirección IP de la unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Subnet Mask 
Introduzca la máscara de subred de la 
unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Gateway 
Introduzca la puerta de enlace del punto 
de acceso.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ DNS Auto 
Establece si adquirir DNS 
automáticamente.  
Cuando se establece en On, se adquiere 
automáticamente la dirección del 
servidor DNS. Este ajuste está disponible 
únicamente si DHCP está ajustado en 
On.
ˎˎ Primary DNS Server 
Introduzca el servidor DNS principal del 
punto de acceso.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.
ˎˎ Secondary DNS Server 
Introduzca el servidor DNS secundario 
del punto de acceso.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

6 Cuando haya terminado, seleccione 
Connect para conectarse al punto de 
acceso.

Conexión manual

1 Siga los pasos de 1 a 3 en “Conexión a un 
punto de acceso a través de WPS” 
(página 57).

2 Seleccione ST Mode Settings >Manual 
Register (página 97) >Execute en el 
menú Network del menú completo.
Aparecerá la pantalla de detalles de la red 
(punto de acceso) de forma momentánea.

3 Configure los siguientes ajustes de 
conexión.
ˎˎ SSID 
Introduzca el SSID del punto de acceso.
ˎˎ Security 
Seleccione el método de cifrado.
ˎˎ Password 
Introduzca la contraseña del punto de 
acceso.
ˎˎ DHCP 
Establezca el ajuste DHCP.  
Cuando establezca el ajuste en On, la 
dirección IP se asignará a la videocámara 
automáticamente.  
Para asignar la dirección IP a la 
videocámara manualmente, establezca 
el ajuste Off.
ˎˎ IP Address 
Introduzca la dirección IP de la unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Subnet Mask 
Introduzca la máscara de subred de la 
unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Gateway 
Introduzca la dirección de la puerta de 

enlace.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ DNS Auto 
Establece si adquirir DNS 
automáticamente.  
Cuando se establece en On, se adquiere 
automáticamente la dirección del 
servidor DNS. Este ajuste está disponible 
únicamente si DHCP está ajustado en 
On.
ˎˎ Primary DNS Server 
Indique la dirección del servidor DNS 
principal.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.
ˎˎ Secondary DNS Server 
Indique la dirección del servidor DNS 
secundario.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

4 Cuando haya terminado, seleccione 
Connect para conectarse al punto de 
acceso.
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Conexión a un dispositivo a través 
de un cable LAN

Puede conectarse a un dispositivo si conecta 
el conector LAN con cable de un adaptador 
LAN con cable (opcional) acoplado al conector 
USB-C (página 7) de la videocámara a un 
router Wi-Fi (opcional) con un cable LAN.

Smartphone/tablet

Router Wi-Fi

Conexiones de cable LAN y ajustes del 
LAN con cable

1 Conecte el conector LAN con cable del 
adaptador LAN con cable a un router Wi-Fi 
mediante un cable LAN.

2 Encienda la videocámara.

3 Ajuste Wired LAN >Setting (página 98) 
en el menú Network del menú completo 
en On.

4 Configure los ajustes de conexión usando 
Wired LAN >Detail Settings (página 98) 
en el menú Network.
ˎˎ DHCP 
Establezca el ajuste DHCP.  
Cuando establezca el ajuste en On, la 
dirección IP se asignará a la videocámara 
automáticamente.  
Para asignar la dirección IP a la 
videocámara manualmente, establezca 
el ajuste Off.
ˎˎ IP Address 
Introduzca la dirección IP de la unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Subnet Mask 
Introduzca la máscara de subred de la 
unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Gateway 
Introduzca la dirección de la puerta de 
enlace.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ DNS Auto 
Establece si adquirir DNS 
automáticamente.  
Cuando se establece en On, se adquiere 
automáticamente la dirección del 
servidor DNS. Este ajuste está disponible 
únicamente si DHCP está ajustado en 
On.
ˎˎ Primary DNS Server 
Indique la dirección del servidor DNS 
principal.  

Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.
ˎˎ Secondary DNS Server 
Indique la dirección del servidor DNS 
secundario.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

5 Cuando haya terminado, seleccione Set 
para aplicar los ajustes.

[Notas]
ˎˎ Seleccione siempre Set tras cambiar los ajustes 

de conexión. No se aplicarán los ajustes si no se 
selecciona Set.
ˎˎ Utilice un adaptador LAN con cable USB tipo C. Se 

recomienda utilizar de un adaptador compatible con 
Gigabit Ethernet. Sin embargo, no se garantiza el 
funcionamiento con todos los dispositivos.
ˎˎ La función de comunicación Wi-Fi integrada puede 

verse afectada dependiendo del modelo del 
adaptador LAN con cable (opcional).
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Puede conectar la videocámara a Internet 
mediante un anclaje USB, LAN con cable o LAN 
inalámbrica.

Conexión mediante anclaje USB

Puede conectar la unidad a un smartphone 
mediante un cable USB y, a continuación, 
conectarse a Internet a través del smartphone.

Configuración de la comunicación con el 
smartphone

Habilite la comunicación Tethering en el 
smartphone.
Para obtener más información, consulte el 
manual de instrucciones del smartphone.

Acople de un smartphone a la 
videocámara

Conecte un cable USB al conector USB-C 
(página 7) de la videocámara y, a 
continuación, conecte el smartphone.

[Notas]
ˎˎ Acople o retire el smartphone con la videocámara 

apagada.
ˎˎ El anclaje USB no se puede utilizar si el smartphone 

se conecta mediante un concentrador USB.
ˎˎ El anclaje USB no se puede utilizar si se conecta un 

ordenador al conector USB/múltiple (página 7).

Conexión a una red

1 Encienda la videocámara.

2 Ajuste Modem >Setting (página 98) en 
el menú Network del menú completo en 
On.

Habilitar el control desde un smartphone

Para controlar la videocámara de forma 
remota mediante la aplicación Content 
Browser Mobile en un smartphone, 
ajuste Modem >Camera Remote Control 
(página 96) en el menú Network del menú 
completo en Enable.

Conexión del modo de estación de 
LAN inalámbrica

Puede conectar la videocámara a Internet 
en el modo de estación Wi-Fi a través de un 
router Wi-Fi opcional o mediante el anclaje a 
la red a un dispositivo.

Smartphone/
tablet

Router Wi-Fi

Ordenador

Internet

Smartphone/
tablet

Internet

Conéctese al router o dispositivo Wi-Fi, tal 
como se describe en “Conexión del modo de 
estación de LAN inalámbrica” (página 57).

Conexión con un cable LAN

Puede conectarse a Internet si conecta el 
conector LAN con cable de un adaptador LAN 
con cable (opcional) acoplado al conector 
USB-C (página 7) del camcorder a un 
router Wi-Fi (opcional) con un cable LAN.

Smartphone/
tablet

Ordenador

Router Wi-Fi

Internet

Conéctese al router Wi-Fi, tal como se describe 
en “Conexión a un dispositivo a través de un 
cable LAN” (página 59).

[Notas]
ˎˎ No se puede utilizar un adaptador LAN con cable 

(opcional) USB si se conecta un ordenador al conector 
USB/múltiple (página 7).
ˎˎ La función de comunicación Wi-Fi integrada puede 

verse afectada dependiendo del modelo del 
adaptador LAN con cable (opcional).

Conexión a Internet
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Carga de archivos
Puede cargar un archivo de proxy o un 
archivo original que se haya grabado en la 
videocámara en un servidor de Internet o 
en un servidor de una red local a través un 
smartphone o un punto de acceso.

Preparación

Conexión a una red

Conecte la videocámara a Internet o a la 
red local siguiendo el procedimiento que se 
detalla en “Conexión a Internet” (página 60) 
o “Conexión a otros dispositivos a través de 
una LAN” (página 56).

Registro de un destino de transferencia 
de archivo

Registre el servidor para la carga de 
antemano.

1 Seleccione File Transfer >Server Settings1 
(o Server Settings2, Server Settings3) en el 
menú Network del menú completo.
Aparecerá la pantalla de configuración de 
destino de la transferencia.

2 Configure cada elemento de la pantalla 
de configuración de destino de la 
transferencia.
Display Name
Introduzca el nombre del servidor que 
desea visualizar en la lista de destino de 
la transferencia.
Service
Muestra el tipo de servidor.
“FTP”: servidor FTP
Host Name
Introduzca la dirección del servidor.

Port
Introduzca el número de puerto del 
servidor para conectarse.
User Name
Introduzca el nombre del usuario.
Password
Introduzca la contraseña.
Passive Mode
Active y desactive el modo pasivo.
Destination Directory
Introduzca el nombre del directorio en el 
servidor de destino.

 [Notas]
ˎˎ Al editar, “” indica los caracteres que no 

podrán cambiarse. No se garantiza el correcto 
funcionamiento al editar un nombre de directorio 
que contenga estos caracteres.  
Si necesita realizar la edición, elimine todos los 
caracteres y vuelva a introducir un valor.
ˎˎ Si se introducen caracteres en Destination 

Directory no válidos en el servidor de destino, 
los archivos se transferirán al directorio de inicio 
del usuario. Los caracteres no válidos variarán 
dependiendo del servidor.

Using Secure Protocol
Ajuste si desea llevar a cabo la carga a 
través de FTP segura.
Root Certificate
Cargue/borre un certificado.
ˎˎ Load 
Seleccione Set en el paso 3 para 
importar un certificado de CA.

* El certificado que se cargue debe estar en 
formato PEM con el nombre de archivo 
“certification.pem” , y debe grabarse en el 
directorio raíz de la tarjeta de memoria insertada 
en la ranura de la tarjeta CFexpress Tipo A/SD (B).

ˎˎ Clear 
Seleccione Set en el paso 3 para borrar 
un certificado de CA.
ˎˎ None 
No cargue ni borre ningún certificado.

 [Notas]
ˎˎ Ajuste el reloj de la videocámara a la hora 

correcta antes de importar un certificado CA.
ˎˎ Al grabar en XAVC-I 4096×2160P/ 

3840×2160P 59.94/50P, no se puede seleccionar 
Load.

ˎˎ En el estado de baja tensión, Load/Clear no 
podrán seleccionarse para un certificado de CA.

Root Certificate Status
Muestra el estado de carga del certificado.
Reset
Restablezca los ajustes predeterminados 
de Server Settings.

3 Cuando haya terminado, seleccione Set 
para aplicar los ajustes.
Seleccione siempre Set tras cambiar los 
ajustes. No se aplicarán los ajustes si no 
se selecciona Set.

Selección de un archivo y carga

Puede seleccionar archivos de proxy o 
archivos originales grabados en tarjetas de 
memoria para transferirlos a un servidor.

Carga de un archivo de proxy en una 
tarjeta de memoria desde la pantalla de 
imágenes en miniatura

1 Conecte la videocámara y el dispositivo 
mediante una conexión de LAN 
(página 56).

2 Seleccione Transfer Clip (Proxy) >Select 
Clip en el menú Thumbnail del menú 
completo.
La pantalla cambia del menú completo a 
la pantalla de imágenes en miniatura.
Los clips se pueden transferir desde la 
pantalla de imágenes en miniatura o la 
pantalla de imágenes en miniatura de 
clips filtrados.

3 Seleccione el clip que desea transferir y, a 
continuación, pulse el botón MENU.
Aparece una pantalla de confirmación de 
transferencia.

4 Seleccione Execute.
El archivo proxy correspondiente al 
archivo seleccionado se registra como 
trabajo de transferencia y comienza la 
carga.
Cuando el trabajo de transferencia se 
registra correctamente, aparece la 
pantalla de resultados de la transferencia.

5 Seleccione OK.
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Para cargar todos los archivos
Seleccione All Clips en lugar de Select Clip en 
el paso 2 para transferir los archivos de proxy 
correspondientes a todos los archivos.

[Nota]
Se pueden transferir hasta 200 archivos.

Carga de un archivo original en una 
tarjeta de memoria desde la pantalla de 
imágenes en miniatura

1 Conecte la videocámara y el dispositivo 
mediante una conexión de LAN 
(página 56).

2 Seleccione Transfer Clip >Select Clip en el 
menú Thumbnail del menú completo.
La pantalla cambia del menú completo a 
la pantalla de imágenes en miniatura.
Los clips se pueden transferir desde la 
pantalla de imágenes en miniatura o la 
pantalla de imágenes en miniatura de 
clips filtrados.

3 Seleccione el clip que desea transferir y, a 
continuación, pulse el botón MENU.
Aparece una pantalla de confirmación de 
transferencia.

4 Seleccione Execute.
El archivo seleccionado se registra como 
trabajo de transferencia y comienza la 
carga.
Cuando el trabajo de transferencia se 
registra correctamente, aparece la 
pantalla de resultados de la transferencia.

5 Seleccione OK.

Para cargar todos los archivos
Seleccione All Clips en lugar de Select Clip en 
el paso 2 para transferir todos los archivos.

[Nota]
Se pueden transferir hasta 200 archivos.

Comprobación de la transferencia de 
archivos

Puede verificar el estado de la transferencia 
de archivos seleccionando File Transfer >View 
Job List (página 98) en el menú Network del 
menú completo.
También puede verificar el estado de la 
transferencia de archivos desde la pantalla de 
la aplicación Content Browser Mobile.

[Consejo]
Si se ajusta File Transfer >Auto Upload (Proxy) 
(página 98), en el menú Network del menú 
completo, en On y existe una conexión de red, los 
archivos de proxy se cargarán automáticamente en el 
servidor especificado mediante Default Upload Server 
(página 98) cuando acabe la grabación.

[Notas]
ˎˎ Se pueden registrar hasta 200 trabajos de 

transferencia.
ˎˎ La lista de trabajos se conserva cuando la 

videocámara se apaga, pero es posible que se 
pierdan hasta 10 minutos de la información de 
progreso reciente si se extrae la batería o se apaga la 
videocámara sin ajustar primero el interruptor POWER 
en STANDBY.
ˎˎ Los trabajos añadidos después del estado de baja 

tensión de la batería no se guardan en la lista de 
trabajos.
ˎˎ Si se produce un error durante la transferencia de 

archivos, no se reanudará la transferencia de un 
clip con el mismo nombre que un clip transferido 
dependiendo de la configuración y el estado del 
servidor de destino de la transferencia. En este caso, 
compruebe la configuración y el estado del servidor 
de destino de la transferencia.

Carga a través de FTP segura

Puede cargar archivos cifrados mediante FTPS 
en el modo Explicit (FTPES) para conectarse 
con el servidor de archivos de destino.

Configuración de la transferencia de FTP 
segura

Para una transferencia de FTP segura, ajuste 
Using Secure Protocol, en el servidor de 
archivos de destino, en ON e importe un 
certificado.
Para obtener más detalles acerca de 
la configuración, consulte “Registro de 
un destino de transferencia de archivo” 
(página 61).
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Pantalla de imágenes en miniatura
Cuando pulsa el botón THUMBNAIL (página 5), los clips grabados en la tarjeta de memoria se muestran como miniaturas en la pantalla.
Puede seleccionar un clip en la pantalla de imágenes en miniatura e iniciar la reproducción de dicho clip. La imagen de reproducción se puede mostrar en el visor y en un monitor externo.
Si pulsa el botón THUMBNAIL de nuevo, se cierra la pantalla de imágenes en miniatura y vuelve a la imagen de la cámara.

[Nota]
Solo los clips grabados con el formato de grabación seleccionado actualmente se mostrarán en la pantalla de imágenes en miniatura. Si un clip grabado esperado no se muestra, compruebe el formato de grabación. Tenga en cuenta esto 
antes de formatear (inicializar) soportes.

Diseño de la pantalla

La información para el clip sobre el que se encuentra el cursor se muestra en la parte inferior de la pantalla.

4 5

6

3

1

2

Indicador de la tarjeta de memoria seleccionada actualmente
(se muestra un icono de bloqueo si la tarjeta está protegida).

Cursor (amarillo)

Número del clip/Número total de clips

1. Miniaturas (imágenes índice)
Muestra la imagen índice de un clip. Cuando 
se graba un clip, su primer fotograma se ajusta 
automáticamente como imagen índice.
La información del clip/fotograma se 
muestra debajo de la imagen en miniatura. 
Puede cambiar la información mostrada en 
Customize View (página 92) >Thumbnail 

Caption en el menú Thumbnail del menú 
completo.

2. Nombre del clip
Muestra el nombre del clip seleccionado.

3. Formato de grabación del vídeo
Muestra el formato de archivo del clip 
seleccionado.

4. Información del modo de grabación 
especial

Muestra el modo de grabación solo si el clip se 
grabó con un modo especial de grabación.
En clips con Slow & Quick Motion, la velocidad 
de fotogramas se muestra a la derecha.

5. Duración del clip

6. Fecha de creación



5. Pantalla de imágenes en miniatura64

Reproducción de clips

Reproducción de clips grabados

Puede reproducir clips grabados cuando la 
videocámara esté en modo de espera (Stby).

1 Inserte la tarjeta de memoria que desea 
reproducir.

2 Pulse el botón THUMBNAIL.

3 Use el selector múltiple (página 7) o el 
dial multifunción (página 5) para 
mover el cursor a la miniatura del clip que 
desea reproducir.

4 Pulse el botón de aplicar del selector 
múltiple o el dial multifunción.
La reproducción comienza desde el 
principio del clip seleccionado.

Puede controlar la reproducción con los 
siguientes botones.
Pulse el botón de aplicar del selector múltiple 

o el dial multifunción: 
Detiene la reproducción.  
Pulse de nuevo para volver a la 
reproducción normal.

Pulse los botones izquierda/derecha del 
selector múltiple: 
Pasa al inicio del clip/inicio del siguiente 
clip.

Mantenga pulsados los botones izquierda/
derecha del selector múltiple: 
Rebobinado/avance rápido.  
Vuelve a la reproducción normal cuando 
suelta el botón.

Botón CANCEL/BACK: 
Detiene la reproducción y vuelve al modo 
de espera de grabación.

[Notas]
ˎˎ Pueden existir roturas momentáneas de imagen o 

visualizarse imágenes fijas en el cambio de un clip 
a otro. Durante este periodo no podrá utilizar la 
videocámara.
ˎˎ Cuando selecciona un clip en la pantalla de imágenes 

en miniatura y comienza la reproducción, pueden 
existir roturas momentáneas de imagen al principio 
del clip. Para ver el inicio del clip sin roturas, ponga 
la videocámara en modo de reproducción, páusela, 
utilice el botón izquierdo del selector múltiple 
para volver al inicio del clip e inicio de nuevo la 
reproducción.
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En la pantalla de imágenes en miniatura, 
puede utilizar los clips o comprobar sus 
propiedades a través del menú Thumbnail del 
menú completo.
El menú Thumbnail (página 92) aparece 
cuando mantiene pulsado el botón MENU y 
selecciona Thumbnail.

Operaciones con el menú 
Thumbnail

Use el selector múltiple (página 7) o el dial 
multifunción (página 5) para seleccionar 
una función y, a continuación, presione el 
botón de aplicar del selector múltiple o el dial 
multifunción.
Pulse el botón de CANCEL/BACK (página 5) 
para volver a la pantalla anterior.

[Nota]
Algunos elementos no pueden seleccionarse, 
dependiendo del estado, cuando se visualiza el menú.

Elementos de menú para 
operaciones de clip

ˎˎ Display Clip Properties
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Filter Clips
ˎˎ Customize View

Para obtener más información sobre los 
elementos de menús de operaciones con clips, 
consulte el menú Thumbnail (página 92).

Visualización de propiedades de clips

Seleccione Display Clip Properties 
(página 92) en el menú Thumbnail para 
mostrar la pantalla de propiedades de los 
clips.

Añadir marcas de clip

Puede añadir marcas de clip (marcas OK, NG o 
KP) en los clips para filtrar la visualización de 
estos según las marcas de clip.
Seleccione la imagen en miniatura del clip 
al que desea añadir una marca de clip y, a 
continuación seleccione la marca de clip 
mediante Set Clip Flag (página 92) en el 
menú Thumbnail del menú completo.

Ajuste Marca de clip añadida

Add OK OK

Add NG NG

Add KEEP KP

[Consejos]
ˎˎ También puede utilizar un botón asignable asignado 

con la función de marcas de clip para añadir marcas 
de clip (página 48).

ˎˎ Puede añadir una marca de clip OK a la imagen 
en miniatura del clip seleccionado (página 50) 
presionando el botón Clip Flag (página 5).

Visualización de la pantalla de 
imágenes en miniatura de clips filtrados

Seleccione Filter Clips (página 92) en 
el menú Thumbnail del menú completo y 
seleccione un tipo de marca de clip para 
mostrar solo aquellos clips que tengan la 
marca especificada.
Para mostrar todos los clips, seleccione All.

[Consejo]
También puede cambiar los filtros en secuencia usando 
el botón DISPLAY.

Eliminación de clips

Puede eliminar clips de tarjetas de memoria.
Seleccione Delete Clip >Select Clip u All Clips 
en el menú Thumbnail del menú completo.
Select Clip: 

Elimina el clip seleccionado. Compatible 
con la selección de varios clips.

All Clips: 
Elimina todos los clips mostrados.

Cambio de la información mostrada en 
la pantalla de imágenes en miniatura

Puede cambiar la información de fotogramas/
clips que se muestra debajo de la imagen en 
miniatura.
Seleccione Customize View >Thumbnail 
Caption en el menú Thumbnail del menú 
completo y seleccione la información que 
desea mostrar.
Date Time: 

Muestra la fecha y la hora de creación del 
clip y de su última modificación.

Time Code: 
Muestra el código de tiempo.

Duration: 
Muestra la duración del clip.

Sequential Number: 
Muestra el número secuencial de cada 
imagen en miniatura.

Operaciones con clips
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Configuración y jerarquía del menú completo
Mantenga pulsado el botón MENU para 
mostrar el menú completo en el visor con el 
fin de especificar los distintos elementos para 
filmar, grabar y reproducir (el menú también 
se puede visualizar en un monitor externo). El 
menú completo incluye los siguientes menús.

Configuración del menú

Menú User
Contiene elementos del menú 
configurados por el usuario mediante Edit 
User Menu.

Menú Edit User
Contiene elementos del menú para editar 
el menú User.

Menú Shooting
Contiene ajustes relacionados con la 
filmación.

Menú Project
Contiene ajustes básicos del proyecto.

Menú Paint/Look
Contiene ajustes relacionados con la 
calidad de la imagen.

Menú TC/Media
Contiene ajustes relacionados con 
códigos de tiempo y soportes de 
grabación.

Menú Monitoring
Contiene ajustes relacionados con la 
salida de vídeo y la pantalla del visor.

Menú Audio
Contiene ajustes relacionados con el 
audio.

Menú Thumbnail
Contiene ajustes relacionados con la 
pantalla de imágenes en miniatura.

Menú Technical
Contiene ajustes para elementos técnicos.

Menú Network
Contiene ajustes relacionados con las 
redes.

Menú Maintenance
Contiene ajustes de dispositivos, como el 
reloj y el idioma.

Jerarquía del menú completo

User 
(Ajustes de 
fábrica)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

VF Setting

Zebra

Zoom

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project Base Setting

Rec Format

Cine EI Setting

Simul Rec

Proxy Rec

Interval Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output

Thumbnail Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical Color Bars

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm

Network Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

File Transfer

Network Reset
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Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Operaciones del menú completo
Mantenga pulsado el botón MENU para 
mostrar el menú completo en el visor con 
el fin de especificar los ajustes detallados 
(el menú también se puede visualizar en un 
monitor externo).

Controles del menú

Botón MENU (página 5)
Manténgalo pulsado para mostrar el 
menú completo. Púlselo de nuevo 
mientras se muestra el menú completo 
para ocultar el menú.

Selector múltiple (pad D de 8 formas y botón 
de aplicar) (página 7)

Pulse los botones del pad D para mover el 
cursor hacia arriba, hacia abajo, hacia la 
izquierda o hacia la derecha y seleccionar 
elementos o ajustes del menú.
Pulse el botón de aplicar del selector 
múltiple para aplicar el elemento 
seleccionado.

Dial multifunción (página 5)
Gire el dial multifunción para mover el 
cursor hacia arriba y hacia abajo para 
seleccionar elementos o ajustes del menú.
Pulse el dial multifunción para aplicar el 
elemento seleccionado.

Botón CANCEL/BACK (página 5)
Púlselo para volver al menú anterior. Los 
cambios sin finalizar se cancelan.

[Notas]
ˎˎ El menú completo no se puede utilizar cuando el 

modo de ampliación de enfoque está activado 
(página 40).
ˎˎ Algunos elementos no pueden seleccionarse, 

dependiendo del estado, cuando se visualiza el 
menú.

Elementos del menú de 
configuración

Presione los botones del pad D o gire el 
dial multifunción para mover el cursor al 
elemento del menú que desea configurar y, a 
continuación, presione el botón de aplicar o el 
dial multifunción para seleccionar el elemento.
ˎˎ El área de selección de elementos del menú 
muestra hasta ocho líneas. Si las opciones 
disponibles para un elemento no se pueden 
mostrar al mismo tiempo, desplácese por 
la pantalla moviendo el cursor hacia arriba/
abajo.
ˎˎ En el caso de los subelementos con una 
amplia gama de opciones (por ejemplo, 
de –99 a +99), el área de configuración no 
se visualiza. El ajuste actual se resalta para 
indicar que el valor se puede cambiar.
ˎˎ Si selecciona [Execute] para una función, la 
función correspondiente se ejecutará.
ˎˎ Si selecciona un elemento que requiere 
confirmación antes de su ejecución, el menú 
se ocultará temporalmente y se mostrará 
un mensaje de confirmación. Compruebe 
el mensaje y a continuación selecciones si 
desea ejecutar o cancelar la función.

Introducción de una cadena de 
caracteres

Cuando selecciona un elemento, como por 
ejemplo un nombre de archivo, que requiere 
la introducción de caracteres, aparecerá la 
pantalla para introducir caracteres.

1

2 3

1 Presione los botones del pad D o gire el 
dial multifunción para seleccionar un tipo 
de carácter y, a continuación, aplique la 
configuración.
ABC: caracteres alfabéticos en mayúsculas
abc: caracteres alfabéticos en minúsculas
123: caracteres numéricos
!#$: caracteres especiales

2 Seleccione un carácter del tipo de carácter 
seleccionado y, a continuación, aplique el 
ajuste.
El cursor pasa al campo siguiente.

Space: introduce un carácter de espacio en 
la posición del cursor.

/: mueve la posición del cursor.
BS: elimina el carácter a la izquierda del 

cursos (retroceso).

3 Cuando acabe, seleccione [Done] y 
aplique el ajuste.

La cadena de caracteres se confirma y la 
pantalla de introducción de caracteres 
desaparece.

Bloqueo y desbloqueo del menú

Puede bloquear el menú completo para que 
solo se muestre el menú User.
En este estado, los ajustes no se pueden 
cambiar con las pantallas de estado.

Bloqueo del menú

1 Mantenga pulsado el dial multifunción y 
mantenga pulsado el botón MENU.

2 Seleccione Menu Settings >User Menu 
with Lock en el menú Technical.

 [Nota]
Si solo mantiene pulsado el botón MENU para 
mostrar el menú completo normal, User Menu Only 
se muestra en Menu Settings, en el menú Technical. 
Mantenga pulsado el dial multifunción y mantenga 
pulsado el botón MENU para mostrar User Menu 
with Lock.

3 Ajústelo en On y pulse el botón de aplicar 
o el dial multifunción.
La visualización de la pantalla del visor 
cambia a la pantalla de introducción del 
número del código de acceso.

4 Introduzca un número arbitrario.
Introduzca un número de 4 dígitos que se 
encuentre entre 0000 y 9999. El valor 
predeterminado es 0000.
Introduzca un número y pulse el botón de 
aplicar o el dial multifunción para mover 
el curso hasta el siguiente dígito.
Cuando haya introducido todos los 
dígitos, mueva el cursor hasta SET.
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5 Pulse el botón de aplicar o el dial 
multifunción.
Se aplica el número introducido.
Aparece un mensaje de confirmación y la 
pantalla cambia a la pantalla del menú 
User.

Desbloqueo del menú

1 Mantenga pulsado el dial multifunción y 
mantenga pulsado el botón MENU.

2 Seleccione Menu Settings >User Menu 
with Lock en el menú User.

 [Nota]
Si solo mantiene pulsado el botón MENU para 
mostrar el menú completo normal, User Menu 
Only se muestra en Menu Settings, en el menú 
Technical. Mantenga pulsado el dial multifunción 
y mantenga pulsado el botón MENU para mostrar 
User Menu with Lock.

3 Ajústelo en Off y pulse el botón de aplicar 
o el dial multifunción.
La visualización de la pantalla del visor 
cambia a la pantalla de introducción del 
número del código de acceso.

4 Introduzca el número del código de 
acceso que se utilizó para bloquear el 
menú.
Introduzca un número y pulse el botón de 
aplicar o el dial multifunción para mover 
el curso hasta el siguiente dígito.
Cuando haya introducido todos los 
dígitos, mueva el cursor hasta Set.

5 Pulse el botón de aplicar o el dial 
multifunción.
Se aplica el número introducido.
Si el número del código de acceso 
introducido coincide con el número del 
código de acceso que se utilizó para 

bloquear el menú, el menú se desbloquea 
y se muestra.

[Notas]
ˎˎ Si el número del código de acceso introducido no 

coincide con el número del código de acceso que 
se utilizó para bloquear el menú, el menú no se 
desbloquea.
ˎˎ Se recomienda que anote el número del código de 

acceso en un lugar cercano por si lo olvida. Si se 
olvida del número del código de acceso, póngase en 
contacto con el servicio de asistencia técnica de Sony.
ˎˎ Si el menú está bloqueado y no se han registrado 

elementos del menú completo de la siguiente tabla 
en el menú User, esas funciones no se pueden 
asignar a los botones asignables.
ˎˎ Si esas funciones ya estaban asignadas a botones 

asignables, cuando se bloquea el menú se fuerza la 
desactivación del ajuste asignable.

Elemento del menú 
completo

Selección de 
botones 
asignables

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

— Auto ND Filter

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Elemento del menú 
completo

Selección de 
botones 
asignables

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Elemento del menú 
completo

Selección de 
botones 
asignables

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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Menú User
Esta sección describe la función y los ajustes de los elementos en cada menú.

User

Elemento Descripción

Base Setting Elemento de Project >Base Setting

Focus Elemento de Shooting >Focus

S&Q Motion Elemento de Shooting >S&Q Motion

LUT On/Off Elemento de Shooting >LUT On/Off

Simul Rec Elemento de Project >Simul Rec

Proxy Rec Elemento de Project >Proxy Rec

Interval Rec Elemento de Project >Interval Rec

Assignable Button Elemento de Project >Assignable Button

Assignable Dial Elemento de Project >Assignable Dial

Multi Function Dial Elemento de Project >Multi Function Dial

All File Elemento de Project >All File

Clip Name Format Elemento de TC/Media >Clip Name Format

Format Media Elemento de TC/Media >Format Media

VF Setting Elemento de Monitoring >VF Setting

Zebra Elemento de Monitoring >Zebra

Zoom Elemento de Technical >Zoom

Menu Settings Elemento de Technical >Menu Settings

Edit User Menu Muestra la pantalla del menú Edit User.

[Nota]
Puede agregar y eliminar elementos de menú en el menú User utilizando el menú Edit User. Se pueden configurar 
hasta 20 elementos.



6. Pantalla de menús y ajustes71

Menú Edit User
El menú Edit User se muestra en el nivel superior cuando se selecciona Edit User Menu en el 
menú User.

Edit User

Elemento Ajuste de subelementos Descripción

Add Item
Adición de un elemento 
al menú User

Agrega un elemento del menú al 
menú User.

Customize Reset
Restablecimiento de los 
elementos en el menú 
User

Restaura los elementos del menú 
registrados en el menú User de 
manera predeterminada de fábrica.

Elemento de menú 
seleccionado durante la 
edición

Delete Elimina el elemento de menú 
registrado del menú User.

Move Reordena los elementos de menú 
registrados dentro del menú User.

Edit Sub Item Edita (registra/elimina) los 
subelementos de menú registrados 
en el menú User.
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Menú Shooting
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento Ajuste de subelementos Descripción

Mode ISO/dB Selecciona el modo de ajuste de ganancia.

ISO/Gain<H> Para obtener más detalles acerca de los 
ajustes, consulte “Ajustes y valores 
predeterminados de Iso/Gain” 
(página 101).

Ajusta el valor predeterminado de 
ganancia <H>.

ISO/Gain<M> Para obtener más detalles acerca de los 
ajustes, consulte “Ajustes y valores 
predeterminados de Iso/Gain” 
(página 101).

Ajusta el valor predeterminado de 
ganancia <M>.

ISO/Gain<L> Para obtener más detalles acerca de los 
ajustes, consulte “Ajustes y valores 
predeterminados de Iso/Gain” 
(página 101).

Ajusta el valor predeterminado de 
ganancia <L>.

Exposure 
Index<H>

Cuando Base ISO se establece en ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Cuando Base ISO se establece en ISO 
12800:

3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Ajusta el valor del índice de exposición 
<H>.
Disponible solo en modo Cine EI.

Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento Ajuste de subelementos Descripción

Exposure 
Index<M>

(El mismo ajuste que Exposure Index<H>)
Cuando Base ISO se establece en ISO 800:

1000EI / 6.3E
Cuando Base ISO se establece en ISO 
12800:

16000EI / 6.3E

Ajusta el valor del índice de exposición 
<M>.

Exposure 
Index<L>

(El mismo ajuste que Exposure Index<H>)
Cuando Base ISO se establece en ISO 800:

800EI / 6.0E
Cuando Base ISO se establece en ISO 
12800:

12800EI / 6.0E

Ajusta el valor del índice de exposición 
<L>.

Shockless 
Gain

On / Off Activa y desactiva la función de ganancia 
sin vibraciones.

Base 
Sensitivity

High / Low Establece la sensibilidad base para el 
modo SDR/HDR.

Base ISO ISO 12800 / ISO 800 Establece la sensibilidad ISO base para el 
modo Cine EI.

Shooting >ND Filter
Ajuste los valores predeterminados del filtro ND.

Elemento Ajuste de subelementos Descripción

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Ajusta el valor predeterminado 1 del filtro 
ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Ajusta el valor predeterminado 2 del filtro 
ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Ajusta el valor predeterminado 3 del filtro 
ND.

Shooting >Shutter
Ajusta las condiciones operativas del obturador electrónico.

Elemento Ajuste de subelementos Descripción

Mode Speed / Angle Selecciona el modo de operación del 
obturador electrónico.
Se utiliza para filmar con claridad sujetos 
que se mueven rápidamente. Selecciona 
el modo para ajustar la velocidad del 
obturador en segundos (Speed) o como 
el ángulo del obturador (Angle).

Shutter 
Speed  
On/Off

On / Off Establece si el tiempo de exposición 
cuando se selecciona el modo Speed 
sigue el valor de Shutter Speed o se 
establece para exposición completa.
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Shooting >Shutter
Ajusta las condiciones operativas del obturador electrónico.

Elemento Ajuste de subelementos Descripción

Shutter 
Speed

64F a 1/8000
Los ajustes disponibles dependen de la 
frecuencia de fotogramas del formato de 
vídeo seleccionado.
59.94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Ajusta la velocidad del obturador cuando 
Mode está ajustado en Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° /  
270.0° / 240.0° / 216.0° / 210.0° /  
180.0° / 172.8° / 150.0° / 144.0° /  
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 
30.0° / 22.5° / 11.25° / 5.6°

Ajusta el ángulo del obturador cuando 
Mode está ajustado en Angle.

ECS On/Off On / Off Activa y desactiva la función Extended 
Clear Scan.

Shooting >Shutter
Ajusta las condiciones operativas del obturador electrónico.

Elemento Ajuste de subelementos Descripción

ECS 
Frequency

De 23.99 a 8000
Los ajustes disponibles dependen de la 
frecuencia de fotogramas del formato de 
vídeo seleccionado.
A continuación se indican los valores 
predeterminados.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Ajusta la frecuencia ECS cuando Mode 
está ajustado en ECS.

Shooting >Auto Exposure
Configura los ajustes de la exposición automática.

Elemento Ajuste de subelementos Descripción

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Establece el nivel de brillo para la 
exposición detectada automáticamente.

Mode Backlight / Standard / Spotlight Establece el modo de funcionamiento del 
ajuste de exposición automática.
Backlight: 

Modo de retroiluminación (modo 
para reducir el oscurecimiento de un 
sujeto cuando dicho sujeto está 
retroiluminado)

Standard: 
Modo estándar

Spotlight: 
Modo de luz direccional (modo para 
reducir la sobreexposición de blancos 
cuando el sujeto recibe una 
iluminación direccional)

Speed De –99 a +99 (±0) Establece la velocidad de ajuste del 
ajuste de exposición automática.

AGC On / Off Activa y desactiva la función AGC (Control 
automático de ganancia).

AGC Limit Para obtener más detalles acerca de los 
ajustes, consulte “Ajustes y valores 
predeterminados de AGC Limit” 
(página 103).

Ajusta la ganancia máxima de la función 
AGC.

AGC Point F2.8 / F4 / F5.6 Establece el valor F-stop de los iris si la 
operación AGC empieza cuando la 
función AGC está ajustada en On.
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Shooting >Auto Exposure
Configura los ajustes de la exposición automática.

Elemento Ajuste de subelementos Descripción

Auto Shutter On / Off Activa y desactiva la función de control 
del obturador automático.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Ajusta la velocidad más rápida del 
obturador en la función de obturador 
automático.

A.SHT Point F5.6 / F8 / F11 / F16 Establece el valor F-stop de los iris si se 
inicia la operación de obturación 
automática.

Clip High 
light

On / Off Activa y desactiva la función que ignora 
las zonas más iluminadas para 
proporcionar una respuesta menor a la 
luminosidad alta.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Ajusta el rango del medidor de luz para 
ajustar automáticamente la exposición 
de acuerdo con la luminosidad del sujeto. 
(No disponible cuando se ajusta la 
exposición manualmente)

Detect 
Window 
Indication

On / Off Activa y desactiva la indicación del rango 
del medidor de luz.

Custom 
Width

De 40 a 999 (500) Establece el ancho del rango del medidor 
de luz.

Custom 
Height

De 70 a 999 (500) Establece la altura del rango del medidor 
de luz.

Custom H 
Position

De –479 a +479 (±0) Ajusta la posición horizontal del rango 
del medidor de luz.

Custom V 
Position

De –464 a +464 (±0) Ajusta la posición vertical del rango del 
medidor de luz.

Shooting >White
Configura los ajustes del balance de blancos.

Elemento Ajuste de subelementos Descripción

Preset White De 2000K a 15000K (3200K) Ajusta el valor predeterminado del 
balance de blancos.

Color Temp 
<A>

De 2000K a 15000K (3200K) Establece la temperatura de color del 
balance de blancos que está guardada 
en la memoria A.

[Nota]
Dado que Color Temp se recorta a 2000K y 
15000K durante la operación R/B Gain, es 
posible que no se pueda mostrar el valor 
correcto de Color Temp para el valor R/B Gain.

Shooting >White
Configura los ajustes del balance de blancos.

Elemento Ajuste de subelementos Descripción

Tint<A> De –99 a +99 (±0) Establece el valor de matiz del balance 
de blancos guardado en la memoria 
blanca A.

[Nota]
Dado que Tint se recorta a ±99 durante la 
operación R/B Gain, es posible que no se 
pueda mostrar el valor correcto de Tint para el 
valor R/B Gain.

R Gain <A> De –99.0 a +99.0 (±0.0) Ajusta la ganancia R del balance de 
blancos que está guardada en la 
memoria A.

B Gain <A> De –99.0 a +99.0 (±0.0) Ajusta la ganancia B del balance de blancos 
que está guardada en la memoria A.

Color Temp 
<B>

De 2000K a 15000K (3200K) Establece la temperatura de color del 
balance de blancos que está guardada 
en la memoria B.

[Nota]
Dado que Color Temp se recorta a 2000K y 
15000K durante la operación R/B Gain, es 
posible que no se pueda mostrar el valor 
correcto de Color Temp para el valor R/B Gain.

Tint<B> De –99 a +99 (±0) Establece el valor de matiz del balance de 
blancos guardado en la memoria blanca B.

[Nota]
Dado que Tint se recorta a ±99 durante la 
operación R/B Gain, es posible que no se 
pueda mostrar el valor correcto de Tint para el 
valor R/B Gain.

R Gain <B> De –99.0 a +99.0 (±0.0) Ajusta la ganancia R del balance de 
blancos que está guardada en la 
memoria B.

B Gain <B> De –99.0 a +99.0 (±0.0) Ajusta la ganancia B del balance de 
blancos que está guardada en la 
memoria B.

Shooting >White Setting
Ajusta los ajustes del balance de blancos.

Elemento Ajuste de subelementos Descripción

Shockless 
White

Off / 1 / 2 / 3 Ajusta la velocidad de respuesta del 
balance de blancos cuando se cambia el 
modo de balance de blancos.
Off: cambia instantáneamente.
De 1 a 3: cambia más lentamente cuanto 

mayor es el número.

ATW Speed 1 / 2 / 3 / 4 / 5 Ajusta la velocidad de respuesta en el 
modo ATW.
1: velocidad de respuesta más rápida
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Shooting >White Setting
Ajusta los ajustes del balance de blancos.

Elemento Ajuste de subelementos Descripción

White 
Switch<B>

Memory / ATW Selecciona el modo de ajuste de balance 
de blancos seleccionado cuando el 
interruptor WHT BAL está ajustado en B.

Filter White 
Memory

On / Off Activa y desactiva la función que ajusta el 
área de memoria del balance de blancos 
para cada filtro ND.
On: ajusta la memoria de alance de 

blancos para cada filtro ND.

 [Consejo]
En el modo predeterminado hay cuatro 
ajustes (CLEAR /1 / 2 / 3). En el modo 
variable hay dos ajustes (CLEAR / On).

Off: ajusta la memoria de alance de 
blancos común a todos los filtros ND.

Shooting >Offset White
Configura los ajustes de desviación del balance de blancos.

Elemento Ajuste de subelementos Descripción

Offset White 
<A>

On / Off Selecciona si se debe (On) o no se debe 
(Off) añadir un valor de desviación al 
balance de blancos especificado en la 
memoria A.

Offset Color 
Temp<A>

De –99 a +99 (±0) Ajusta la desviación de la temperatura de 
color que se añadirá al balance de 
blancos en la memoria A cuando Offset 
White <A> está ajustado en On.

Offset 
Tint<A>

De –99 a +99 (±0) Ajusta la desviación del valor de Tint que 
se añadirá al balance de blancos en la 
memoria A cuando Offset White <A> está 
ajustado en On.

Offset White 
<B>

On / Off Selecciona si se debe (On) o no se debe 
(Off) añadir un valor de desviación al 
balance de blancos especificado en la 
memoria B.

Offset Color 
Temp<B>

De –99 a +99 (±0) Ajusta la desviación de la temperatura de 
color que se añadirá al balance de 
blancos en la memoria B cuando Offset 
White <B> está ajustado en On.

Offset 
Tint<B>

De –99 a +99 (±0) Ajusta la desviación del valor de Tint que 
se añadirá al balance de blancos en la 
memoria B cuando Offset White <B> está 
ajustado en On.

Shooting >Offset White
Configura los ajustes de desviación del balance de blancos.

Elemento Ajuste de subelementos Descripción

Offset White 
<ATW>

On / Off Selecciona si se debe (On) o no se debe 
(Off) añadir un valor de desviación al 
balance de blancos ATW.

Offset Color 
Temp<ATW>

De –99 a +99 (±0) Ajusta la desviación de la temperatura de 
color que se añadirá al balance de 
blancos ATW cuando Offset White <ATW> 
está ajustado en On.

Offset 
Tint<ATW>

De –99 a +99 (±0) Ajusta la desviación del valor de Tint que 
se añadirá al balance de blancos ATW 
cuando Offset White <ATW> está 
ajustado en On.

Shooting >Focus
Configura los ajustes de enfoque.

Elemento Ajuste de subelementos Descripción

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Establece la velocidad del enfoque para 
cuando el sujeto cambia durante el 
enfoque automático.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Establece la sensibilidad para cambiar el 
enfoque del sujeto durante el enfoque 
automático.

Focus Area Wide / Zone / Flexible Spot Establece el área de destino para la 
función Auto Focus y Push Auto Focus 
(AF) (página 37).
Wide: 

Busca un sujeto en un ángulo amplio 
de la imagen al enfocar.

Zone: 
Busca automáticamente un punto de 
enfoque dentro de la zona 
especificada.

Flexible Spot: 
Enfoca una posición especificada en 
la imagen.

Focus Area 
(AF-S)

Flexible Spot Establece el área de destino para la 
función Push Auto Focus (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Activa y desactiva el AF de detección de 
caras.

Push AF 
Mode

AF / Single-shot AF(AF-S) Ajusta el modo Push Auto Focus.
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Shooting >Focus
Configura los ajustes de enfoque.

Elemento Ajuste de subelementos Descripción

AF Assist On / Off Cuando está ajustado en On, le permite 
anular temporalmente el enfoque 
automático para ajustar el enfoque 
manualmente.

Shooting >S&Q Motion
Configura los ajustes del modo Slow & Quick Motion (página 49).

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo Slow & Quick 
Motion.
Cuando se ajusta en On, se inhabilitan las 
siguientes funciones.

 ˎ Diafragma automático
 ˎ Enfoque automático

Frame Rate De 1fps a 60fps / 100fps / 120fps / 150fps / 
180fps / 200fps / 240fps

Ajusta la velocidad de fotogramas para la 
filmación con el modo Slow & Quick 
Motion.

[Nota]
Los ajustes disponibles dependen de la 
frecuencia del sistema, el códec y el formato de 
vídeo seleccionados.

Shooting >LUT On/Off
Configura los ajustes de LUT.

Elemento Ajuste de subelementos Descripción

SDI/HDMI MLUT On / MLUT Off Selecciona si se va a aplicar la LUT de 
monitor al vídeo de las salidas SDI y 
HDMI.

VF/Proxy/
Stream

MLUT On / MLUT Off Selecciona si se va a aplicar la LUT de 
monitor al vídeo del visor, de proxy y de 
la salida de transmisión.

Internal Rec MLUT On / MLUT Off Selecciona si se va a aplicar la LUT de 
monitor al vídeo de grabación interna.

Shooting >Noise Suppression
Configura los ajustes de supresión de ruido.

[Consejo]
Los ajustes Setting(Custom) y Level(Custom) se reflejan en el ajuste Target Display (página 105).

Elemento Ajuste de subelementos Descripción

Setting 
(Custom)

On / Off Activa y desactiva la función de 
supresión de ruido en el modo Custom.

Level 
(Custom)

Low / Mid / High Ajusta el nivel de supresión de ruido en 
el modo Custom.

Setting 
(Cine EI)

On / Off Activa y desactiva la función de 
supresión de ruido en el modo Cine EI.

Level 
(Cine EI)

Low / Mid / High Ajusta el nivel de supresión de ruido en 
el modo Cine EI.

Shooting >Flicker Reduce
Configura los ajustes de corrección de parpadeo.

Elemento Ajuste de subelementos Descripción

Mode Auto / On / Off Ajusta el modo de corrección de 
parpadeo.

Frequency 50Hz / 60Hz Ajusta la frecuencia de la fuente de 
alimentación que proporciona la 
iluminación causante del parpadeo.

Shooting >SteadyShot
Configura los ajustes de estabilización de la imagen.

Elemento Ajuste de subelementos Descripción

Setting Active / Standard / Off Configura la función de estabilización de 
la imagen.

[Nota]
Habilitado cuando se acopla un objetivo 
compatible.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Project >Base Setting
Configura los ajustes básicos.

Elemento Ajuste de subelementos Descripción

Shooting 
Mode

Custom / Cine EI Ajusta el modo de filmación 
(página 24).

Target 
Display

SDR(BT.709) / HDR(HLG) Ajusta el espacio de color de la 
grabación/salida en el modo Cine EI.

Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento Ajuste de subelementos Descripción

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Selecciona la frecuencia del sistema.

Imager Scan 
Mode

FF / S35 Establece la combinación del método de 
lectura de imágenes (todos los 
píxeles / agrupación de píxeles) y la 
configuración del tamaño de la imagen.

Codec RAW / RAW & XAVC-I / XAVC-I / XAVC-L Ajusta el modo de grabación/
reproducción.

RAW Output 
Format

Los ajustes disponibles dependen de la 
configuración de Frequency y Codec.

Establece el formato de grabación de una 
grabadora RAW externa.

[Nota]
Cuando Codec está ajustado en RAW & XAVC-I, 
el ajuste Video Format cambia en la vinculación 
con el ajuste RAW Output Format.

Frequency Codec Opciones de 
selección

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & 
XAVC-I

4096×2160

3840×2160

24 RAW 4096×2160

RAW & 
XAVC-I

4096×2160

Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento Ajuste de subelementos Descripción

Video Format Los ajustes disponibles dependen de la 
configuración de Frequency y Codec.

Ajusta el formato de grabación.

Frequency Codec Opciones de 
selección

59.94 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

50 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

29.97 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Menú Project
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Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento Ajuste de subelementos Descripción

Video Format 25 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

23.98 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

24 RAW –

RAW & 
XAVC-I

4096×2160P

XAVC-I 4096×2160P

Project >Cine EI Setting
Configura los ajustes del modo Cine EI.

Elemento Ajuste de subelementos Descripción

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Ajusta el espacio de color en el modo 
Cine EI.
S-Gamut3/SLog3: 

Establece el espacio de color en el 
modo Cine EI en S-Gamut3.

S-Gamut3.Cine/SLog3: 
Establece el espacio de color en el 
modo Cine EI en S-Gamut3.Cine.

Project >Simul Rec
Ajusta el modo de grabación simultánea (página 50).

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
grabación simultánea y ajusta el soporte 
de destino de grabación.

Project >Proxy Rec
Ajusta el modo de grabación de proxy.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo de grabación 
de proxy.

Audio 
Channel

CH1/CH2 / CH3/CH4 Selecciona el canal de audio en el que se 
grabarán los datos de proxy.

Project >Interval Rec
Ajusta el modo de grabación de intervalos (página 49).

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo de grabación 
de intervalo. (Si se ajusta este modo en 
On, el resto de modos especiales se 
ajustará en Off).

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (seg.)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min.)
1 / 2 / 3 / 4 / 6 / 12 / 24 (hora)

Ajusta el intervalo entre grabaciones en 
el modo de grabación Interval Rec 
(cuando Interval Rec está ajustado en 
On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Los ajustes disponibles dependen de la 
frecuencia de fotogramas del formato de 
vídeo seleccionado.
59.94P/50P: 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P: 

1frame / 3frames / 6frames / 9frames

Ajusta el número de fotogramas que se 
desea grabar por toma en el modo de 
grabación Interval Rec (cuando Interval 
Rec está ajustado en On).

Pre-Lighting Off / 2sec / 5sec / 10sec Ajusta el número de segundos que se 
enciende la luz de vídeo antes de que se 
inicie la grabación en el modo de 
grabación Interval Rec.

[Consejo]
Disponible únicamente cuando se utiliza el 
HVL-LBPC (opcional).
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Project >SDI/HDMI Rec Control
Configura los ajustes de control de grabación SDI/HDMI.

Elemento Ajuste de subelementos Descripción

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Establece el control de inicio/parada de 
grabación de un dispositivo externo 
mediante la señal de salida SDI/HDMI.
Off: 

No usa el control remoto.
SDI/HDMI Remote I/F: 

Control de detención/inicio de 
grabación de un dispositivo externo 
conectado, cuando no hay ningún 
soporte insertado en la videocámara. 
No se ha sincronizado con la 
precisión de fotogramas para el 
soporte de la videocámara.

Parallel Rec: 
Control de detención/inicio de 
grabación de un dispositivo externo 
conectado, cuando hay un soporte 
insertado en la videocámara. 
Sincronizado con la precisión de 
fotogramas para el soporte de la 
videocámara.

[Nota]
Para el control con la señal de salida HDMI, 
ajuste HDMI TC Out >Setting (página 85) en 
el menú TC/Media del menú completo en On.

Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento Ajuste de subelementos Descripción

<1> a <9>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Auto Iris / Push Auto Iris / 
Auto Shutter / Auto Exposure Level / 
Backlight / Spotlight / Preset White 
Select / ATW / ATW Hold / AF Speed/
Sens. / Focus Setting / Focus Area / Focus 
Area(AF-S) / Face/Eye Detection AF / Push 
AF Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / Focus 
Magnifier x3 / Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / Rec Review / 
Clip Flag OK / Clip Flag NG / Clip Flag 
Keep / Color Bars / Tally [Front] / 
DURATION/TC/U-BIT / Display / Lens Info / 
Video Signal Monitor / Marker / VF 
Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Volume / 
Thumbnail / Touch Operation / Handle 
Zoom / NFC / Auto Upload (Proxy) / Direct 
Menu / User Menu / Menu

Asigna funciones a los botones 
asignables.
Base ISO/Sensitivity: 

Cambia la sensibilidad base del 
sensor de imagen.

AGC: 
Activa y desactiva la función AGC.

Push AGC: 
Habilita la función AGC mientras se 
mantiene pulsado el botón.

ND Filter Position: 
Cambia los filtros ND.

Auto ND Filter: 
Activa y desactiva la función de filtro 
ND.

Push Auto ND: 
Habilita la función Auto ND Filter 
mientras se mantiene pulsado el 
botón.

Auto Iris: 
Activa y desactiva la función del 
diafragma.

Push Auto Iris: 
Habilita la función de diafragma 
automático mientras se mantenga 
pulsado el botón.

Auto Shutter: 
Activa y desactiva la función del 
obturador automático.

Auto Exposure Level: 
Muestra/sale del menú directo de 
Auto Exposure Level.

Backlight: 
Cambia entre retroiluminación y 
estándar.

Spotlight: 
Cambia entre luz direccional y 
estándar.

Preset White Select: 
Cambia el valor del modo 
predeterminado del balance de 
blancos.

ATW: 
Activa y desactiva la función ATW.

ATW Hold: 
Pausa la operación de la función 
ATW.
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Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento Ajuste de subelementos Descripción

<1> a <9>, 
Focus Hold 
Button

AF Speed/Sens.: 
Cambia el ajuste de la velocidad de 
transición AF y el ajuste de la 
sensibilidad de desplazamiento del 
sujeto AF.

Focus Setting: 
Establece el área de enfoque.

Focus Area: 
Establece el área de enfoque para AF 
y Push AF.

Focus Area(AF-S): 
Establece el área de enfoque para 
Push AF (AF-S).

Face/Eye Detection AF: 
Cambia la configuración del AF de 
detección de caras/ojos.

Push AF Mode: 
Cambia la configuración del modo 
Push AF.

Push AF/Push MF: 
En el modo de enfoque MF, activa AF 
mientras se presiona el botón. 
En el modo de enfoque AF, activa MF 
mientras se presiona el botón.

Focus Hold: 
En el modo de enfoque AF, el 
enfoque se fija mientras se presiona 
el botón.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

Activa y desactiva la función de 
ampliación de enfoque.

S&Q Motion: 
Activa y desactiva Slow & Quick 
Motion. 
Establece la velocidad de fotogramas 
de filmación si se mantiene pulsado.

SteadyShot: 
Alterna entre Active, Standard y Off.

Rec: 
Inicia/detiene la grabación.

Rec Review: 
Activa y desactiva la función Rec 
Review.

Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento Ajuste de subelementos Descripción

<1> a <9>, 
Focus Hold 
Button

Clip Flag OK: 
Ejecuta la función Add OK. 
Pulse dos veces para ejecutar Delete 
Clip Flag.

Clip Flag NG: 
Ejecuta la función Add NG. 
Pulse dos veces para ejecutar Delete 
Clip Flag.

Clip Flag Keep: 
Ejecuta la función Add Keep. 
Pulse dos veces para ejecutar Delete 
Clip Flag.

Color Bars: 
Activa y desactiva las barras de 
colores.

Tally [Front]: 
Activa y desactiva la función de 
grabación/lámpara indicadora/
parpadeo.

DURATION/TC/U-BIT: 
Alterna entre Time Code, Users Bit y 
Duration.

Display: 
Activa y desactiva los indicadores de 
la pantalla.

Lens Info: 
Cambia el indicador de profundidad 
de campo.

Video Signal Monitor: 
Cambia el monitor de señal de vídeo 
(como un monitor de forma de onda).

Marker: 
Activa y desactiva la función de 
marcador.

VF Adjust: 
Muestra las barras de nivel para el 
ajuste del brillo de la pantalla del 
visor.

VF Mode: 
Cambia la visualización del visor 
entre color y blanco y negro.

Gamma Display Assist: 
Cambia la función de asistencia de 
visualización de gamma.

Peaking: 
Activa y desactiva la función de 
nitidez.
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Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento Ajuste de subelementos Descripción

<1> a <9>, 
Focus Hold 
Button

Zebra: 
Activa y desactiva la función cebra.

Volume: 
Ajusta la salida del nivel de audio del 
monitor en la toma de auriculares y 
en el altavoz incorporado.

Thumbnail: 
Muestra/sale de la pantalla de 
imágenes en miniatura.

Touch Operation: 
Activa y desactiva el funcionamiento 
táctil.

Handle Zoom: 
Cambia el funcionamiento del zoom 
del asa.

NFC: 
Ejecuta la función NFC.

Auto Upload (Proxy): 
Activa y desactiva la transferencia 
automática de los archivos proxy.

Direct Menu: 
Muestra/sale del menú directo.

User Menu: 
Muestra/sale del menú User.

Menu: 
Muestra/sale del menú completo.

Project >Assignable Dial
Establece las asignaciones de funciones para el dial asignable y ajusta el sentido de rotación.

Elemento Ajuste de subelementos Descripción

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level

Asigna funciones al dial asignable.
ISO/Gain/EI: 

Ajusta la ganancia o EI.
ND Filter: 

Ajusta el filtro ND.
IRIS: 

Ajusta el diafragma.
Auto Exposure Level: 

Ajusta el nivel de exposición 
automática.

Audio Input Level: 
Ajusta el nivel de grabación de audio.

Grip Dial 
Direction

Normal / Opposite Establece el sentido de rotación del dial 
asignable de la empuñadura.
Normal: Girar en sentido normal.
Opposite: Girar en sentido contrario.

Project >Assignable Dial
Establece las asignaciones de funciones para el dial asignable y ajusta el sentido de rotación.

Elemento Ajuste de subelementos Descripción

Handle Dial Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level / Multi 
Function Dial

Asigna funciones al dial asignable del 
asa.
ISO/Gain/EI: 

Ajusta la ganancia o EI.
ND Filter: 

Ajusta el filtro ND.
IRIS: 

Ajusta el diafragma.
Auto Exposure Level: 

Ajusta el nivel de exposición 
automática.

Audio Input Level: 
Ajusta el nivel de grabación de audio.

Multi Function Dial: 
Funciona como un dial multifunción.

Handle Dial 
Direction

Normal / Opposite Establece el sentido de rotación del dial 
asignable del asa.
Normal: Girar en sentido normal.
Opposite: Girar en sentido contrario.

Project >Multi Function Dial
Asigna funciones al dial multifunción.

Elemento Ajuste de subelementos Descripción

Default 
Function

Off / IRIS / ISO/Gain/EI / Auto Exposure 
Level / Audio Input Level

Asigna la función predeterminada al dial 
multifunción.
IRIS: 

Ajusta el diafragma.
ISO/Gain/EI: 

Ajusta la ganancia o EI.
Auto Exposure Level: 

Ajusta el nivel de exposición 
automática.

Audio Input Level: 
Ajusta el nivel de grabación de audio.
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Project >User File
Establece configuraciones relacionadas con las operaciones de archivos de usuario.

Elemento Ajuste de subelementos Descripción

Load 
Media(B)

Execute / Cancel Carga la configuración del archivo de 
usuario en una tarjeta de memoria 
insertada en una ranura para tarjetas 
CFexpress Tipo A/SD (B).
Execute: ejecuta la función.

Save 
Media(B)

Execute / Cancel Guarda la configuración del archivo de 
usuario en una tarjeta de memoria 
insertada en una ranura para tarjetas 
CFexpress Tipo A/SD (B).
Execute: ejecuta la función.

File ID Muestra una pantalla para mostrar/editar 
el identificador de archivo de los archivos 
de usuario.

Load 
Customize 
Data

On / Off Establece si desea cargar la información 
personalizada del menú User al ejecutar 
Load Media(B).

Load White 
Data

On / Off Establece si desea cargar la información 
del balance de blancos al ejecutar Load 
Media(B).

Project >All File
Configura los ajustes relacionados con los archivos ALL.

Elemento Ajuste de subelementos Descripción

Load 
Media(B)

Execute / Cancel Carga un archivo ALL
Execute: ejecuta la función.

Save 
Media(B)

Execute / Cancel Guarda un archivo ALL.
Execute: ejecuta la función.

File ID Asigna un nombre al archivo.

Load Network 
Data

On / Off Establece si desea cargar la información 
de configuración del menú Network al 
ejecutar Load Media(B).
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Menú Paint/Look
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Paint/Look >Scene File
Configura los ajustes relacionados con los archivos de escena.

Elemento Ajuste de subelementos Descripción
Recall Carga un archivo de escena restaurado en 

la memoria interna y aplica los ajustes a la 
configuración actual de la calidad de 
imagen.

Store Guarda el estado actual de la calidad de 
imagen como archivo de escena en la 
memoria interna.

Delete Elimina un archivo de escena almacenado 
en la memoria interna.

Preset Recall Cuando Shooting Mode está ajustado en 
Custom y Target Display está ajustado en 
SDR(BT.709):

S-Cinetone / Standard / Still / ITU709
Cuando Shooting Mode está ajustado en 
Custom y Target Display está ajustado en 
HDR(HLG):

HLG Live / HLG Natural

Aplica los ajustes predeterminados de la 
calidad de imagen (no regrabables) a la 
configuración actual de la calidad de 
imagen.

Paint/Look >Base Look
Configura los ajustes relacionados con el aspecto básico.

Elemento Ajuste de subelementos Descripción
Select Cuando Shooting Mode está ajustado en 

Custom y Target Display está ajustado en 
SDR(BT.709):

S-Cinetone / Standard / Still / ITU709 / 
De User1 a User16

Cuando Shooting Mode está ajustado en 
Custom y Target Display está ajustado en 
HDR(HLG):

HLG Live / HLG Natural / De User1 a 
User16

Cuando Shooting Mode está ajustado en 
Cine EI:

s709 / 709(800) / S-Log3 / De User1 a 
User16

Selecciona un aspecto básico.

Delete Elimina el aspecto básico seleccionado.
Delete All Elimina todos los aspectos básicos.
Import Carga un archivo de aspecto básico desde 

un soporte de grabación.
Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Establece la gama de entrada para el 

aspecto básico seleccionado.

Paint/Look >Base Look
Configura los ajustes relacionados con el aspecto básico.

Elemento Ajuste de subelementos Descripción
Output BT.709 / HLG Establece la gama de salida para el 

aspecto básico seleccionado.
AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /  
5/3EV / 2EV

Establece el valor de referencia de la 
exposición para el aspecto básico 
seleccionado.

Paint/Look >Reset Paint Settings
Restablece los ajustes del menú Paint/Look, excepto el aspecto básico.

Elemento Ajuste de subelementos Descripción
Reset without 
Base Look

Execute / Cancel Restablece los ajustes del menú Paint/
Look, excepto el aspecto básico.
Execute: ejecuta la función.

Paint/Look >Black
Configura los ajustes de negro.

Elemento Ajuste de subelementos Descripción

Master Black De –99.0 a +99.0 (±0.0) Ajusta el nivel de negro maestro.

R Black De –99.0 a +99.0 (±0.0) Ajusta el nivel de negro R.

B Black De –99.0 a +99.0 (±0.0) Ajusta el nivel de negro B.

Paint/Look >Knee
Configura los ajustes de corrección de inflexión.

Elemento Ajuste de subelementos Descripción

Setting Cuando Target Display está ajustado en 
SDR(BT.709):

On / Off / ---
Cuando Target Display está ajustado en 
HDR(HLG):

On / Off / ---

Activa y desactiva la función de 
corrección de inflexión.

Auto Knee Cuando Target Display está ajustado en 
SDR(BT.709):

On / Off / ---
Cuando Target Display está ajustado en 
HDR(HLG):

On / Off / ---

Activa y desactiva la función de inflexión 
automática.

Point De 75% a 109% (90%) Ajusta el punto de inflexión.

Slope De –99 a +99 (±0) ajusta la pendiente de inflexión.
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Paint/Look >Detail
Configura las opciones de ajuste de detalles.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de detalles.

Level De –7 a +7 (±0) Ajusta el nivel de detalle.

Manual 
Setting

On / Off / --- Activa y desactiva la función de ajuste 
manual de detalles.

V/H Balance De –2 a +2 (±0) Ajusta el balance entre el detalle vertical 
(V) y el horizontal (H) para el ajuste 
manual de detalles.

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Ajusta el balance entre el detalle de 
negros (B) para las áreas de baja 
luminosidad y el detalle de blancos (W) 
para las áreas de alta luminosidad para el 
ajuste manual de detalles.

Limit De 0 a 7 Establece el límite de detalle para el 
ajuste manual de detalles.

Crispening De 0 a 7 Establece el nivel de nitidez para el ajuste 
manual de detalles.

High Light 
Detail

De 0 a 4 Establece el límite de detalle de las áreas 
de alta luminosidad para el ajuste 
manual de detalles.

Paint/Look >Matrix
Configura los ajustes de corrección de matrices.

Elemento Ajuste de subelementos Descripción

User Matrix On / Off Activa y desactiva la función de 
corrección matricial del usuario.

User Matrix 
Level

De –99 a +99 (±0) Ajusta la saturación de color de toda la 
imagen.

User Matrix 
Phase

De –99 a +99 (±0) Ajusta el tono de color (fase) de toda la 
imagen.

User Matrix 
R-G

De –99 a +99 (±0) Ajusta una matriz del usuario R-G 
definida por el usuario.

User Matrix 
R-B

De –99 a +99 (±0) Ajusta una matriz del usuario R-B 
definida por el usuario.

User Matrix 
G-R

De –99 a +99 (±0) Ajusta una matriz del usuario G-R 
definida por el usuario.

User Matrix 
G-B

De –99 a +99 (±0) Ajusta una matriz del usuario G-B 
definida por el usuario.

User Matrix 
B-R

De –99 a +99 (±0) Ajusta una matriz del usuario B-R 
definida por el usuario.

Paint/Look >Matrix
Configura los ajustes de corrección de matrices.

Elemento Ajuste de subelementos Descripción

User Matrix 
B-G

De –99 a +99 (±0) Ajusta una matriz del usuario B-G 
definida por el usuario.

Paint/Look >Multi Matrix
Configura los ajustes de corrección de matrices múltiples.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
corrección de matrices múltiples.

Reset Execute / Cancel Restablece el tono y la saturación de 
cada color de eje a los valores 
predeterminados.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Selecciona el eje.

Hue De –99 a +99 (±0) Ajusta el matiz del color utilizado para la 
corrección de matrices múltiples.

Saturation De –99 a +99 (±0) Ajusta la saturación del color utilizado 
para la corrección de matrices múltiples.
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Menú TC/Media
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

TC/Media >Timecode
Configura los ajustes de código de tiempo.

Elemento Ajuste de subelementos Descripción

Mode Preset / Regen / Clock Ajusta el modo de ejecución del código 
de tiempo.
Preset: 

Empieza a funcionar a partir de un 
valor preestablecido.

Regen: 
Empieza a funcionar a partir del 
código de tiempo del final del clip 
anterior.

Clock: 
Utiliza el reloj interno como código 
de tiempo.

Run Rec Run / Free Run Rec Run: Funciona solo durante la 
grabación.

Free Run: Funciona siempre, 
independientemente del 
funcionamiento del camcorder.

Setting Ajusta el código de tiempo en un valor 
arbitrario.
SET: Ajustar el valor.

Reset Execute / Cancel Restablece el valor del código de tiempo 
a 00:00:00:00.
Execute: ejecuta la función.

TC Format DF / NDF Ajusta el formato del código de tiempo.
DF: Omisión de fotograma
NDF: No omisión de fotograma

TC/Media >TC Display
Configura los ajustes de visualización de datos de tiempo.

Elemento Ajuste de subelementos Descripción

Display Select Timecode / Users Bit / Duration Cambia la visualización de datos de 
tiempo.

TC/Media >Users Bit
Configura los ajustes relacionados con los bits de usuario.

Elemento Ajuste de subelementos Descripción

Mode Fix / Time Ajusta el modo de bit de usuario.
Fix: Utiliza un valor fijo arbitrario en bits 

de usuario.
Time: Utiliza la hora actual en bits de 

usuario.

Setting Ajusta los bits de usuario en un valor 
arbitrario.

TC/Media >HDMI TC Out
Configura los ajustes relacionados con la salida de código de tiempo cuando se utiliza HDMI.

Elemento Ajuste de subelementos Descripción

Setting On / Off Ajusta si enviar la salida del código de 
tiempo a dispositivos con otros objetivos, 
mediante HDMI.
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TC/Media >Clip Name Format
Configura los ajustes relacionados con el nombre y la eliminación de los clips.

Elemento Ajuste de subelementos Descripción

Title Prefix nnn_ (nnn son los 3 últimos dígitos del 
número de serie)
(Visualización de un máximo de 7 dígitos)

Establece la parte del título (de 4 a 46 
caracteres) del nombre del clip.
Abre una pantalla de introducción de 
cadenas de caracteres.

Estructura de la pantalla de 
introducción de cadenas de caracteres
Área de selección de caracteres (3 líneas): 

Selecciona los caracteres que se van 
a introducir en la posición del cursor 
del área Title Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Área de operación del cursor (1 línea): 
Espacio: inserta un espacio en la 
posición del cursor.  
: mueve el cursor hacia la 
izquierda.  
: mueve el cursor hacia la derecha.  
BS: elimina el carácter situado a la 
izquierda del cursor.

Área Title Prefix (1 línea): 
Área para indicar el título.

Para establecer el título
1. Seleccione el carácter que desea 

insertar en la posición del cursor en 
el área Title Prefix desde el área de 
selección de caracteres con el 
selector múltiple (página 7) y 
pulse el botón de aplicar del selector 
múltiple. (Se inserta el carácter 
seleccionado y el cursor se mueve 
hacia la derecha).

2. Repita el paso 1 para establecer el 
título. (Utilice BS según sea 
necesario.)

3. Tras establecer el título, seleccione 
Done para cerrar la pantalla de 
introducción de caracteres.

TC/Media >Clip Name Format
Configura los ajustes relacionados con el nombre y la eliminación de los clips.

Elemento Ajuste de subelementos Descripción

Number Set De 0001 a 9999 Establece el sufijo formado por un 
número de 4 dígitos del nombre del clip.

TC/Media >Update Media
Actualiza el archivo de gestión en las tarjetas de memoria.

Elemento Ajuste de subelementos Descripción

Media(A) Execute / Cancel Actualiza el archivo de gestión en la 
tarjeta de memoria en la ranura A.
Execute: ejecuta la función.

Media(B) Execute / Cancel Actualiza el archivo de gestión en la 
tarjeta de memoria en la ranura B.
Execute: ejecuta la función.

TC/Media >Format Media
Inicializa las tarjetas de memoria.

Elemento Ajuste de subelementos Descripción

Media(A) Full Format / Quick Format / Cancel Formatea la tarjeta de memoria de la 
ranura A.

Media(B) Full Format / Quick Format / Cancel Formatea la tarjeta de memoria de la 
ranura B.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Monitoring >Output On/Off
Configura los ajustes de salida de vídeo.

Elemento Ajuste de subelementos Descripción

SDI On / Off Activa y desactiva la salida SDI.

HDMI On / Off Activa y desactiva la salida HDMI.

Monitoring >Output Format
Configura los ajustes del formato de salida.

Elemento Ajuste de subelementos Descripción

SDI Para obtener más detalles acerca de los 
ajustes, consulte “Limitaciones y formatos 
de salida” (página 111).

Ajusta la resolución de salida de SDI y 
HDMI.HDMI

Monitoring >Output Display
Configura los ajustes de la señal de salida.

Elemento Ajuste de subelementos Descripción

SDI On / Off Muestra si el menú y la información de 
estado están integrados en la señal de 
salida SDI.

HDMI On / Off Muestra si el menú y la información de 
estado están integrados en la señal de 
salida HDMI.

Monitoring >Display On/Off
Configura los ajustes de los elementos de la pantalla.

Elemento Ajuste de subelementos Descripción

Network 
Status

On / Off Selecciona los elementos que se 
visualizan en el visor.

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

SteadyShot On / Off

Menú Monitoring
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Monitoring >Display On/Off
Configura los ajustes de los elementos de la pantalla.

Elemento Ajuste de subelementos Descripción

Base Look/
LUT

On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Configura los ajustes de visualización de marcadores.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la visualización de 
todos los marcadores.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Selecciona el color de la señal de los 
marcadores.

Center 
Marker

1 / 2 / 3 / 4 / Off Selecciona el marcador central.

Safety Zone On / Off Activa y desactiva el marcador de la zona 
de seguridad.

Safety Area 80% / 90% / 92.5% / 95% Selecciona el tamaño del marcador de la 
zona de seguridad (como un porcentaje 
del tamaño total de la pantalla).

Aspect 
Marker

Line / Mask / Off Selecciona el tipo de marcador de 
aspecto.

Aspect Mask De 0 a 15 (12) Ajusta el nivel de la señal de vídeo fuera 
del marcador.

Aspect Safety 
Zone

On / Off Activa y desactiva el marcador de la zona 
de seguridad de aspecto.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Selecciona el tamaño del marcador de la 
zona de seguridad de aspecto (como un 
porcentaje del tamaño total de la 
pantalla).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Ajusta el modo cuando se muestra el 
marcador de aspecto.

Custom 
Aspect Ratio

Introduzca un valor arbitrario (01.00:01.00) Configura la relación de aspecto en un 
valor arbitrario.

[Nota]
Esta opción se activa cuando Aspect Select 
está ajustado en Custom.

Guide Frame On / Off Activa y desactiva la visualización del 
fotograma de la imagen.

100% Marker On / Off Activa y desactiva el marcador de 100%.

User Box On / Off Activa y desactiva la visualización del 
marcador de casilla del usuario.

User Box 
Width

De 3 a 479 (240) Ajusta la amplitud del marcador de 
casilla de usuario (distancia del centro a 
los bordes derecho e izquierdo).

User Box 
Height

De 3 a 269 (135) Ajusta la altura del marcador de casilla 
de usuario (distancia del centro a los 
bordes superior e inferior).
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Monitoring >Marker
Configura los ajustes de visualización de marcadores.

Elemento Ajuste de subelementos Descripción

User Box H 
Position

De –476 a +476 (0) Establece la posición horizontal del 
centro del marcador de la casilla de 
usuario.

User Box V 
Position

De –266 a +266 (0) Establece la posición vertical del centro 
del marcador de la casilla de usuario.

Monitoring >VF Setting
Configura los ajustes del visor.

Elemento Ajuste de subelementos Descripción

Brightness De 1 a 15 (8) Ajusta el brillo de la imagen del visor.

Color Mode Color / B&W Selecciona el modo de visualización del 
visor en modo E-E/grabación.

Monitoring >Gamma Display Assist
Ajusta la asistencia de la visualización de gamma.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de pantalla 
asistida de gamma en el modo Custom 
cuando Target Display está ajustado en 
HDR(HLG).

Monitoring >Peaking
Configura los ajustes de nitidez.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de nitidez.

Peaking Level High / Mid / Low Ajusta el nivel de la señal de nitidez de 
color.

Color B&W / Red / Yellow / Blue Selecciona el color de la señal de nitidez 
de color.

Monitoring >Zebra
Configura los ajustes de los patrones de cebra.

Elemento Ajuste de subelementos Descripción

Setting Off / Zebra1 / Zebra2 Selecciona el tipo de patrón de cebra 
(Off, Zebra 1, Zebra 2).

Zebra1 Level De 0% a 109% (70%) Ajusta el nivel de visualización de Zebra 1.

Zebra1 
Aperture 
Level

De 2% a 20% (10%) Ajusta el nivel de apertura de Zebra 1.

Zebra2 Level De 0% a 109% (100%) Ajusta el nivel de visualización de Zebra 2.
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Menú Audio
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).
Consulte “Diagramas de bloques” (página 125).

Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento Ajuste de subelementos Descripción

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Cambia la fuente de entrada para la 
grabación en el canal 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Cambia la fuente de entrada para la 
grabación en el canal 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Cambia la fuente de entrada para la 
grabación en el canal 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Cambia la fuente de entrada para la 
grabación en el canal 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Ajusta el nivel de la grabación de 
referencia para la entrada del micrófono 
XLR desde INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Ajusta el nivel de la grabación de 
referencia para la entrada del micrófono 
XLR desde INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Selecciona el nivel de entrada de 
referencia cuando los interruptores 
INPUT1/INPUT2 están ajustados en LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Selecciona el nivel de grabación de la 
señal del tono de referencia de 1 kHz.

CH1 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 1.

CH2 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 2.

CH3 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 3.

CH4 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 4.

Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento Ajuste de subelementos Descripción

CH3 Level 
Control

Auto / Manual Selecciona el ajuste de nivel de entrada 
de audio automático o el ajuste manual 
para el canal de grabación 3.

[Nota]
Si CH3 Input Select y CH4 Input Select están 
ajustados en Internal MIC, CH4 cambia a 
automático/manual junto con este ajuste.

CH4 Level 
Control

Auto / Manual Selecciona el ajuste de nivel de entrada 
de audio automático o el ajuste manual 
para el canal de grabación 4.

[Nota]
Si CH3 Input Select y CH4 Input Select están 
ajustados en Internal MIC, CH4 cambia a 
automático/manual junto con el ajuste CH3 
Level Control.

CH3 Input 
Level

De 0 a 99 (49) Ajusta el nivel de entrada para el canal 
de grabación 3.

CH4 Input 
Level

De 0 a 99 (49) Ajusta el nivel de entrada para el canal 
de grabación 4.

Audio Input 
Level

De 0 a 99 Ajusta el nivel de entrada de audio.
Se puede utilizar como volumen maestro 
en función de los ajustes de CH1 Level a 
CH4 Level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Selecciona la característica del limitador 
para señales de entrada grandes cuando 
está ajustado el nivel de entrada de 
audio manualmente.

CH1&2 AGC 
Mode

Mono / Stereo Establece el modo de ajuste de nivel 
automático para la grabación en el canal 
1 y en el canal 2. Cuando se selecciona 
Stereo, AGC se vincula entre los canales.

CH3&4 AGC 
Mode

Mono / Stereo Establece el modo de ajuste de nivel 
automático para la grabación en el canal 
3 y en el canal 4. Cuando se selecciona 
Stereo, AGC se vincula entre los canales.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Selecciona la característica AGC.
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Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento Ajuste de subelementos Descripción

1kHz Tone on 
Color Bars

On / Off Activa y desactiva la señal de tono de 
referencia de 1 kHz cuando se muestran 
las barras de colores.

[Nota]
Cuando se ajusta en On, la señal de tono de 
referencia de 1 kHz se establece para grabar 
en el canal 3 y en el canal 4, aunque CH3 Input 
Select y CH4 Input Select estén ajustados en 
Off.

CH1 Level Entrada sin el adaptador de XLR
Audio Input Level / Side / Level+Side

Entrada con el adaptador de XLR 
(página 47)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 1.

[Nota]
“Side” hace referencia al dial AUDIO LEVEL 
(CH1) situado en el lateral de la videocámara. 
Cuando se selecciona Level+Side, el nivel de 
grabación de audio está determinado por la 
combinación de Audio Input Level y los ajustes 
del dial (página 125).

CH2 Level Entrada sin el adaptador de XLR
Audio Input Level / Side / Level+Side

Entrada con el adaptador de XLR 
(página 47)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 2.

[Nota]
“Side” hace referencia al dial AUDIO LEVEL 
(CH2) situado en el lateral de la videocámara. 
Cuando se selecciona Level+Side, el nivel de 
grabación de audio está determinado por la 
combinación de Audio Input Level y los ajustes 
del dial (página 125).

CH3 Level Entrada sin el adaptador de XLR
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Entrada con el adaptador de XLR 
(página 47)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 3.

CH4 Level Entrada sin el adaptador de XLR
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Entrada con el adaptador de XLR 
(página 47)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 4.

Audio >Audio Output
Configura los ajustes de salida de audio.

Elemento Ajuste de subelementos Descripción

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Selecciona la salida del canal de audio en 
la toma de auriculares y en el altavoz 
incorporado.

[Nota]
Si el audio de varios canales se establece para 
la salida simultánea, el nivel de salida de cada 
canal se reduce para la emisión con el fin de 
evitar la sobreexposición.

Volume De 0 a 50 Ajusta la salida del nivel de audio del 
monitor en la toma de auriculares y en el 
altavoz incorporado.

Headphone 
Out

Mono / Stereo Selecciona si la salida de la toma de 
auriculares es monoaural (Mono) o 
estéreo (Stereo).

Alarm Level De 0 a 7 (4) Ajusta el volumen de la alarma.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Ajusta la combinación de canales de 
audio en la salida HDMI.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Thumbnail

Elemento Ajuste de subelementos Descripción

Display Clip 
Properties

Muestra la pantalla de propiedades de 
visualización de clips.

Thumbnail >Set Clip Flag
Configura los ajustes de marca de clip.

Elemento Ajuste de subelementos Descripción

Add OK Agrega una marca OK.

Add NG Agrega una marca NG.

Add KEEP Agrega una marca Keep.

Delete Clip 
Flag

Elimina todas las marcas.

Thumbnail >Lock/Unlock Clip
Configura los ajustes de protección de clips.

Elemento Ajuste de subelementos Descripción

Select Clip Selecciona y bloque/desbloquea un clip.

Lock All Clips Bloquea todos los clips.

Unlock All 
Clips

Desbloquea todos los clips.

Thumbnail >Delete Clip
Elimina clips.

Elemento Ajuste de subelementos Descripción

Select Clip Elimina el clip seleccionado.

All Clips Elimina todos los clips.

Thumbnail >Transfer Clip
Transfiere los clips.

[Nota]
Transfer Clip no se puede configurar si no se ha definido Access Authentication >Password en el menú Network.

Elemento Ajuste de subelementos Descripción

Select Clip Transfiere los clips seleccionados.

All Clips Transfiere todos los clips.

[Nota]
Se pueden transferir hasta 200 clips.

Thumbnail >Transfer Clip (Proxy)
Transfiere los clips de proxy.

[Nota]
Transfer Clip (Proxy) no se puede configurar si no se ha definido Access Authentication >Password en el menú 
Network.

Elemento Ajuste de subelementos Descripción

Select Clip Transfiere los clips de proxy 
correspondientes a los clips 
seleccionados.

All Clips Transfiere los clips de proxy 
correspondientes a todos los clips.

[Nota]
Se pueden transferir hasta 200 clips.

Thumbnail >Filter Clips
Configura los ajustes de los clips que se van a visualizar.

Elemento Ajuste de subelementos Descripción

OK Muestra solo los clips con la marca OK.

NG Muestra solo los clips con la marca NG.

KEEP Muestra solo los clips con la marca Keep.

None Muestra solo los clips que no tienen 
marca.

All Muestra todos los clips, 
independientemente de si hay marcas.

Thumbnail >Customize View
Cambia la pantalla de imágenes en miniatura.

Elemento Ajuste de subelementos Descripción

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Cambia la información mostrada debajo 
de las imágenes en miniatura.

Menú Thumbnail
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Menú Technical
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Technical >Color Bars
Configura los ajustes de las barras de colores.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva las barras de colores.

Type ARIB / 100% / 75% / SMPTE Selecciona el tipo de barra de color.

Technical >ND Dial
Configura los ajustes relacionados con las operaciones del dial ND VARIABLE.

Elemento Ajuste de subelementos Descripción

CLEAR with 
Dial

On / Off Establece si se habilita el cambio de 
estado ND (CLEAR  On) mediante la 
operación del dial ND VARIABLE.

Technical >Tally
Ajusta la lámpara indicadora/indicador de grabación.

Elemento Ajuste de subelementos Descripción

Front On / Off Enciende y apaga el indicador de 
grabación/lámpara indicadora (frontal).

Rear On / Off Enciende y apaga el indicador de 
grabación/lámpara indicadora (trasero).

Technical >HOLD Switch Setting
Configura los ajustes del interruptor Hold.

Elemento Ajuste de subelementos Descripción

with Rec 
Button

On / Off Establece si se bloquea el 
funcionamiento del botón START/STOP 
de grabación.

with Hand 
Grip Remote

On / Off Ajusta si se bloquea el funcionamiento 
del control remoto de la empuñadura.

Technical >Touch Operation
Configura los ajustes relacionados con las operaciones táctiles.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el funcionamiento táctil.

Technical >Rec Review
Configura los ajustes de revisión de grabación.

Elemento Ajuste de subelementos Descripción

Setting 3sec / 10sec / Clip Selecciona la hora de reproducción de los 
clips recién grabados para revisar la 
grabación.

Technical >Zoom
Configura los ajustes del zoom.

Elemento Ajuste de subelementos Descripción

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Establece el tipo de zoom.
Optical Zoom Only: 

El zoom óptico se ajusta mediante el 
objetivo.

On(Clear Image Zoom): 
Zoom electrónico con poco o nada 
de deterioro de la calidad de imagen.

Technical >Handle Zoom
Configura los ajustes del zoom del asa.

Elemento Ajuste de subelementos Descripción

Setting Off / Low / High / Variable Ajusta la velocidad del zoom del asa.

High De 1 a 8 (8) Establece la velocidad del zoom de la 
palanca de zoom del asa cuando se 
selecciona la velocidad High del zoom 
del asa.

Low De 1 a 8 (3) Establece la velocidad del zoom de la 
palanca de zoom del asa cuando se 
selecciona la velocidad Low del zoom del 
asa.

[Nota]
Puede producirse un zoom desequilibrado 
cuando la velocidad de zoom se ajusta a un 
valor bajo.

Technical >Menu Settings
Configura los ajustes relacionados con el menú.

Elemento Ajuste de subelementos Descripción

User Menu 
Only

On / Off Ajusta si solo se muestra el menú User 
(On) o si se muestra la lista del menú 
(Off) cuando la videocámara muestre el 
menú.

User Menu 
with Lock

On / Off Ajusta si se bloquea la pantalla del menú 
y se muestra solo el menú User.

[Nota]
Este elemento no se muestra durante el 
funcionamiento normal de la pantalla del 
menú. Para obtener más información acerca 
del funcionamiento de la pantalla del menú, 
consulte la página 68.
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Technical >Fan Control
Configura los ajustes del modo de control del ventilador.

Elemento Ajuste de subelementos Descripción

Setting Auto / Minimum / Off in Rec Ajusta el modo de control del ventilador 
de la videocámara.

[Nota]
Si la temperatura interna de la videocámara 
asciende por encima de un valor determinado, 
el ventilador comenzará a funcionar, aunque 
esté seleccionada la opción Off in Rec.

Technical >Lens
Configura los ajustes relacionados con los objetivos.

Elemento Ajuste de subelementos Descripción

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Ajusta el sentido de funcionamiento del 
anillo del zoom.

[Nota]
Solo está habilitado cuando se utiliza un 
objetivo de montura E compatible con el 
cambio de dirección del anillo de zoom.

Shading 
Compensation

Auto / Off Activa y desactiva la compensación de 
sombreado automático.

Chroma 
Aberration 
Comp.

Auto / Off Activa y desactiva la compensación de la 
aberración cromática automática.

Distortion 
Comp.

Auto / Off Activa y desactiva la compensación 
automática de la distorsión.

Distance 
Display

Meter / Feet Establece las unidades de visualización 
para la información del objetivo y la 
posición de enfoque.

Zoom Position 
Display

Focal Length / Number / Bar Establece el formato de visualización 
para la posición del zoom.

Technical >Video Light Set
Ajusta el método de iluminación de la luz de vídeo. Disponible únicamente cuando se utiliza el 
HVL-LBPC (opcional).

Elemento Ajuste de subelementos Descripción

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Ajusta el método de control de 
iluminación para la luz de vídeo acoplada 
a la zapata de interfaces múltiples.
Power Link: 

Activa y desactiva la luz de vídeo 
cuando la videocámara se enciende/
apaga.

Rec Link: 
Activa y desactiva la luz de vídeo 
cuando la videocámara inicia/detiene 
la grabación.

Rec Link + Stby: 
Activa y habilita el modo de espera la 
luz de vídeo cuando la videocámara 
inicia/detiene la grabación.

Technical >APR
Ejecuta APR.

Elemento Ajuste de subelementos Descripción

APR Execute / Cancel Ejecuta APR (restauración automática de 
píxeles) para ajustar automáticamente el 
sensor de imagen.
Execute: ejecuta la función.

[Nota]
Coloque siempre la tapa del objetivo antes de 
ejecutar APR.

Technical >Camera Battery Alarm
Configura los ajustes de la alarma de tensión baja en la batería.

Elemento Ajuste de subelementos Descripción

Low Battery 5% / 10% / 15% / … / 45% / 50% Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
tensión baja en la batería (saltos de 5%).

Battery 
Empty

De 3% a 7% Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
batería agotada.
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Technical >Camera DC IN Alarm
Configura los ajustes de la alarma de tensión de entrada.

Elemento Ajuste de subelementos Descripción

DC Low 
Voltage1

De 16.0V a 19.0V (16.5V) Ajusta la tensión a partir de la cual se 
mostrará una alarma de tensión de 
entrada DC IN baja.

DC Low 
Voltage2

De 15.5V a 18.5V Ajusta la tensión a partir de la cual se 
mostrará una alarma de tensión de 
entrada DC IN insuficiente.
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Menú Network
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Network >Access Authentication
Configura los ajustes relacionados con la autenticación.

Elemento Ajuste de subelementos Descripción

User Name Establece el nombre del usuario para la 
autenticación de acceso.

Password Establece la contraseña para la 
autenticación de acceso.

Network >Wireless LAN
Establece la configuración relacionada con las conexiones LAN inalámbricas.

Elemento Ajuste de subelementos Descripción

Setting Access Point Mode / Station Mode / Off Selecciona el modo de funcionamiento 
de la conexión LAN inalámbrica.

WPS Execute / Cancel Establece una conexión mediante WPS 
(Wi-Fi Protected Setup).
Execute: ejecuta la función.

NFC Execute / Cancel Establece una conexión mediante NFC 
(comunicación de campo cercano).
Execute: ejecuta la función.

MAC Address Muestra la dirección MAC de la interfaz 
LAN inalámbrica de la videocámara.

Network >AP Mode Settings
Establece la configuración relacionada con las conexiones de modo de punto de acceso.

Elemento Ajuste de subelementos Descripción

Channel Auto(5GHz) / Auto / CH1 / CH2 /  
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

Establece el canal de LAN inalámbrica.
Auto(5GHz) solo está disponible en la 
ILME-FX6V/VK.

Camera SSID 
& Password

Muestra el SSID y la contraseña de la 
videocámara.

Regenerate 
Password

Execute / Cancel Crea una nueva contraseña.
Execute: ejecuta la función.

IP Address Muestra la dirección IP de la videocámara 
en el modo de punto de acceso.

Subnet Mask Muestra la máscara de subred de la 
videocámara en el modo de punto de 
acceso.

Network >ST Mode Settings
Establece la configuración relacionada con las conexiones de modo de estación.

Elemento Ajuste de subelementos Descripción

Camera 
Remote 
Control

Enable / Disable Establece si se habilita el control remoto 
desde un dispositivo conectado a la 
videocámara mediante LAN inalámbrica 
en el modo de estación.

Connected 
Network

Muestra la red LAN inalámbrica 
conectada (punto de acceso).

SSID Muestra el SSID del punto de acceso que 
se va a conectar.

Security Muestra el tipo de seguridad del punto 
de acceso que se va a conectar.

Password Muestra la contraseña del punto de 
acceso que se va a conectar.
Cuando Security está ajustada en WEP o 

WPA: *******
Cuando Security está ajustada en None: 

(en blanco)

DHCP Muestra si DHCP está activado/
desactivado.

IP Address Muestra la dirección IP de la videocámara 
cuando DHCP está ajustado en Off.

Subnet Mask Muestra la máscara de subred de la 
videocámara cuando DHCP está ajustado 
en Off.

Gateway Muestra la puerta de enlace 
predeterminada de la videocámara 
cuando DHCP está ajustado en Off.

DNS Auto Muestra si la adquisición de DNS está 
activada/desactivada.

Primary DNS Server Muestra el servidor principal de DNS de 
la videocámara cuando DNS Auto está 
ajustado en Off.

Secondary DNS Server Muestra el servidor secundario de DNS 
de la videocámara cuando DNS Auto está 
ajustado en Off.
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Network >ST Mode Settings
Establece la configuración relacionada con las conexiones de modo de estación.

Elemento Ajuste de subelementos Descripción

Scan 
Networks

Detecta las redes LAN inalámbricas 
(puntos de acceso) y muestra una lista.
Seleccione un destino de entre las 
opciones de la lista para la realizar la 
conexión.

SSID Muestra el SSID del punto de acceso que 
se va a conectar.

Security Muestra el tipo de seguridad del punto 
de acceso que se va a conectar.

Password Introduzca la contraseña del punto de 
acceso que se va a conectar.

DHCP 
On / Off

Activa y desactiva DHCP.

IP Address Introduce la dirección IP de la 
videocámara cuando DHCP está ajustado 
en Off.

Subnet Mask Introduce la máscara de subred de la 
videocámara cuando DHCP está ajustado 
en Off.

Gateway Introduce la puerta de enlace 
predeterminada de la videocámara 
cuando DHCP está ajustado en Off.

DNS Auto 
On / Off

Activa y desactiva la adquisición 
automática de DNS.

Primary DNS Server Introduce el servidor principal de DNS de 
la videocámara cuando DNS Auto está 
ajustado en Off.

Secondary DNS Server Introduce el servidor secundario de DNS 
de la videocámara cuando DNS Auto está 
ajustado en Off.

Network >ST Mode Settings
Establece la configuración relacionada con las conexiones de modo de estación.

Elemento Ajuste de subelementos Descripción

Manual 
Register

Registra los ajustes para la conexión 
manual a un punto de acceso.

SSID Introduzca el SSID del punto de acceso 
que se va a conectar.

Security 
None / WEP / WPA

Ajusta el tipo de seguridad del punto de 
acceso que se va a conectar. Seleccione 
WPA si el tipo de seguridad del punto de 
acceso de destino es WPA o WPA2.

Password Introduzca la contraseña del punto de 
acceso que se va a conectar.

DHCP 
On / Off

Activa y desactiva DHCP.

IP Address Introduce la dirección IP de la 
videocámara cuando DHCP está ajustado 
en Off.

Subnet Mask Introduce la máscara de subred de la 
videocámara cuando DHCP está ajustado 
en Off.

Gateway Introduce la puerta de enlace 
predeterminada de la videocámara 
cuando DHCP está ajustado en Off.

DNS Auto 
On / Off

Activa y desactiva la adquisición 
automática de DNS.

Primary DNS Server Introduce el servidor principal de DNS 
cuando DNS Auto está ajustado en Off.

Secondary DNS Server Introduce el servidor secundario de DNS 
cuando DNS Auto está ajustado en Off.
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Network >Wired LAN
Establece la configuración relacionada con las conexiones LAN con cable.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función LAN con 
cable.

Camera 
Remote 
Control

Enable / Disable Establece si se habilita el control remoto 
desde un dispositivo conectado a la 
videocámara mediante LAN con cable.

Detail 
Settings

Configura las propiedades de la conexión 
LAN con cable.

DHCP 
On / Off

Activa y desactiva DHCP.

IP Address Introduce la dirección IP de la 
videocámara cuando DHCP está ajustado 
en Off.

Subnet Mask Introduce la máscara de subred de la 
videocámara cuando DHCP está ajustado 
en Off.

Gateway Introduce la puerta de enlace 
predeterminada de la videocámara 
cuando DHCP está ajustado en Off.

DNS Auto 
On / Off

Activa y desactiva la adquisición 
automática de DNS.

Primary DNS Server Introduce el servidor principal de DNS 
cuando DNS Auto está ajustado en Off.

Secondary DNS Server Introduce el servidor secundario de DNS 
cuando DNS Auto está ajustado en Off.

Network >Modem
Configura los ajustes relacionados con el anclaje USB.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la conexión del 
smartphone.

Camera 
Remote 
Control

Enable / Disable Establece si se permite la conexión para 
el acceso con Content Browser Mobile a 
través de un smartphone.

Device Name Muestra el nombre de dispositivo del 
smartphone.

IP Address Muestra la dirección IP del smartphone.

Subnet Mask Muestra la máscara de subred del 
smartphone.

Network >File Transfer
Configura los ajustes relacionados con la transferencia de archivos.

Elemento Ajuste de subelementos Descripción

Auto Upload 
(Proxy)

On / Off Activa y desactiva la transferencia 
automática de los archivos proxy.

Default 
Upload 
Server

Selecciona el servidor de carga para los 
archivos. El servidor seleccionado aquí se 
convierte en el destino de carga 
automática para los archivos de proxy y 
el destino de carga para los archivos 
desde la pantalla de imágenes en 
miniatura.
Muestra el nombre para mostrar 
configurado en Server Settings del 1 al 3.

Clear 
Completed 
Jobs

Execute / Cancel Borra de la lista los trabajos de 
transferencia finalizados.
Execute: ejecuta la función.

Clear All Jobs Execute / Cancel Borra de la lista todos los trabajos de 
transferencia.
Execute: ejecuta la función.

View Job List Muestra la lista de trabajos de 
transferencia.
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Network >File Transfer
Configura los ajustes relacionados con la transferencia de archivos.

Elemento Ajuste de subelementos Descripción

Server 
Settings1

Display Name Establece el nombre para mostrar que 
aparece en el menú de configuración del 
destino de la transferencia.

Service 
FTP

Muestra el tipo de servidor.

Host Name Establece el nombre de host del servidor 
de destino de la transferencia.

Port (1 a 65535 (21)) Establece el número de puerto del 
servidor de destino de la transferencia.

User Name Establece el nombre del usuario para la 
autenticación de la conexión del servidor 
de destino de la transferencia.

Password Establece la contraseña de autenticación 
de la conexión del servidor de destino de 
la transferencia.

Passive Mode 
On / Off

Activa y desactiva el modo PASV.

Destination Directory Introduzca el nombre del directorio de 
destino de la transferencia.

Using Secure Protocol 
On / Off

Establece si se utiliza (On) o no (Off) la 
transferencia FTP segura (modo FTPS 
explícito: FTPES).

Root Certificate 
Load / Clear / None

Carga un certificado raíz para la 
transferencia FTP segura y borra los 
ajustes.

Root Certificate Status 
Loaded / No Certificate

Muestra el estado de carga del 
certificado raíz para la transferencia FTP 
segura.

Reset 
Execute / Cancel

Restablece los ajustes predeterminados 
de Server Settings.
Execute: ejecuta la función.

Server 
Settings2

Igual que Server Settings1.

Server 
Settings3

Igual que Server Settings1.

Network >Network Reset
Restablece los ajustes de red.

Elemento Ajuste de subelementos Descripción

Reset Execute / Cancel Restablece los ajustes de red.
Execute: ejecuta la función.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Maintenance >Language
Ajusta el idioma de visualización.

Elemento Ajuste de subelementos Descripción

Select Ajusta el idioma de visualización.
SET: Ajustar el lenguaje.

Maintenance >Clock Set
Configura los ajustes del reloj interno.

Elemento Ajuste de subelementos Descripción

Time Zone De UTC – 12:00 a UTC + 14:00 Ajusta la diferencia horaria desde UTC en 
intervalos de 30 minutos.

Date Mode YYMMDD / MMDDYY / DDMMYY Selecciona el formato de visualización de 
la fecha.
YYMMDD: Año, mes, día
MMDDYY: Mes, día, año
DDMMYY: Día, mes, año

12H/24H 12H / 24H Ajusta el formato de visualización del 
reloj.
12H: modo de 12 horas
24H: modo de 24 horas

Date Ajusta la fecha actual.
SET: Ajustar el valor.

Time Ajusta la hora actual.
SET: Ajustar el valor.

Maintenance >All Reset
Restablece los valores predeterminados de fábrica.

Elemento Ajuste de subelementos Descripción

Reset Execute / Cancel Restablece todos los ajustes a los valores 
predeterminados de fábrica.
Execute: ejecuta la función.

[Nota]
El archivo 3D LUT importando con Base Look 
>Import (página 83) en el menú Paint/
Look se eliminará. Puede eliminar todos 
los archivos 3D LUT importados, seleccione 
Base Look >Delete All en el menú Paint/Look 
(página 83).

Reset without 
Network

Execute / Cancel Restablece los ajustes predeterminados 
del menú, con excepción de los ajustes 
del menú Network.

Maintenance >Hours Meter
Muestra el tiempo de ejecución acumulado.

Elemento Ajuste de subelementos Descripción

Hours 
(System)

Muestra el número de horas acumuladas 
de uso (no se puede restablecer).

Hours (Reset) Muestra el número de horas acumuladas 
de uso (se puede restablecer).

Reset Execute / Cancel Restablece la visualización de Hours 
(Reset) a 0.
Execute: ejecuta la función.

Maintenance >Version
Muestra la información de versión.

Elemento Ajuste de subelementos Descripción

Version 
Number

Vx.xx Muestra la versión del software de la 
videocámara.

Version Up Execute / Cancel Actualiza la videocámara.*

Execute: ejecuta la función.
* Esta función actualiza el software de la 

videocámara.

Lens Version 
Number

Vxx Muestra el número de la versión del 
software de un objetivo de montura E.

Menú Maintenance



6. Pantalla de menús y ajustes101

Ajustes y valores predeterminados del menú Shooting

Ajustes y valores predeterminados de Iso/Gain

El rango de ajustes y valores predeterminados de ISO/Gain (página 72) varía en función de la configuración de Mode, Target Display, Base Look >Select y Base Sensitivity. Las opciones disponibles 
aparecen resaltadas en gris.

Cuando Mode está ajustado en ISO

Target Display SDR(BT.709) HDR(HLG) Común para SDR(BT.709) y HDR(HLG)

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live / HLG Natural De User1 a User16

Base Sensitivity Low High Low High Low High

ISO 320 ISO/Gain<L> predeterminado

ISO 400

ISO 500

ISO 640 ISO/Gain<M> predeterminado

ISO 800 ISO/Gain<L> predeterminado ISO/Gain<L> predeterminado

ISO 1000

ISO 1250 ISO/Gain<H> predeterminado

ISO 1600 ISO/Gain<M> predeterminado ISO/Gain<M> predeterminado

ISO 2000

ISO 2500

ISO 3200 ISO/Gain<H> predeterminado ISO/Gain<H> predeterminado

ISO 4000

ISO 5000 ISO/Gain<L> predeterminado

ISO 6400

ISO 8000

ISO 10000 ISO/Gain<M> predeterminado

ISO 12800 ISO/Gain<L> predeterminado ISO/Gain<L> predeterminado

ISO 16000

ISO 20000 ISO/Gain<H> predeterminado

ISO 25600 ISO/Gain<M> predeterminado ISO/Gain<M> predeterminado

ISO 32000

ISO 40000

ISO 51200 ISO/Gain<H> predeterminado ISO/Gain<H> predeterminado

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Cuando Mode está ajustado en dB

Rango de ajuste

–3dB

–2dB

–1dB

0dB ISO/Gain<L> predeterminado

1dB

2dB

3dB

4dB

5dB

6dB ISO/Gain<M> predeterminado

7dB

8dB

9dB

10dB

11dB

12dB ISO/Gain<H> predeterminado

13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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Ajustes y valores predeterminados de AGC Limit

El rango de ajustes y valores predeterminados de AGC Limit (página 73) varía en función de la configuración de Mode, Target Display, Base Look >Select y Base Sensitivity. Las opciones disponibles 
aparecen resaltadas en gris.

Cuando Mode está ajustado en ISO

Target Display SDR(BT.709) HDR(HLG) HDR(HLG) Común para SDR(BT.709) y HDR(HLG)

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live HLG Natural De User1 a User16

Base Sensitivity Low High Low High Low High Low High

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000 Predeterminado

ISO 2500

ISO 3200

ISO 4000

ISO 5000 Predeterminado Predeterminado Predeterminado

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000 Predeterminado

ISO 40000

ISO 51200

ISO 64000

ISO 80000 Predeterminado Predeterminado Predeterminado

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Cuando Mode está ajustado en dB

Rango de ajuste

3dB

6dB

9dB

12dB

15dB Predeterminado

18dB

21dB

24dB

27dB

30dB
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Ajustes de calidad de imagen guardados para cada modo de filmación
El estado actual de los elementos de configuración relacionados con la calidad de la imagen se guarda para cada uno de los siguientes modos de filmación (página 24). Cuando se cambia el 
modo de filmación disparo, los ajustes correspondientes que se guardan se aplican al modo de filmación de objetivo.
ˎˎ Modo Custom SDR(BT.709)
ˎˎ Modo Custom HDR(HLG)
ˎˎ Modo Cine EI

A continuación se muestran los elementos de configuración relacionados con la calidad de la imagen que se guardan para cada modo de filmación.
Sí: el elemento se guarda.
No: el elemento no se guarda.

Elemento de configuración Modo de disparo

Modo Custom Modo Cine EI

SDR(BT.709) HDR(HLG)

Menú Shooting ISO/Gain/EI ISO/Gain Sí1) No

Exposure Index No Sí

Base Sensitivity Sí No

Base ISO No Sí

White Preset White Sí Sí

Distinto de lo anterior Sí

White Setting Sí

Offset White Sí No

LUT On/Off No Sí

Noise Suppression Setting(Custom) Sí Sí No

Level(Custom) Sí Sí No

Setting(Cine EI) No Sí

Level(Cine EI) No Sí

Menú Paint/Look Base Look Select Sí Sí Sí

Input2) Sí

Output2) Sí

AE Level Offset2) Sí

Black Sí Sí No

Knee Auto Knee Sí No No

Distinto de lo anterior Sí Sí No

Detail Sí Sí No

Matrix Sí Sí No

Multi Matrix Sí Sí No

1) Se guardan ajustes de sensibilidad ISO separados para los modos Custom SDR(BT.709) y HDR(HLG).
2) Los ajustes se guardan para cada Base Look y no dependen del modo de filmación.
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Datos de configuración

Puede guardar la configuración del menú 
completo en una tarjeta de memoria insertada 
en una ranura para tarjetas CFexpress Tipo 
A/SD (B). Le permitirá cargar rápidamente el 
conjunto de ajustes de menú apropiado para 
la situación actual.
Los datos de configuración se guardan en las 
categorías siguientes.

Archivos de usuario
Los archivos de usuario guardan los 
elementos de configuración del menú User 
personalizable.
Puede guardar hasta 64 archivos en una 
tarjeta de memoria.
Si carga este archivo en la memoria de 
la videocámara, puede personalizar la 
configuración del menú User.

Archivos ALL (todos los ajustes)
Los archivos ALL guardan los datos de 
configuración de todos los menús. Puede 
guardar hasta 64 archivos en una tarjeta de 
memoria.

[Nota]
Los datos específicos del dispositivo (sombreado, 
niveles de emisión y otros datos que requieran ajustes 
para el dispositivo en concreto) no se guardarán.

Guardar un archivo de usuario/un 
archivo ALL

1 Introduzca una tarjeta de memoria en una 
ranura para tarjetas CFexpress Tipo A/SD 
(B) (página 6).
ˎˎ En las tarjetas CFexpress, la etiqueta 
mira hacia la izquierda.
ˎˎ En las tarjetas SD, la etiqueta mira hacia 
la derecha con la esquina biselada en la 
parte inferior.

2 Para un archivo de usuario, seleccione 
User File >Save Media(B) (página 82) 
>Execute en el menú Project del menú 
completo.
Para un archivo ALL, seleccione All File 
>Save Media(B) (página 82) >Execute 
en el menú Project del menú completo.
Aparecerá una pantalla de destino de 
almacenamiento del archivo.

3 Seleccione una fila “No File” en la pantalla 
de destino de almacenamiento.
Si selecciona una fila con una entrada de 
File ID, se sobrescribirá el archivo 
seleccionado.
File ID se genera automáticamente, pero 
puede modificarla.

4 Seleccione Execute en la pantalla de 
confirmación.

Cargar un archivo de usuario/un 
archivo ALL

1 Introduzca la tarjeta de memoria en la 
que esté guardado un archivo en una 
ranura para tarjetas CFexpress Tipo A/SD 
(B) (página 6).
ˎˎ En las tarjetas CFexpress, la etiqueta 
mira hacia la izquierda.
ˎˎ En las tarjetas SD, la etiqueta mira hacia 
la derecha con la esquina biselada en la 
parte inferior.

2 Para un archivo de usuario, seleccione 
User File >Load Media(B) (página 82) 
>Execute en el menú Project del menú 
completo.
Para un archivo ALL, seleccione All File 
>Load Media(B) (página 82) >Execute 
en el menú Project del menú completo.
Aparecerá una pantalla con la lista de 
archivos.

3 Seleccione un archivo para cargar.
Aparece una pantalla de confirmación.

4 Seleccione Execute.

[Notas]
ˎˎ La unidad se reiniciará automáticamente después de 

cargar los datos de configuración.
ˎˎ Cuando All File >Load Network Data, en el menú 

Project del menú completo, está ajustado en Off, se 
cargan todos los ajustes del archivo ALL, salvo los 
ajustes del menú Network.

Cambio del File ID

1 Para un archivo de usuario, seleccione 
User File >File ID (página 82) en el 
menú Project del menú completo.
Para un archivo ALL, seleccione All File 
>File ID (página 82) en el menú Project 
del menú completo.
Aparecerá una pantalla para editar File ID.

2 Seleccione un carácter con el selector 
múltiple (página 7) o el dial 
multifunción (página 5) y, a 
continuación, presione el botón de aplicar 
del selector múltiple o el dial 
multifunción.

3 Repita el paso 2 según sea necesario.

4 Al terminar de introducir los caracteres, 
seleccione Done.

Guardar y cargar datos de configuración
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Conexión de dispositivos de grabación y monitores externos
Para mostrar imágenes de grabación 
o reproducción en un monitor externo, 
seleccione la señal de salida de la 
videocámara y utilice un cable adecuado para 
conectar el monitor.
También puede conectar dispositivos de 
grabación, como una videograbadora y grabar 
la señal de salida desde la videocámara.
Puede mostrar la misma información que 
aparece en el visor, como por ejemplo, 
la información de estado y los menús, 
en un monitor externo. Ajuste Info. Disp. 
(página 14) en la pantalla Monitoring Status 
u Output Display (página 87) en el menú 
Monitoring del menú completo en On según 
la señal que se enviará al monitor.

Conector SDI OUT (tipo BNC)

Configure la activación/desactivación de la 
salida y el formato de salida desde el menú 
Monitoring (página 87).
Utilice un cable coaxial de 75 Ω disponible en 
el mercado para realizar la conexión.

[Nota]
Compruebe que la conexión entre la videocámara y el 
dispositivo externo está conectada a tierra antes de 
encender los dispositivos.

(Se recomienda que la videocámara y el 
dispositivo externo se enciendan después de 
conectar el cable coaxial de 75 Ω).
Si el dispositivo externo se debe conectar a la 
videocámara mientras este está encendido, 
conecte primero el cable coaxial de 75 Ω 
al dispositivo externo y, a continuación, 
conéctelo a la videocámara.

Para iniciar una grabación en la 
videocámara y en el dispositivo externo 
simultáneamente

Con la salida de señal SDI habilitada, ajuste 
SDI/HDMI Rec Control (página 79) >Setting 
en el menú Project del menú completo en 
SDI/HDMI Remote I/F o Parallel Rec para 
habilitar la salida de una señal de activación 
REC hacia el dispositivo externo conectado 
en el conector SDI OUT. Esto sincronizará la 
grabación en el dispositivo externo con la 
videocámara.

[Notas]
ˎˎ Si el dispositivo externo conectado no es compatible 

con la señal de activación REC, el dispositivo no se 
podrá utilizar.
ˎˎ Solo se emite la señal de activación REC cuando no 

hay ningún soporte insertado en ese momento.

Conector HDMI OUT (conector tipo A)

Configure la activación/desactivación de 
la salida y el formato de salida en el menú 
Monitoring (página 87) del menú completo.

Para iniciar una grabación en la 
videocámara y en el dispositivo externo 
simultáneamente

Con la salida de señal HDMI habilitada, ajuste 
HDMI TC Out >Setting (página 85) en el 
menú TC/Media del menú completo en On y 
SDI/HDMI Rec Control >Setting (página 79) 
en el menú Project en SDI/HDMI Remote I/F 
o Parallel Rec para habilitar la salida de una 
señal de activación REC hacia el dispositivo 
externo conectado en el conector HDMI OUT. 
Esto sincronizará la grabación en el dispositivo 
externo con la videocámara.
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Sincronización de los códigos de tiempo
Puede sincronizar el código de tiempo de la 
unidad con otros dispositivos.

Bloqueo del código de tiempo en 
otros dispositivos

Ajuste la unidad que proporciona el código 
de tiempo en un modo en el que la salida 
del código de tiempo siga funcionando (por 
ejemplo, Free Run o Clock).

1 Ajuste Timecode (página 85) en el 
menú TC/Media del menú completo de la 
siguiente manera:
Mode: Preset
Run: Free Run

2 Pulse el botón asignable (página 48) 
correspondiente a la función DURATION/
TC/U-BIT para mostrar los códigos de 
tiempo en la pantalla.

3 Compruebe que el interruptor de 
selección IN/OUT (página 4) esté en la 
posición IN y, a continuación, suministre 
un código de tiempo de referencia para 
sincronizar la frecuencia del sistema de la 
videocámara al conector TC IN/TC OUT.

El generador de códigos de tiempo de la 
videocámara se bloqueará con el código de 
tiempo de referencia y “EXT-LK” aparecerá en 
la pantalla.
Después de que hayan transcurrido diez 
segundos desde el bloqueo del código de 
tiempo, el estado de bloqueo externo se 
mantendrá incluso si se desconecta la fuente 
externa de códigos de tiempo.

[Notas]
ˎˎ Cuando se utiliza el bloqueo externo, el código de 

tiempo obtendrá el bloqueo con el código de tiempo 
externo de forma instantánea y el valor de este 
código de tiempo externo aparecerá en el área de 
visualización de datos. Sin embargo, no comience a 
grabar inmediatamente. Espere unos segundos antes 
de comenzar a grabar hasta que el generador de 
sincronización se estabilice.
ˎˎ Si la frecuencia del código de tiempo de referencia 

y la frecuencia de fotogramas de la videocámara 
no son iguales, no se podrá conseguir un bloqueo 
y la videocámara no funcionará correctamente. Si 
esto ocurre, el código de tiempo no conseguirá un 
bloqueo correcto con el código de tiempo externo.
ˎˎ Es posible que el código de tiempo cambie un 

fotograma por hora con respecto al código de tiempo 
de referencia.

Para liberar el bloqueo externo

Cambie el ajuste Timecode en el menú TC/
Media del menú completo o apague la 
videocámara.
La sincronización externa también se libera si 
se cambia la frecuencia del sistema y cuando 
comienza a grabar en un modo de grabación 
especial (Slow & Quick Motion o Interval Rec).

Sincronización del código de 
tiempo de otro dispositivo con el 
código de tiempo de la 
videocámara

Ajuste la unidad que proporciona el código 
de tiempo en un modo en el que la salida 
del código de tiempo siga funcionando (por 
ejemplo, Free Run o Clock).

1 Ajuste el código de tiempo de la 
videocámara mediante Timecode 
(página 85) en el menú TC/Media del 
menú completo.

2 Compruebe que el interruptor de 
selección TC IN/OUT (página 4) esté 
ajustado en la posición OUT y conecte el 
conector TC IN/TC OUT al conector de 
entrada de código de tiempo del 
dispositivo que desea sincronizar.
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Gestión/Edición de clips con un ordenador

Conexión con un cable USB

Uso de un lector de tarjetas (opcional)

Conecte un lector de tarjetas CFexpress o un 
lector de tarjetas SD a un ordenador mediante 
un cable USB e introduzca una tarjeta de 
memoria en la ranura del lector de tarjetas. 
La tarjeta de memoria se reconocerá como 
una unidad de extensión del ordenador. En 
ordenadores compatibles, puede importar 
clips a alta velocidad utilizando el modo de 
almacenamiento masivo de la videocámara.

Uso del modo de almacenamiento 
masivo

[Nota]
El modo de almacenamiento masivo no se puede 
utilizar cuando Modem >Setting está ajustado en On en 
el menú Network del menú completo o cuando Wired 
LAN >Setting está ajustado en On en el menú Network. 
Ajuste ambos en Off.

Conecte la videocámara con un cable USB e 
inserte una tarjeta de memoria en la ranura 
para tarjeta A o B. La tarjeta de memoria se 
reconoce como una unidad de extensión de 
ordenador.

1 Conecte el conector USB-C (página 7) 
o el conector USB/múltiple (página 7) 
al ordenador con un cable USB.

2 Sitúe el interruptor POWER de la 
videocámara en la posición ON.
En la pantalla del visor aparecerá un 
mensaje que le preguntará si desea 
habilitar la conexión USB.

 [Nota]
El mensaje de confirmación de la conexión USB 
no se muestra si en esos momentos aparece otro 
mensaje de confirmación o de proceso en curso, 
por ejemplo, cuando se formatea o se restaura un 
tarjeta de memoria.
El mensaje de confirmación se mostrará cuando 
finalice el formateo o la restauración. El mensaje de 
confirmación de USB tampoco se muestra mientras 
aparece la pantalla de propiedades del clip. El 
mensaje se mostrará cuando el procesamiento 
finalice o cuando vuelva a la pantalla de imágenes 
en miniatura.

3 Gire el dial multifunción para seleccionar 
Execute.

4 En Windows, compruebe que la tarjeta se 
ha añadido como un disco extraíble en la 
ventana “Mi Equipo”.
En Mac, compruebe que se crea una 
carpeta “NO NAME” o “Untitled” (editable) 
en el escritorio.

[Notas]
ˎˎ No realice las siguientes operaciones si el indicador 

de acceso se ilumina en rojo.
 – Apagado o desconexión del cable de alimentación
 – Extraer la tarjeta de memoria
 – Desconectar el cable USB

ˎˎ No se garantiza el funcionamiento en todos los 
ordenadores.

Uso de un sistema de edición no 
lineal

En un sistema de edición no lineal, es 
necesario disponer de software de edición 
(opcional) que sea compatible con los 
formatos grabados por la videocámara.
Utilice el software específico de aplicaciones 
para guardar previamente los clips que desee 
editar en el disco duro del ordenador.
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Precauciones de uso
Acerca de la condensación

Si la unidad se lleva de repente de un lugar 
frío a uno cálido o si la temperatura ambiente 
sufre un aumento repentino, es posible que 
se acumule humedad en la superficie exterior 
o interior de la unidad. Este fenómeno se 
conoce como condensación. Si se produce 
condensación, apague la unidad y espere a 
que se evapore antes de ponerla en marcha. 
No la utilice en ese estado, ya que podría 
dañarla.

Acerca de los paneles LCD

El panel LCD de esta unidad ha sido fabricado 
con tecnología de alta precisión y ofrece 
un índice de píxeles funcionales de al 
menos el 99,99%. Por ello, es posible que 
quede una pequeña proporción de píxeles 
“atascados”, o bien siempre apagados 
(negro), siempre encendidos (rojo, verde o 
azul), o parpadeando. Además, a lo largo 
de un amplio periodo de tiempo, esos 
píxeles “atascados” pueden ir apareciendo 
espontáneamente debido a las características 
de la pantalla de cristal líquido. Esto no 
significa que la unidad funcione mal. Tenga 
en cuenta que dichos problemas no producen 
efectos en los datos grabados.

Fenómenos del sensor de imagen CMOS 
de la cámara

[Nota]
Los siguientes fenómenos que podrían producirse en 
las imágenes están relacionados con los sensores de 
imagen. No indican que exista una avería.

Motas blancas
Aunque los sensores de imágenes se fabrican 
con tecnologías de alta precisión, es posible 
que se generen pequeñas motas blancas en 
la pantalla en casos excepcionales producidas 
por rayos cósmicos, etc.
Están relacionadas con el principio de los 
sensores de imágenes y no se trata de una 
avería.
Las motas blancas suelen verse especialmente 
en las siguientes situaciones:
ˎˎ Cuando la unidad se utiliza bajo una 
temperatura medioambiental alta

ˎˎ Cuando ha aumentado la ganancia 
(sensibilidad)

Parpadeo
Si captura imágenes bajo la luz producida por 
lámparas fluorescentes, lámparas de sodio, 
lámparas de vapor de mercurio o LED, es 
posible que la pantalla parpadee o que los 
colores varíen.

Acerca de los consumibles

ˎˎ El ventilador y la batería son consumibles 
que deben sustituirse periódicamente.  
Si utiliza la unidad a temperatura ambiente, 
el ciclo de sustitución normal será de 5 
años aproximadamente. Sin embargo, esto 
representa solo una directriz general y no 
constituye ninguna garantía de su vida útil. 
Para obtener más información acerca de la 
sustitución de componentes, póngase en 
contacto con el distribuidor.
ˎˎ La vida útil del adaptador de CA y del 
condensador electrolítico es de unos 5 años 
con las temperaturas de funcionamiento 
habituales y un uso normal (8 horas al 
día, 25 días al mes). Si el uso supera la 
frecuencia normal indicada, es posible que 
la vida útil se vea reducida.
ˎˎ La terminal de la batería de esta unidad 
(el conector para paquetes de pilas 
y adaptadores de CA) es una parte 
consumible.  
Puede que la unidad no funcione 
correctamente si los contactos de las pilas 
están doblados o deformados debido a 
algún golpe o a vibraciones o si se han 
corroído debido a un uso prolongado en el 
exterior.  
Se recomienda realizar inspecciones 
periódicas para que la unidad continúe 
funcionando correctamente y para 
prolongar su vida útil. Contacte con el 
servicio de asistencia técnica de Sony o con 
el responsable de ventas para obtener más 
información sobre las inspecciones.

Acerca de la batería recargable incorporada

El camcorder dispone de una batería 
recargable incorporada que almacena la fecha, 
la hora y otros ajustes incluso cuando está 
apagado. La batería recargable incorporada 
estará cargada a las 24 horas de conectarse 
la unidad a una toma de corriente con el 
adaptador de CA o si se coloca una batería 
completamente cargada, independientemente 
de que el camcorder esté encendido o 
apagado. La batería recargable tardará 
aproximadamente 2 meses en descargarse 
por completo si no se conecta el adaptador 
de CA o si se utiliza el camcorder sin la 
batería. Cargue la batería antes de utilizar el 
camcorder. Sin embargo, incluso si la batería 
recargable no está cargada, el funcionamiento 
de la videocámara no se verá afectado 
siempre que no necesite registrar la fecha.

Uso y ubicaciones de almacenamiento

Guarde la unidad en un lugar llano y ventilado.
Evite utilizar o guardar la unidad en los 
siguientes lugares.
ˎˎ En entornos excesivamente calientes o fríos 
(rango de temperatura de funcionamiento: 
de 0 °C a 40 °C)  
Recuerde que, en verano, en climas cálidos, 
la temperatura dentro de un coche con las 
ventanas subidas puede superar fácilmente 
los 50 °C.
ˎˎ En lugares húmedos o con polvo. Lugares 
donde la unidad pueda quedar expuesta a 
la lluvia
ˎˎ Lugares susceptibles de recibir vibraciones 
fuertes
ˎˎ Cerca de campos magnéticos potentes
ˎˎ Cerca de transmisores de radio o televisión 
que generen campos electromagnéticos 
potentes.
ˎˎ En contacto directo con la luz sola o 
cerca de calefactores durante periodos 
prolongados

Nota sobre los rayos láser

Los rayos láser pueden dañar el sensor de 
imagen CMOS. Si filma una escena que 
incluya un rayo láser, evite que este se 
dirija directamente al objetivo de la unidad. 
Específicamente, los rayos láser de alta 
potencia procedentes de los dispositivos 
médicos o de otros dispositivos podrían 
causar daños debido a los efectos de la luz 
reflejada y la luz dispersa.

Cómo evitar interferencias 
electromagnéticas procedentes de 
dispositivos de comunicación portátiles

El uso de teléfonos móviles y otros 
dispositivos de comunicación cerca 
de la cámara puede producir averías e 
interferencias con las señales de audio y 
vídeo. Es recomendable que los dispositivos 
de comunicación portátiles que se encuentren 
cerca de la cámara estén apagados.

Precauciones de seguridad

ˎˎ SONY NO SE HACE RESPONSABLE POR 
DAÑOS DE NINGÚN TIPO DEBIDOS A LA 
OMISIÓN DE LAS MEDIDAS DE SEGURIDAD 
ADECUADAS EN DISPOSITIVOS DE 
TRANSMISIÓN, FUGAS DE DATOS INEVITABLES 
DERIVADAS DE LAS ESPECIFICACIONES DE 
TRANSMISIÓN O PROBLEMAS DE SEGURIDAD 
DE CUALQUIER TIPO.
ˎˎ En función del entorno operativo, es posible 
que terceros no autorizados en la red 
puedan acceder a la unidad. Al conectar la 
unidad a la red, confirme siempre que la red 
está correctamente protegida.
ˎˎ Es posible que terceros no autorizados 
situados cerca de las señales puedan 
interceptar sin saberlo contenidos de la 
comunicación. Al utilizar la comunicación 
LAN inalámbrica, aplique medidas de 
seguridad para proteger los contenidos de 
la comunicación.
ˎˎ Cuando conecte este producto a una red, 
conéctelo mediante un sistema con función 
de protección como, por ejemplo, un 
router o un firewall. Si se conecta sin dicha 
protección, pueden producirse problemas 
de seguridad.
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Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 1920×1080P (Level 
A)).

[Notas]
ˎˎ La resolución del formato de salida está limitada por la configuración de Rec Format >Frequency, Video Format y 

Codec en el menú Project del menú completo (página 77).
ˎˎ La resolución del formato de salida está limitada por la combinación con la velocidad de fotogramas a cámara 

lenta y rápida. La salida HDMI cambia a Full HD si en el menú completo se cumplen las siguientes condiciones:
 – Rec Format >Video Format está ajustado en 4096×2160 o 3840×2160 en el menú Project.
 – S&Q Motion >Setting en el menú Shooting está ajustado en On.
 – S&Q Motion >Frame Rate en el menú Shooting es superior a 60fps.
 – Rec Format >Codec en el menú Project está ajustado en RAW o RAW & XAVC-I, o bien Output On/Off >SDI en el 

menú Monitoring está ajustado en On.
ˎˎ Cuando la salida HDMI se ajusta en 4096×2160P o 3840×2160P, esta cambia a 1920×1080P si se cumplen las 

condiciones anteriores. Cuando ocurre esto, las opciones de selección de salida HDMI 4096×2160P y 3840×2160P 
para Output Format >SDI/HDMI (página 87) en el menú Monitoring aparecen atenuadas y no se pueden 
seleccionar.
ˎˎ Si la resolución de la salida de vídeo es mayor que la resolución de la imagen, no se emite ninguna imagen 

reproducida.

Formatos de salida del conector SDI OUT/HDMI OUT

Frecuencia del 
sistema 
(Rec Format 
>Frequency en el 
menú Project)

Formato de vídeo 
(Rec Format 
>Video Format en 
el menú Project)

Estado de la salida 
RAW
(Rec Format 
>Codec en el 
menú Project)

Formato de salida (Output Format en el 
menú Monitoring)

SDI HDMI

59.94/50 4096×2160 Con salida RAW – 4096×2160P

1920×1080P

1920×1080i

3840×2160P

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080i

Frecuencia del 
sistema 
(Rec Format 
>Frequency en el 
menú Project)

Formato de vídeo 
(Rec Format 
>Video Format en 
el menú Project)

Estado de la salida 
RAW
(Rec Format 
>Codec en el 
menú Project)

Formato de salida (Output Format en el 
menú Monitoring)

SDI HDMI

Sin salida RAW 4096×2160P 4096×2160P

1920×1080P

1920×1080i

3840×2160P 3840×2160P

1920×1080P

1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080i

1920×1080P  
(Level B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

3840×2160 Con salida RAW – 3840×2160P

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080i

Sin salida RAW 3840×2160P 3840×2160P

1920×1080P

1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080i

1920×1080P  
(Level B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

Limitaciones y formatos de salida
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Frecuencia del 
sistema 
(Rec Format 
>Frequency en el 
menú Project)

Formato de vídeo 
(Rec Format 
>Video Format en 
el menú Project)

Estado de la salida 
RAW
(Rec Format 
>Codec en el 
menú Project)

Formato de salida (Output Format en el 
menú Monitoring)

SDI HDMI

1920×1080 Sin salida RAW 1920×1080P 
(Level A)

1920×1080P

1920×1080i

1920×1080P  
(Level B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

– 59.94: 720×480P
50: 720×576P

29.97/25 4096×2160 Con salida RAW – 4096×2160P

1920×1080P

3840×2160P

1920×1080P

1920×1080P

1920×1080i

Sin salida RAW 4096×2160P 4096×2160P

1920×1080P

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

3840×2160 Con salida RAW – 3840×2160P

1920×1080P

1920×1080P

1920×1080i

Sin salida RAW 3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

1920×1080 Sin salida RAW 1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

Frecuencia del 
sistema 
(Rec Format 
>Frequency en el 
menú Project)

Formato de vídeo 
(Rec Format 
>Video Format en 
el menú Project)

Estado de la salida 
RAW
(Rec Format 
>Codec en el 
menú Project)

Formato de salida (Output Format en el 
menú Monitoring)

SDI HDMI

24 4096×2160 Con salida RAW – 4096×2160P

1920×1080P

Sin salida RAW 4096×2160P 4096×2160P

1920×1080P 1920×1080P

23.98 4096×2160 Con salida RAW – 4096×2160P

1920×1080P

3840×2160P

1920×1080P

1920×1080P

Sin salida RAW 4096×2160P 4096×2160P

1920×1080P

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

3840×2160 Con salida RAW – 3840×2160P

1920×1080P

1920×1080P

Sin salida RAW 3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080 Sin salida RAW 1920×1080P 1920×1080P
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Fuente de alimentación

Síntoma Causa Solución

La videocámara no se 
enciende.

La batería no está colocada y 
no se está suministrando 
alimentación al conector DC 
IN.

Coloque una batería (página 17) o 
conecte la videocámara a la 
alimentación de CA con un adaptador 
de CA (página 18).

La batería está 
completamente agotada.

Sustituya la batería por una batería 
cargada por completo (página 17).

El suministro de 
alimentación se corta 
durante el funcionamiento.

La batería se agota por 
completo.

Sustituya la batería por una batería 
cargada por completo (página 17).

La batería se agota muy 
rápido.

La temperatura ambiente es 
muy baja.

Esto se debe a las características de la 
batería y no es un defecto.

No se ha cambiado la batería 
de forma adecuada.

Sustituya la batería (página 17).
Si la batería se agota pronto, incluso 
después de haberla cargado por 
completo, es posible que haya llegado 
al final de su vida útil. Sustitúyala por 
una nueva.

Grabación/reproducción

Síntoma Causa Solución

La grabación no comienza al 
pulsar el botón START/STOP.

La tarjeta de memoria está 
llena.

Sustituya la tarjeta de memoria por otra 
con espacio suficiente.

Es necesario restablecer la 
tarjeta de memoria.

Restaure la tarjeta de memoria 
(página 33).

No se puede grabar audio. Los diales AUDIO LEVEL 
(CH1/CH2) están establecidos 
al nivel mínimo.

Ajuste los niveles de grabación de 
audio con los diales AUDIO LEVEL (CH1/
CH2) (página 46).

El sonido grabado está 
distorsionado.

El nivel de audio es 
demasiado alto.

Ajuste los niveles de grabación de 
audio con los diales AUDIO LEVEL (CH1/
CH2) (página 46).

Síntoma Causa Solución

El sonido grabado tiene un 
alto nivel de ruido.

El nivel de audio es 
demasiado bajo.

Ajuste los niveles de grabación de 
audio con los diales AUDIO LEVEL (CH1/
CH2) (página 46).
Cuando se selecciona un micrófono 
externo, ajuste también la 
configuración de referencia INPUT MIC 
en Audio Input en el menú Audio 
(página 90).

No se pueden reproducir los 
clips.

Se está editando el clip. No se pueden reproducir los clips si ha 
modificado los nombres o las carpetas 
de archivo o si el clip se está utilizando 
en un ordenador. No se trata de un fallo 
de funcionamiento.

Se está grabando el clip en 
otro dispositivo.

Los clips grabados en otros dispositivos 
pueden no reproducirse o mostrarse en 
un tamaño incorrecto. No se trata de un 
fallo de funcionamiento.

Dispositivos externos

Síntoma Solución

El ordenador no reconoce la 
videocámara.

Desconecte el cable USB del ordenador y vuelva a conectarlo de 
forma segura.

Desconecte el cable USB del ordenador, reinícielo y vuelva a seguir 
los pasos en el orden correcto.

Conecte el ordenador y la videocámara insertando un cable USB 
en el conector USB-C o el conector USB/múltiple.

No se pueden cargar los clips en 
el ordenador.

Desconecte el cable USB del ordenador, reinicie la videocámara y 
vuelva a conectarlo.

Debe instalarse el software de aplicación para cargar los clips en 
su ordenador (página 109).

Resolución de problemas
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Conexión LAN inalámbrica

[Nota]
Las obstrucciones y la interferencia electromagnética entre la videocámara y el punto de acceso de LAN inalámbrico 
o el dispositivo del terminal, o bien el entorno ambiental (tal como los materiales de la pared) podrían acortar el 
rango de comunicación o impedir las conexiones por completo. Si experimenta estos problemas, verifique el estado 
de conexión/comunicación tras mover la videocámara a una nueva ubicación o tras acercarla al punto de acceso/
dispositivo del terminal.

Síntoma Solución

El dispositivo del terminal no 
puede acceder a la videocámara.

 ˎ Compruebe la conexión LAN inalámbrica (dirección IP, etc.).
 ˎ Es posible que el ajuste de comunicación entre el punto de 
acceso y el cliente no sea válido. Para obtener más información, 
remítase a las instrucciones de funcionamiento del punto de 
acceso.

No puede iniciar sesión en la 
videocámara.

Compruebe el nombre de usuario y la contraseña establecidos.

Conexión a Internet

Síntoma Solución

Fallo al cargar un archivo. Es posible que el nombre de usuario y la contraseña del servidor 
no sean correctos.
Introduzca el nombre de usuario y la contraseña correctos.

La carga de archivos no está 
disponible.

Es posible que las condiciones de la señal sean deficientes.
Desplácese a otra ubicación e inténtelo de nuevo.

Al usar el Filtro ND

Síntoma Solución

El filtro ND no se mueve. Puede mover manualmente el filtro a la posición Clear mediante el 
siguiente procedimiento.

1 Gire el interruptor POWER de la videocámara hasta la posición OFF.

2 Retire la tapa redonda de la parte inferior.

3 Introduzca un destornillador en el orificio y gírelo en el sentido contrario a las agujas del 
reloj.
ˎˎ Para mover el filtro ND hasta la posición Clear, gírelo en el sentido contrario a las agujas del 
reloj. Siga girándolo hasta llegar a la posición Clear.
ˎˎ Utilice un destornillador de ø2,4 mm de diámetro o menos. La profundidad de inserción del 
destornillador es de unos 3,0 cm.

Orificio para el destornillador
(con la tapa quitada)

4 Ajuste el interruptor ND PRESET/VARIABLE (página 5) a la posición PRESET, y ajuste los 
botones arriba/abajo de ND FILTER POSITION (página 5) a la posición CLEAR.

[Notas]
ˎˎ No utilice el procedimiento anterior durante el funcionamiento normal. Solo debe utilizar este procedimiento si no 

puede mover el filtro ND. El filtro ND puede sufrir daños si se utiliza este procedimiento durante el funcionamiento 
normal.
ˎˎ Después de utilizar el procedimiento anterior, consulte a un centro de servicio de Sony para que le reparen la 

videocámara.
ˎˎ Aunque siga apareciendo un mensaje de error después de realizar el procedimiento anterior, podrá filmar.
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Si en la videocámara se produce una condición de funcionamiento, precaución o advertencia 
que requiera confirmación, en el visor aparecerá un mensaje, la lámpara indicadora/indicador de 
grabación comenzará a parpadear y sonará un pitido de advertencia.
El pitido de advertencia se emite desde los auriculares conectados a la toma de auriculares.

Mensajes de error

El camcorder dejará de funcionar cuando se visualicen los siguientes mensajes.

Mensaje del visor Sonido de 
advertencia

Lámpara 
indicadora/
indicador de 
grabación

Causa y solución

E + Código de error Continuo Parpadeo 
rápido

Indica una anomalía en el camcorder. La 
grabación se detiene, incluso si REC se muestra 
en el visor.
Apague el camcorder y compruebe si existe algún 
problema con los dispositivos, cables o soportes 
conectados. Si el error continúa cuando el 
camcorder se vuelve a encender, póngase en 
contacto con el servicio de asistencia técnica de 
Sony.
(Si el camcorder no se apaga cuando el interruptor 
POWER se ajusta en OFF, extraiga la batería o 
desconecte la alimentación DC IN).
Es posible que no aparezca una pantalla de error 
o un sonido de advertencia dependiendo del 
estado de la videocámara.

Mensajes de advertencia

Siga las instrucciones proporcionadas si se muestran los siguientes mensajes.

Mensaje del visor Sonido de 
advertencia

Lámpara 
indicadora/
indicador de 
grabación

Causa y solución

Battery Near End Intermitente Parpadeo La capacidad restante de la batería se está 
agotando.
Recárguela en cuanto pueda.

Battery End Continuo Parpadeo 
rápido

La batería está agotada. La grabación se detiene.
Detenga el funcionamiento y sustituya la batería.

Mensaje del visor Sonido de 
advertencia

Lámpara 
indicadora/
indicador de 
grabación

Causa y solución

Temperature High Intermitente Parpadeo La temperatura interna es elevada.
Apague el camcorder y deje que se enfríe antes 
de volverlo a utilizar.

Media Temperature 
High

Intermitente Parpadeo La temperatura de la tarjeta CFexpress es elevada.
Sustituya la tarjeta o deje que se enfríe antes de 
volverla a utilizar.

Voltage Low Intermitente Parpadeo La tensión de DC IN es baja (nivel 1). Compruebe la 
fuente de alimentación.

Insufficient Voltage Continuo Parpadeo 
rápido

La tensión de DC IN es demasiado baja (nivel 2). 
La grabación se detiene.
Conecte a una fuente de alimentación distinta.

Media Near Full Intermitente Parpadeo La capacidad restante de la tarjeta de memoria se 
está agotando.
Sustitúyala en cuanto pueda.

Media Full Continuo Parpadeo 
rápido

Los clips no se pueden grabar o copiar porque no 
queda capacidad en la tarjeta de memoria.
Sustitúyala inmediatamente.

Clips Near Full Intermitente Parpadeo El número de clips adicionales que pueden 
grabarse en la tarjeta de memoria está 
alcanzando valores bajos.
Sustitúyala en cuanto pueda.

Clips Full Continuo Parpadeo 
rápido

Se ha alcanzado el número máximo de clips que 
pueden grabarse en la tarjeta de memoria.
No se pueden grabar o copiar más clips. 
Sustitúyala inmediatamente.

Last Clip Recording Intermitente Parpadeo El clip que está grabando actualmente es el 
último que puede grabar, ya que ha alanzado el 
número máximo de clips.
Prepare una tarjeta de memoria nueva.

Media(A)1) Life Near 
End

Intermitente Parpadeo La tarjeta de memoria está llegando al final de su 
vida útil. Sustitúyala en cuanto pueda.

Media(A)1) Life End Continuo Parpadeo 
rápido

La tarjeta de memoria ha llegado al final de su 
vida útil. Sustitúyala inmediatamente.

Media(A)1) Near Full Intermitente Parpadeo Al utilizar la función Simul Rec

Media(A)1) Full Continuo Parpadeo 
rápido

Al utilizar la función Simul Rec

Media(A)1) Clips Near 
Full

Intermitente Parpadeo Al utilizar la función Simul Rec

Media(A)1) Clips Full Continuo Parpadeo 
rápido

Al utilizar la función Simul Rec

Media(A)1) Last Clip 
Rec

Intermitente Parpadeo Al utilizar la función Simul Rec

1) Se muestra “Media (B)” para la tarjeta de la ranura B.

Advertencias de funcionamiento
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Mensajes de precaución y de funcionamiento

Es posible que los siguientes mensajes de precaución y funcionamiento aparezcan en el 
centro de la pantalla. Siga las instrucciones proporcionadas para resolver el problema.

Mensaje de pantalla Causa y solución

Battery Error
Please Change Battery

Se ha detectado un error en la batería.
Sustitúyala por una batería normal.

Backup Battery End
Please Change

La capacidad restante de la batería de reserva es insuficiente.
Cargue la batería de reserva.

Unknown Media (A)1)

Please Change
Se ha introducido una tarjeta de memoria particionada o una 
tarjeta de memoria que contiene más clips de los que puede 
procesar la videocámara.
La tarjeta no se puede utilizar en la videocámara y se debe 
sustituir.

Cannot Use Media (A)1)

Unsupported File System
Se ha introducido una tarjeta que utiliza un sistema de 
archivos diferente o que no se ha formateado.
La tarjeta no se puede utilizar en la videocámara y se debe 
sustituir o formatear con la videocámara.

Media Error
Media (A) 1) Needs to be Restored

Se ha producido un error en la tarjeta de memoria y se debe 
restaurar.
Restaure la tarjeta de memoria.

Media Error
Cannot Record to Media (A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se 
puede utilizar para la grabación.
La reproducción es posible, por tanto, se recomienda copiar y 
sustituir la tarjeta de memoria.

Media Error
Cannot Use Media (A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se 
puede utilizar para la grabación ni la reproducción.
La tarjeta no se puede utilizar en la videocámara y se debe 
sustituir.

Media (A)1) Error
Recording Halted
Playback Halted

La grabación y la reproducción se han detenido a causa de un 
error que se ha producido mientras se utilizaba la tarjeta de 
memoria.
Si el problema continúa, sustituya la tarjeta de memoria.

Media Reached Rewriting Limit
Change Media (A)1)

La tarjeta de memoria ha llegado al final de su vida útil.
Realice una copia de seguridad y sustituya la tarjeta 
inmediatamente. Si continúa utilizando la tarjeta, es posible 
que no pueda grabar o reproducir.
Para obtener más información, consulte las instrucciones de 
funcionamiento de la tarjeta de memoria.

The specified address is invalid. La dirección especificada no es válida.
Compruebe que el ajuste sea correcto.

Cannot Use Specified Port Number El número de puerto especificado no es válido.
Compruebe que el ajuste sea correcto.

Mensaje de pantalla Causa y solución

Fan Stopped El ventilador incorporado se ha detenido.
Evite utilizar la videocámara con temperaturas elevadas, 
desconecte la alimentación y póngase en contacto con el 
servicio de asistencia técnica de Sony.

Lens I/F Error(xx:xx) Se detectó un error de comunicación I/F con el objetivo al 
conectar un objetivo de montura E.
Verifique el estado de conexión con el objetivo de montura E.
Si el problema persiste, póngase en contacto con el servicio 
de asistencia técnica de Sony con el código de error (cinco 
caracteres entre paréntesis).

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Se detectó un accesorio incompatible.
El único accesorio de terminal múltiple compatible con la 
unidad es el control remoto de la empuñadura suministrado.

Failed Este error puede aparecer si no se puede obtener una 
dirección con el ajuste DHCP fijado en On.
Compruebe los ajustes de servidor de DHCP.

Cannot add auto upload job of Proxy 
file because maximum number of 
upload jobs was reached.

Se ha alcanzado el número máximo de trabajos de 
transferencia.
Borre los trabajos no deseados. Es posible que el ajuste de 
destino de carga automática para archivos de proxy también 
sea incorrecto. Compruebe que el ajuste sea correcto.

<SSID>Not found. No se pudo encontrar la red (punto de acceso) con el <SSID> 
especificado.
Compruebe que el ajuste sea correcto.

<SSID>Authentication Failed Fallo de autenticación de conexión en la red (punto de acceso) 
con el <SSID> especificado.
Compruebe que la contraseña y el resto de ajustes sean 
correctos.

An IP address conflict has occurred. 
Please check the network settings.

Existe un conflicto en las direcciones de red de LAN 
inalámbrica, LAN con cable o anclaje USB.
Cambie la dirección de forma manual o cambie los ajustes del 
router de red.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

La dirección IP del modo de punto de acceso de LAN 
inalámbrica se cambió debido a un conflicto con las 
direcciones de red del modo de punto de acceso de LAN 
inalámbrica, LAN con cable o anclaje USB.
Compruebe la configuración de la dirección IP.

1) Se muestra “Media (B)” para la tarjeta de la ranura B.
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Elementos configurados en el menú completo

Sí: el elemento se guarda.
No: el elemento no se guarda.
–: no guardado (ajuste temporal)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Sí No

ISO/Gain<H> Sí No

ISO/Gain<M> Sí No

ISO/Gain<L> Sí No

Exposure Index<H> Sí No

Exposure Index<M> Sí No

Exposure Index<L> Sí No

Shockless Gain Sí No

Base Sensitivity Sí No

Base ISO Sí No

ND Filter Preset1 Sí No

Preset2 Sí No

Preset3 Sí No

Shutter Mode Sí No

Shutter Speed On/Off Sí No

Shutter Speed Sí No

Shutter Angle Sí No

ECS On/Off Sí No

ECS Frequency Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Sí No

Mode Sí No

Speed Sí No

AGC Sí No

AGC Limit Sí No

AGC Point Sí No

Auto Shutter Sí No

A.SHT Limit Sí No

A.SHT Point Sí No

Clip High light Sí No

Detect Window Sí No

Detect Window Indication Sí No

Custom Width Sí No

Custom Height Sí No

Custom H Position Sí No

Custom V Position Sí No

White Preset White Sí No

Color Temp <A> Sí No

Tint<A> Sí No

R Gain <A> Sí No

B Gain <A> Sí No

Color Temp <B> Sí No

Tint<B> Sí No

R Gain <B> Sí No

B Gain <B> Sí No

White Setting Shockless White Sí No

ATW Speed Sí No

White Switch<B> Sí No

Filter White Memory Sí No

Elementos guardados en Files
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Sí No

Offset Color Temp<A> Sí No

Offset Tint<A> Sí No

Offset White <B> Sí No

Offset Color Temp<B> Sí No

Offset Tint<B> Sí No

Offset White<ATW> Sí No

Offset Color Temp<ATW> Sí No

Offset Tint<ATW> Sí No

Focus AF Transition Speed Sí No

AF Subj. Shift Sens. Sí No

Focus Area Sí No

Focus Area (AF-S) Sí No

Face/Eye Detection AF Sí No

Push AF Mode Sí No

AF Assist Sí No

S&Q Motion Setting Sí No

Frame Rate Sí No

LUT On/Off SDI/HDMI Sí No

VF/Proxy/Stream Sí No

Internal Rec Sí No

Noise Suppression Setting(Custom) Sí No

Level(Custom) Sí No

Setting(Cine EI) Sí –

Level(Cine EI) Sí –

Flicker Reduce Mode Sí No

Frequency Sí No

SteadyShot Setting Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Sí –

Target Display Sí –

Rec Format Frequency Sí No

Imager Scan Mode Sí No

Codec Sí No

RAW Output Format Sí No

Video Format Sí No

Cine EI Setting Color Gamut Sí –

Simul Rec Setting Sí No

Proxy Rec Setting Sí No

Audio Channel Sí No

Interval Rec Setting No No

Interval Time Sí No

Number of Frames Sí No

Pre-Lighting Sí No

SDI/HDMI Rec Control Setting Sí No

Assignable Button <1> Sí No

<2> Sí No

<3> Sí No

<4> Sí No

<5> Sí No

<6> Sí No

<7> Sí No

<8> Sí No

<9> Sí No

Focus Hold Button Sí No

Assignable Dial Grip/Remote Dial Sí No

Grip Dial Direction Sí No

Handle Dial Sí No

Handle Dial Direction Sí No

Multi Function Dial Default Function Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project User File Load Media(B) – –

Save Media(B) – –

File ID No No

Load Customize Data Sí No

Load White Data Sí No

All File Load Media(B) – –

Save Media(B) – –

File ID Sí No

Load Network Data No No

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Sí Sí

Delete – –

Delete All – –

Import – –

Input Sí Sí

Output Sí Sí

AE Level Offset Sí Sí

Reset Paint Settings Reset without Base Look – –

Black Master Black Sí Sí

R Black Sí Sí

B Black Sí Sí

Knee Setting Sí Sí

Auto Knee Sí Sí

Point Sí Sí

Slope Sí Sí

Detail Setting Sí Sí

Level Sí Sí

Manual Setting Sí Sí

V/H Balance Sí Sí

B/W Balance Sí Sí

Limit Sí Sí

Crispening Sí Sí

High Light Detail Sí Sí

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Matrix User Matrix Sí Sí

User Matrix Level Sí Sí

User Matrix Phase Sí Sí

User Matrix R-G Sí Sí

User Matrix R-B Sí Sí

User Matrix G-R Sí Sí

User Matrix G-B Sí Sí

User Matrix B-R Sí Sí

User Matrix B-G Sí Sí

Multi Matrix Setting Sí Sí

Reset – –

Axis No Sí

Hue Sí Sí

Saturation Sí Sí

TC/Media Timecode Mode Sí No

Run Sí No

Setting No No

Reset – –

TC Format Sí No

TC Display Display Select Sí No

Users Bit Mode Sí No

Setting No No

HDMI TC Out Setting Sí No

Clip Name Format Title Prefix Sí No

Number Set No No

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Monitoring Output On/Off SDI Sí No

HDMI Sí No

Output Format SDI Sí No

HDMI Sí No

Output Display SDI Sí No

HDMI Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Network Status Sí No

File Transfer Status Sí No

Rec/Play Status Sí No

RAW Output Control Status Sí No

Tally Sí No

Battery Remain Sí No

Focus Mode Sí No

Focus Position Sí No

Focus Area Indicator Sí No

Focus Area Ind.(AF-S) Sí No

Face/Eye Detection Frame Sí No

Lens Info Sí No

Imager Scan Mode Sí No

Rec Format Sí No

Frame Rate Sí No

Zoom Position Sí No

UWP RF Level Sí No

SteadyShot Sí No

Base Look/LUT Sí No

SDI/HDMI Rec Control Sí No

Gamma Display Assist Sí No

Proxy Status Sí No

Base ISO/Sensitivity Sí No

Media Status Sí No

Video Signal Monitor Sí No

Clip Name Sí No

White Balance Sí No

Scene File Sí No

Focus Indicator Sí No

Auto Exposure Mode Sí No

Auto Exposure Level Sí No

Timecode Sí No

ND Filter Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Iris Sí No

ISO/Gain/EI Sí No

Shutter Sí No

Level Gauge Sí No

Audio Level Meter Sí No

Video Level Warning Sí No

Clip Number Sí No

Notice Message Sí No

Marker Setting Sí No

Color Sí No

Center Marker Sí No

Safety Zone Sí No

Safety Area Sí No

Aspect Marker Sí No

Aspect Mask Sí No

Aspect Safety Zone Sí No

Aspect Safety Area Sí No

Aspect Select Sí No

Custom Aspect Ratio Sí No

Guide Frame Sí No

100% Marker Sí No

User Box Sí No

User Box Width Sí No

User Box Height Sí No

User Box H Position Sí No

User Box V Position Sí No

VF Setting Brightness Sí No

Color Mode Sí No

Gamma Display Assist Setting Sí No

Peaking Setting Sí No

Peaking Level Sí No

Color Sí No

Zebra Setting Sí No

Zebra1 Level Sí No

Zebra1 Aperture Level Sí No

Zebra2 Level Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 Input Select Sí No

CH2 Input Select Sí No

CH3 Input Select Sí No

CH4 Input Select Sí No

INPUT1 MIC Reference Sí No

INPUT2 MIC Reference Sí No

Line Input Reference Sí No

Reference Level Sí No

CH1 Wind Filter Sí No

CH2 Wind Filter Sí No

CH3 Wind Filter Sí No

CH4 Wind Filter Sí No

CH3 Level Control Sí No

CH4 Level Control Sí No

CH3 Input Level Sí No

CH4 Input Level Sí No

Audio Input Level Sí No

Limiter Mode Sí No

CH1&2 AGC Mode Sí No

CH3&4 AGC Mode Sí No

AGC Spec Sí No

1kHz Tone on Color Bars Sí No

CH1 Level Sí No

CH2 Level Sí No

CH3 Level Sí No

CH4 Level Sí No

Audio Output Monitor CH Sí No

Volume No No

Headphone Out Sí No

Alarm Level Sí No

HDMI Output CH Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Sí –

Technical Color Bars Setting No No

Type Sí No

ND Dial CLEAR with Dial Sí No

Tally Front Sí No

Rear Sí No

HOLD Switch Setting with Rec Button Sí No

with Hand Grip Remote Sí No

Touch Operation Setting Sí No

Rec Review Setting Sí No

Zoom Zoom Type Sí No

Handle Zoom Setting Sí No

High Sí No

Low Sí No

Menu Settings User Menu Only Sí No

User Menu with Lock No No

Fan Control Setting Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Lens Zoom Ring Direction Sí No

Shading Compensation Sí No

Chroma Aberration Comp. Sí No

Distortion Comp. Sí No

Distance Display Sí No

Zoom Position Display Sí No

Video Light Set Video Light Set Sí No

APR APR – –

Camera Battery Alarm Low Battery Sí No

Battery Empty Sí No

Camera DC IN Alarm DC Low Voltage1 Sí No

DC Low Voltage2 Sí No

Network Access Authentication User Name No No

Password No No

Wireless LAN Setting Sí No

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Sí No

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Sí No

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password No No

DHCP Sí No

IP Address Sí No

Subnet Mask Sí No

Gateway Sí No

DNS Auto Sí No

Primary DNS Server Sí No

Secondary DNS Server Sí No

Manual Register

SSID Sí No

Security Sí No

Password No No

DHCP Sí No

IP Address Sí No

Subnet Mask Sí No

Gateway Sí No

DNS Auto Sí No

Primary DNS Server Sí No

Secondary DNS Server Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Sí No

Camera Remote Control Sí No

Detail Settings

DHCP Sí No

IP Address Sí No

Subnet Mask Sí No

Gateway Sí No

DNS Auto Sí No

Primary DNS Server Sí No

Secondary DNS Server Sí No

Modem Setting Sí No

Camera Remote Control Sí No

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload (Proxy) Sí No

Default Upload Server Sí No

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Sí No

Service Sí No

Host Name Sí No

Port Sí No

User Name No No

Password No No

Passive Mode Sí No

Destination Directory Sí No

Using Secure Protocol Sí No

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Sí No

Clock Set Time Zone Sí No

Date Mode Sí No

12H/24H Sí No

Date No No

Time No No

All Reset Reset – –

Reset without Network – –

Hours Meter Hours (System) – –

Hours (Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –
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Elementos configurados por botones asignables

Sí: el elemento se guarda.
No: el elemento no se guarda.
–: no guardado (ajuste temporal)

Selección de botones asignables All File Scene File

ND Filter Position Sí No

Auto Iris Sí No

ATW Sí No

Focus Setting Sí No

Display Sí –

VF Adjust Sí –

Elementos configurados por el dial asignable

Sí: el elemento se guarda.
No: el elemento no se guarda.
–: no guardado (ajuste temporal)

Selección de diales asignables All File Scene File

IRIS Sí No

ND Filter Sí No

Audio Input Level Sí No
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Consulte los elementos relacionados en “Especificación del audio que se va a grabar” (página 46) y “Menú User” (página 70).

Audio Input (CH1&CH2)

A continuación se muestra el diagrama de bloques con el asa acoplada.

INPUT1
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INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
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r 
X

LR
 a

d
ap

to
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<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

* Ajústelo en Manual cuando el audio entre desde el adaptador XLR.

Diagramas de bloques
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Audio Input (CH3&CH4)

A continuación se muestra el diagrama de bloques con el asa acoplada.
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[CH3 Wind Filter]
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O�

[CH4 Wind Filter]
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O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
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Through

[Color Bars]
[1kHz Tone on Color
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O�

 
* Ajústelo en Manual cuando el audio entre desde el adaptador XLR.
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Audio Output

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4
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Puede actualizar el software de un objetivo de 
montura E con la videocámara.
Consulte el sitio web del objetivo para saber 
qué objetivos pueden actualizarse y cuál es el 
firmware correspondiente.

Comprobación de la versión

1 Acople un objetivo de montura E a la 
videocámara (página 22).

2 Seleccione Version en el menú 
Maintenance del menú completo para 
que se muestre Lens Version Number 
(página 100).
El número de versión del software del 
objetivo de montura E aparecerá en el 
lateral.

Actualización del software

Ajuste la videocámara en el modo de 
almacenamiento masivo (página 109).
Actualice el software siguiendo el 
procedimiento suministrado con el software 
del objetivo.

Actualización del software del objetivo de montura E
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Licencia de la cartera de patentes 
visuales de MPEG-4

ESTE PRODUCTO SE AUTORIZA BAJO LA 
LICENCIA DE CARTERA DE PATENTES AVC QUE 
PERMITE AL CONSUMIDOR EL USO PERSONAL 
U OTROS USOS EN LOS QUE NO RECIBA 
REMUNERACIÓN PARA:
(i) CODIFICAR VÍDEO QUE CUMPLA CON EL 

ESTÁNDAR VISUAL DE MPEG-4 (“MPEG-4 
VIDEO”) Y/O

(ii) DECODIFICAR VÍDEO MPEG-4 CODIFICADO 
POR UN CONSUMIDOR DURANTE UNA 
ACTIVIDAD PERSONAL U OBTENIDO 
A TRAVÉS DE UN PROVEEDOR DE 
VÍDEO AUTORIZADO POR MPEG PARA 
SUMINISTRAR VÍDEO MPEG-4.

NO SE OTORGA NINGÚN TIPO DE LICENCIA 
O NO EXISTE NINGUNA LICENCIA IMPLÍCITA 
PARA NINGÚN OTRO USO. MPEG LA, LLC. 
PUEDE OBTENER INFORMACIÓN ADICIONAL, 
INCLUIDA LA RELACIONADA CON USOS 
PROMOCIONALES, INTERNOS Y COMERCIALES 
Y LICENCIAS. CONSULTE HTTP://WWW.
MPEGLA.COM

Obtención del software con la 
licencia GPL/LGPL

Este producto utiliza un software al que se 
aplica la licencia GPL/LGPL. Esto le informa 
de que tiene derecho a acceder, modificar 
y redistribuir el código fuente de estos 
programas de software de acuerdo con las 
condiciones de la GPL/LGPL.
El código fuente se proporciona en Internet. 
Utilice la siguiente URL y siga las instrucciones 
de descarga.

http://www.sony.net/Products/Linux/
common/search.html

Le rogamos que no se ponga en contacto con 
nosotros acerca de los contenidos del código 
fuente.

Las licencias (en inglés) se registran en la 
memoria interna del producto.
Establezca una conexión de almacenamiento 
masivo entre el producto y un ordenador para 
leer las licencias en la carpeta “PMHOME” - 
“LICENSE”.

Si se utiliza un Mac, es posible que la carpeta 
“PMHOME” - “LICENSE” no esté accesible.
Para visualizar los archivos, utilice un 
ordenador que no sea Mac o visite la siguiente 
URL.
https://oss.sony.net/License/ILME-FX6/

CONTRATO DE LICENCIA DE 
USUARIO FINAL

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 

distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 
or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 
will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 

Licencias

http://www.sony.net/Products/Linux/common/search.html
http://www.sony.net/Products/Linux/common/search.html
https://oss.sony.net/License/ILME-FX6/
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you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 

in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 

(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 

devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 
of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 
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Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 

that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 

NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 
of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licencias de software de código 
abierto

En base a los contratos de licencia entre Sony 
y los propietarios del copyright del software, 
este producto utiliza software libre.
Para cumplir los requisitos de los propietarios 
del copyright del software, Sony se ve 
obligado a informarle acerca del contenido de 
estas licencias.
Las licencias (en inglés) se registran en la 
memoria interna del producto.
Establezca una conexión de almacenamiento 
masivo entre el producto y un ordenador para 
leer las licencias en la carpeta “PMHOME” - 
“LICENSE”.

Si se utiliza un Mac, es posible que la carpeta 
“PMHOME” - “LICENSE” no esté accesible.
Para visualizar los archivos, utilice un 
ordenador que no sea Mac o visite la siguiente 
URL.
https://oss.sony.net/License/ILME-FX6/

https://oss.sony.net/License/ILME-FX6/
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General

Peso

 Aprox. 890 g (solo el cuerpo principal)

 Aprox. 2,59 kg (incluido el objetivo 

SEL24105G, la cubierta del 

objetivo, la batería (BP‑U35), el 

visor, el asa y la empuñadura)

Dimensiones

 Consulte la página 134.

Requisitos de alimentación

 19,5 V de CC (de 18,0 V a 20,5 V)

Consumo de energía

 Aprox. 18,0 W (cuerpo, objetivo, grabación 

XAVC‑I QFHD 59.94P, visor 

colocado, sin dispositivo externo 

conectado)

 Aprox. 36,0 W (cuerpo, objetivo, grabación 

XAVC‑I QFHD 59.94P (S&Q 

120 fps), visor colocado, 

HDMI, SDI, dispositivo externo 

conectado)

Temperatura de funcionamiento

 De 0 °C a 40 °C

Temperatura de almacenamiento

 De –20 °C a +60 °C

Tiempo de funcionamiento continuo

 Aprox. 105 minutos (con BP‑U35) 

(cuerpo, objetivo, grabación 

XAVC‑I QFHD 59.94P, visor 

colocado, sin dispositivo externo 

conectado)

Formato de grabación (vídeo)

 XAVC Intra

  Modo XAVC‑I 4K/QFHD: 

CBG, velocidad de bits de 

600 Mbps (máx.), MPEG‑4 

AVC/H.264

  Modo XAVC‑I HD: 

CBG, velocidad de bits de 

223 Mbps (máx.), MPEG‑4 

AVC/H.264

 XAVC Long

  Modo XAVC‑L QFHD: 

VBR, velocidad de bits de 

150 Mbps (máx.), MPEG‑4 H.264/

AVC

  Modo XAVC‑L HD 50: 

VBR, velocidad de bits de 

50 Mbps (máx.), MPEG‑4 H.264/

AVC

  Modo XAVC‑L HD 35: 

VBR, velocidad de bits de 35 Mbps 

(máx.), MPEG‑4 H.264/AVC

Formato de grabación (audio)

 LPCM de 24 bits, 48 kHz, 4 canales

Velocidad de fotogramas de grabación

 XAVC Intra

  Modo XAVC‑I 4K: 

4096×2160/59.94P, 50P, 29.97P, 

25P, 24P, 23.98P

  Modo XAVC‑I QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

  Modo XAVC‑I HD: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

 XAVC Long

  Modo XAVC‑L QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

  Modo XAVC‑L HD 50: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

  Modo XAVC‑L HD 35: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

Tiempo de grabación/reproducción

 XAVC Intra

  Modo XAVC‑I QFHD:

   59.94P

   Aprox. 30 minutos  

(con CEA‑G160T)

  Modo XAVC‑I HD:

   59.94P

   Aprox. 78 minutos  

(con CEA‑G160T)

 XAVC Long

  Modo XAVC‑L QFHD:

   59.94P

   Aprox. 115 minutos  

(con CEA‑G160T)

  Modo XAVC‑L HD 50:

   59.94P

   Aprox. 155 minutos  

(con CEA‑G80T)

  Modo XAVC‑L HD 35:

   59.94P

   Aprox. 210 minutos  

(con CEA‑G80T)

[Nota]
El tiempo de grabación/reproducción puede variar 
debido a las condiciones de uso y a las características de 
la memoria. Los tiempos de grabación y reproducción 
son para una grabación continua como un solo clip. Los 
tiempos reales pueden ser inferiores, dependiendo del 
número de clips grabados.

Sección de la cámara

Dispositivo de generación de imágenes (tipo)

 Sensor de imagen CMOS de un solo chip 

equivalente a fotograma 

completo de 35 mm

Número de píxeles

 12,9M (total)

 10,2M (efectivos)

Auto focus

 Método de detección: detección de fase / 

detección de contraste

Filtros ND internos

 CLEAR: OFF

 1: 1/4ND

 2: 1/16ND

 3: 1/64ND

 ND linealmente variable: de 1/4ND a 1/128ND

Sensibilidad ISO

 ISO 800/12800 (modo Cine EI, fuente de luz 

D55)

Montura del objetivo

 Montura E

Latitud

 Más de 15 paradas

Velocidad del obturador

 De 64F a 1/8000 de s (23.98P)

Ángulo del obturador

 De 5,6° a 360°, de 2 a 64 fotogramas

Slow & Quick Motion

 XAVC QFHD: de 1 fps a 120 fps

 XAVC HD: de 1 fps a 240 fps

 XAVC 4K: de 1 fps a 60 fps

 XAVC HD (S35): de 1 fps a 120 fps

Balance de blancos

 De 2000 K a 15000 K

Gain

 De –3 dB a +30 dB (incrementos de 1 dB)

Base look

 S‑Cinetone, Standard, Still, ITU709, s709, 

709(800%), S‑Log3, HLG Live, 

HLG Natural

Sección de audio

Frecuencia de muestreo

 48 kHz

Especificaciones



8. Apéndice: Especificaciones133

Cuantificación

 24 bits

Respuesta en frecuencia

 Modo MIC de la entrada XLR: de 20 Hz a 

20 kHz (±3 dB o menos)

 Modo LINE de la entrada XLR: de 20 Hz a 

20 kHz (±3 dB o menos)

Rango dinámico

 Modo MIC de la entrada XLR: 80 dB (típico)

 Modo LINE de la entrada XLR: 90 dB (típico)

Distorsión

 Modo MIC de la entrada XLR: 0,08% o inferior 

(nivel de entrada de –40 dBu)

 Modo LINE de la entrada XLR: 0,08% o inferior 

(nivel de entrada de +14 dBu)

Altavoz integrado

 Monoaural

Micrófono interno 

 Monoaural

Micrófono interno del asa

 Micrófono de condensador electret estéreo 

omnidireccional

[Nota]
Cuando se acopla el asa, solo se activa el micrófono 
interno del asa.

Sección de entrada/salida

Entradas
INPUT 1/2:

 Tipo XLR, 3 contactos, hembra

 Conmutable entre LINE / MIC / MIC+48V

 MIC: de –30 dBu a –80 dBu de referencia

TC IN:

 Tipo BNC

Salidas
SDI OUT:

 Tipo BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), 

HD-SDI

Auriculares (minitoma estéreo):

 –16 dBu (salida del nivel de referencia, 

volumen máximo del monitor, 

carga de 16 Ω)

HDMI:

 Tipo A, 19 contactos

TC OUT:

 Tipo BNC

Otras
DC IN:

 Compatible con EIAJ, de 18 V a 20,5 V de CC

Zapata de interfaz múltiple:

 Específico (21 contactos)

REMOTE:

 Tipo subminitoma de 3 polos y 2,5 mm

Conector del control remoto de la empuñadura:

 Minitoma estéreo de 4 polos y 3,5 mm 

(conector suministrado 

para el control remoto de la 

empuñadura)

USB-C:

 USB 3.2 Gen 1

USB/múltiple:

 Compatible con el estándar USB 2.0, tipo 

micro B para almacenamiento 

masivo (1)

VF:

 Específico (40 contactos)

Sección de visualización

Visor (LCD)
Tamaño de la pantalla

 Diagonal de 8,8 cm (3,5 pulgadas)

Relación de aspecto

 16:9

Número de píxeles

 1280 (H) × 720 (V)

Sección de la ranura multimedia

Ranura de la tarjeta CFexpress Tipo A/SD (2)

LAN inalámbrica

Estándares compatibles

 IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

 IEEE 802.11 b/g/n (ILME-FX6T/TK)

Banda de frecuencia

 2,4 GHz

 5 GHz (solo ILME-FX6V/VK)

Protocolos de seguridad compatibles

 WEP/WPA-PSK/WPA2-PSK

Método de conexión

 Wi-Fi Protected Setup™ (WPS)/Manual

Método de acceso

 Modo de infraestructura

Cargador de batería (BC-CU1)

Peso

 Aprox. 60 g

Dimensiones

 Aprox. 57 × 26 × 101 mm 

(anchura/altura/profundidad)

Input

 19,5 V de CC, 26 W

Output

 16,4 V de CC, 1,4 A

Temperatura de funcionamiento

 De 0 °C a 40 °C

Temperatura de almacenamiento

 De –20 °C a +60 °C

Accesorios suministrados

Adaptador de CA (1)

Cable de alimentación (1) 

Cargador de batería (1) 

Batería (1)

Asa (1)

Monitor LCD (1)

Cable USB-C (1)

Control remoto de la empuñadura (1)

Cubierta del monitor LCD (1)

Kit de zapata sin conexión (1) 

(Zapata sin conexión (1), muelle de la zapata (1), 

tornillos (4))

Tapa de la montura del objetivo (1)

Tapa protectora del conector del asa (1)

Antes de utilizar esta unidad (1)

Folleto de la garantía (1)

El diseño y las especificaciones están sujetos a 
cambios sin previo aviso.
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Notas
ˎˎ Haga siempre un ensayo de grabación 
y verifique que se grabó bien. SONY NO 
SE HACE RESPONSABLE POR DAÑOS DE 
NINGÚN TIPO, INCLUYENDO PERO NO 
LIMITADO A LA COMPENSACIÓN O PAGO 
POR FALLO EN HACER CUALQUIER TIPO 
DE CONTENIDO DE GRABACIÓN POR 
MEDIO DE ESTA UNIDAD O SU SOPORTE DE 
GRABACIÓN O CUALQUIER OTRO SOPORTE 
O SISTEMA DE ALMACENAMIENTO.
ˎˎ Verifique siempre que esta unidad 
funciona correctamente antes de utilizarla. 
SONY NO SE HACE RESPONSABLE POR 
DAÑOS DE NINGÚN TIPO, INCLUYENDO 
PERO NO LIMITADO A LA COMPENSACIÓN 
O PAGO POR LA PÉRDIDA DE GANANCIAS 
PRESENTES O FUTURAS DEBIDO AL FALLO 
DE ESTA UNIDAD, YA SEA DURANTE LA 
VIGENCIA DE LA GARANTÍA O DESPUÉS 
DEL VENCIMIENTO DE LA GARANTÍA NI 
POR CUALQUIER OTRA RAZÓN.
ˎˎ SONY NO SE HACE RESPONSABLE POR 
RECLAMACIONES DE NINGÚN TIPO 
REALIZADAS POR USUARIOS DE ESTA 
UNIDAD O POR TERCEROS.
ˎˎ SONY NO SE HACE RESPONSABLE 
POR LA PÉRDIDA, LA REPARACIÓN O 
LA REPRODUCCIÓN DE CUALQUIER 
DATO GRABADO EN EL SISTEMA 
DE ALMACENAMIENTO INTERNO, 
SOPORTES DE GRABACIÓN O CUALQUIER 
OTRO SOPORTE O SISTEMA DE 
ALMACENAMIENTO.
ˎˎ SONY NO SE HACE RESPONSABLE DE LA 
FINALIZACIÓN NI DE LA INTERRUPCIÓN, 
POR LA CIRCUNSTANCIA QUE FUERA, DE 
CUALQUIER SERVICIO RELACIONADO CON 
ESTA UNIDAD.

Dimensiones exteriores

Unidad: mm

UNC 1/4-20

UNC 3/8-16

228

2-UNC 1/4-20

UNC 1/4-20

143

UNC 1/4-20

116

8-UNC 1/4-20

11460

258
2-UNC 1/4-20

153

28

25

25
25

25

Las dimensiones son valores aproximados.
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Marcas comerciales

ˎˎ  es marca comercial de Sony Corporation.
ˎˎ XAVC y  son marcas comerciales 
registradas de Sony Corporation.
ˎˎ Los términos HDMI y HDMI High-
Definition Multimedia Interface, y el 
Logotipo HDMI son marcas comerciales 
o marcas registradas de HDMI Licensing 
Administrator, Inc. en los Estados Unidos y 
en otros países.
ˎˎ Microsoft y Windows son marcas 
comerciales o marcas comerciales 
registradas de Microsoft Corporation en 
Estados Unidos o en otros países.
ˎˎ Mac y macOS son marcas comerciales 
registradas de Apple Inc. en Estados Unidos 
y en otros países.
ˎˎ “Catalyst Browse”, “Content Browser 
Mobile” y el logotipo de “Content Browser 
Mobile” son marcas comerciales o 
marcas comerciales registradas de Sony 
Corporation.
ˎˎ iOS es una marca comercial o marca 
comercial registrada de Cisco Systems, Inc. 
y/o sus afiliados en Estados Unidos y en 
otros países.
ˎˎ Android y Google Play son marcas 
comerciales de Google Inc.
ˎˎ Wi-Fi, el logotipo Wi-Fi y Wi-Fi PROTECTED 
SETUP son marcas comerciales o marcas 
comerciales registradas de Wi-Fi Alliance.
ˎˎ Marca N es una marca comercial o marca 
comercial registrada de NFC Forum en 
Estados Unidos y en otros países.
ˎˎ El logotipo de SDXC es una marca comercial 
de SD-3C, LLC.
ˎˎ CFexpress y el logotipo de CFexpress Tipo A 
son marcas comerciales de CompactFlash 
Association.

Todos los demás nombres de compañías y de 
productos son marcas comerciales registradas 

o marcas comerciales de sus respectivos 
propietarios. En este documento, no se utilizan 
los símbolos ™ o ® para indicar los elementos 
con marca registrada.
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